* You can give a name to a value or formula — even when the value or formula
doesn’t exist on the worksheet. For example, you can create the name
Interest_Rate for a value of .075. Then, vou can use this name in your formulas
{more about this in the next chapter).

Valid Names

Although Excel is quite flexible about the names that you can define, it does have
some rules:

« Names can’t contain any spaces. You might want to use an underscore or a
period character to simulate a space (such as Annual_Total or Annual. Total).

* You can use any combination of letters and numbers, but the name must
begin with a letter. A name can’t begin with a number (such as 3rdQuarter) or
look like a cell reference (such as ()3).

» Symbols, except for underscores and periods, aren’t allowed. Although it’s not
documented, I've found that Excel also allows a backslash (\) and question
mark (?).

» Names are limited to 255 characters. Trust me —using a name anywhere near
this length is not a good idea; in fact, it defeats the purpose of naming ranges.

* You can use single letters (except for R or C), but this is generally not recom-
mended because, again, it defeats the purpose of using meaningful names.

Excel also uses a few names internally for its own use. Although vou can create
names that override Excel’s internal names, you should avoid doing so. To be on
the safe side, avoid using the following for names: Print_Area, Print_Titles,
Consolidate_Area, and Sheet_Title.

You can use labels that appear as row and column headings as names; when you
do, you don't actually have to define the names. This feature is most useful when
you use formulas, so it is discussed in detail in Chapter 9.

Creating Names Manually

Several ways exist to create names. This section discusses two methods to create
names manually.

Using the Define Name dialog box

To create a range name, start by selecting the cell or range that you want to name.
Then, select Insert+ Name+ Define (or press Ctrl+F3). Excel displays the Define
Name dialog box, shown in Figure 8-16.
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Figure 8-16: Create names for cells or ranges by
using the Define Name dialog box.

Type a name in the box labeled Names in workbook (or use the name that Excel
proposes, if any). The active or selected cell or range address appears in the Refers
to box. Verify that the address listed is correct and then click OK to add the name
to your worksheet and close the dialog box. Or, you can click the Add button to
continue adding names to your worksheet. If you do this, you must specify the
Refers to range either by typing an address (imake sure to begin with an equal sign)
or by pointing to it in the worksheet. Each name appears in the list box.

Using the Name box

A faster way to create a name is to use the Name box. Select the cell or range to
name and then click the Name box and type the name. Press Enter to create the
naine. If a name already exists, you can’t use the Name box to change the range to
which that name refers. Attempting to do so simply selects the range.

When you enter a name in the Name box, you must press Enter to actually record
the name. If you type a name and then click in the worksheet, Excel won't create
the name.

The Namie box is a drop-down list and shows all names in the workbook (see Figure
8-17). To choose a named cell or range, click the Name box and choose the name.
The name appears in the Name box, and Excel selects the named cell or range in
the worksheet. Oddly enough, you can’t open the Name box by using the keyboard;
you must use a mouse. After you click the Name box, however, you can use the
direction keys and Enter to choose a name.
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Figure 8-17: The Name box shows all names defined in the workbook.

Creating Names Automatically

You may have a worksheet that contains text that you want to use for names for
adjacent cells or ranges. Figure 8-18 shows an example of such a worksheet. In this
case, you might want to use the text in column A to create names for the
corresponding values in column B. Excel makes this very easy to do.

Figure 8-18: Excel makes it easy to create
names by using text in adjacent cells.
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e
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To create names by using adjacent text, start by selecting the name text and the
cells that you want to name (these can be individual cells or ranges of cells). The
names must be adjacent to the cells that you're naming (a multiple selection is
allowed). Then, choose Inserts Name» Create (or Ctrl+Shift+F3). Excel displays
the Create Names dialog box, shown in Figure 8-19. The check marks in this dialog
box are based on Excel’s analysis of the selected range. For example, if Excel finds
text in the first row of the selection, it proposes that you create names based on the
top row. If Excel didn’t guess correctly, you can change the check boxes. Click OK
and Excel creates the names.

R S S A B T

re 8-19: The Create Names dialog box.

If the text contained in a cell would result in an invalid name, Excel modifies the
name to make it valid. For example, if a cell contains the text Net income (which is
invalid for a name because it contains a space), Excel converts the space to an
underscore character. If Excel encounters a value or a formula where text should
be, however, it doesn‘t convert it to a valid name. It simply doesn't create a name.

You should double-check the names that Excel creates. Sometimes, the Inserte
Name« Create command works counterintuitively.

CiM Ex. 1052 Page 4



Figure 8-20 shows a small table of text and values. If you select the entire table,
chaose InsertName+ Create, and accept Excel’s suggestions (Top Row and Left
Column options), vou'll find that the name Products doesn’t refer to AZ:AB, as you
would expect, but instead refers to B2:C5. If the upper-left cell of the selection
contains text and vou choose the Top Row and Left Column options, Excel uses that
text for the name of the entire data—excluding the top row and left column. So,
before you accept the names that Excel creates, take a minute to make sure that
they refer to the correct ranges.

Figure 8-20: Creating namas from the data in this
table may produce unexpected results.

Creating a Table of Names

After you create a large number of names, you may need to know the ranges that
each name defines, particularly if you're trving to track down errors or document
yvour work. Excel lets you create a list of all names in the workbook and their
corresponding addresses. To create a table of names, first move the cell pointer to
an empty area of vour workshest —the table is created at the active cell position
and will overwrite any information at that location. Use the Insert» Name+ Paste
command (or F3). Excel displays the Paste Name dialog box, shown in Figure 8-21,
which lists all the defined names. To paste a list of names, click the Paste List
button.
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Figure 8-21: The Paste Name dialog box.

Deleting Names

If yvou no longer need a defined name, you can delete it. Deleting a range name does
not delete information in the range; it can, however, make formulas in your
workbook invalid.

Choose Insert+ Name+ Define to display the Define Name dialog box. Choose the
name that you want to delete from the list and then click the Delete button.

Be extra careful when deleting names. If the name is used in a formula, deleting
the name causes the formula to become invalid (it will display #NAME?).
However, deleting a name can be undone, so if you find that formulas return
#NAME? after you delete a name, select Edit+ Undo to get the name back.

If you delete the rows or columns that contain named cells or ranges, the names
contain an invalid reference. For example, if cell Al on Sheetl is named Interest and
you delete row 1 or column A, Interest then refers to =Sheet1#REF! (that is, an
erroneous reference). I you use Interest in a formula, the formula displays #REFR.
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Redefining Names

After you define a name, you may want to change the cell or range to which it
refers. Select Insert+ Namee+ Define to display the Define Name dialog box. Click
the name that you want to change and then edit the cell or range address in the
Refers to edit box. If you want to, you can click the edit box and select a new cell or
range by pointing in the worksheet.

Excel automatically adjusts the cells to which your names refer. For example,
assume that cell A10 is named Summary. If you delete a row above row 10,
Summary then refers to cell A9. This is just what you would expect to happen, so
you don't need to be concerned about it

Changing Names

Excel doesn’t have a simple way to change a name once you create the name. If you
create a name and then realize that it’s not the name that you want — or, perhaps,
that you spelled it incorrectly —you must create the new name and then delete the
old name.

Learning More About Names

Excel offers some additional features with respect to using names — features
unmatched in any of its competitors.

These advanced naming features are most useful when working with formulas
and therefore are discussed in Chapter 9.

Summary

This chapter discusses the basic worksheet operations that involve cells and
ranges. These operations include selecting, copying, moving, deleting, and working
with ranges that extend across multiple worksheets in a workbook. This chapter
also introduces the topic of names, an important concept that can make yvour
worksheets more readable and easier to maintain.
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Creating and
Using Formulas

Formulas are what make a spreadsheet so useful. Without
formulas, a spreadsheet would be little more than a word
processor with a very powerful table feature. A worksheet
without formulas is essentially dead. Using formulas adds life
and lets you calculate results from the data stored in the work-
sheet. This chapter introduces formulas and helps you get up
to speed with these important elements.

Introducing Formulas

To add a formula to a worksheet, you enter it into a cell. You
can delete, move, and copy formulas just like any other item of
data. Formulas use arithmetic operators to work with values,
text, worksheet functions, and other formulas to calculate a
value in the cell. Values and text can be located in other cells,
which makes changing data easy and gives worksheets their
dynamic nature. For example, Excel recalculates formulas if the
value in a cell used by the formula changes. In essence, you
can see multiple scenarios quickly by changing the data in a
worksheet and letting formulas do the work.

A formula entered into a cell can consist of any of the
following elements:

» Operators such as + (for addition) and * (for
multiplication)
+ Cell references (including named cells and ranges)
+ Values or text
» Worksheet functions (such as SUM or AVERAGE)
A formula can consist of up to 1,024 characters. After you
enter a formula into a cell, the cell displays the result of the

formula. The formula itself appears in the formula bar when
yvou select the cell, however.
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Here are a few examples of formulas:

=150%.05 Multiplies 150 times .05. This formula uses only values
and isn’t all that useful.

=Al+A2 Adds the values in cells Al and A2.

=Income-Expenses Subtracts the cell named Expenses from the cell named
Income.

=SUM(A1:A12) Adds the values in the range A1:A12.

=Al1=C12 Compares cell Al with cell C12. If they are identical, the

formula returns TRUE; otherwise, it returns FALSE.

Notice that formulas always begin with an equal sign so that Excel can distinguish
formulas from text.

Operators Used in Formulas

Excel lets you use a variety of operators in your formulas. Table 9-1 lists the opera-
tors that Excel recognizes. In addition to these, Excel has many built-in functions
that enable you to perform more operations.

Qperator Name

Subtraction

/ Division

& Concatenation

> Logical comparison (greater than)

>= Logical comparison (greater than or equal to)

<> Logical comparison (not equal to)
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=Al«<>A2 Returns TRUE if the value in cell Al isn’t equal to the value
in cell A2. Otherwise, it returns FALSE.

Operator Precedence

In an earlier example, parentheses are used in the formula, to control the order in
which the calculations occur. The formula without parentheses looks like this:

=[ncome-Expenses*TaxRate

If you enter the formula without the parentheses, Excel computes the wrong
answer. To understand why this occurs, vou need to understand a concept called
operator precedence, which basically is the set of rules that Excel uses to perform
its calculations. Table 9-2 lists Excel’s operator precedence. This table shows that
exponentiation has the highest precedence (that is, it's performed first), and
logical comparisons have the lowest precedence.

You use parentheses to override Excel’s built-in order of precedence. Returning to
the previous example, the formula that follows doesn’t use parentheses and, there-
fore, is evaluated using Excel’s standard operator precedence. Because multiplica-
tion has a higher precedence, the Expense cell is multiplied by the TaxRate cell.
Then, this result is subtracted from Income. This isn’t what was intended.

The correct formula, which follows, uses parentheses to control the order of
operations. Expressions within parentheses are always evaluated first. In this case,
Expenses is subtracted from Income and the result is multiplied by TaxRate.

={Income-Expenses)*TaxRate

Symbol Operator Precedence

* Multiplication 2

+ Addition 3

& Concatenation 4

< Less than 5
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You can also nest parentheses in formulas, which means putting parentheses inside
of parentheses. If you do so, Excel evaluates the most deeply nested expressions
first and works its way out. Figure 9-2 shows an example of a formula that uses
nested parentheses.

Figure 9-2: A formula with nested parentheses.

=({(B2*C2)+(B3*C3)+(B4*C4))*B6

This formula has four sets of parentheses —three sets are nested inside the fourth
set. Excel evaluates each nested set of parentheses and then adds up the three
results. This sum is then multiplied by the value in B6.

Using parentheses liberally in yvour formulas is a good idea. | often use parentheses
even when they aren’t necessary, to clarify the order of operations and make the
formula easier to read. For example, if you want to add 1 to the product of two cells,
the following formula will do it:

—1+A1*A2

[find it much clearer, however, to use the following formula (with superfluous
parentheses):

=1+{A1*A2)

Every left parenthesis, of course, must have a matching right parenthesis. lf you
have many levels of nested parentheses, it can sometimes be difficult to keep them
straight. If the parentheses don’t match, Excel displays a message explaining the
problem and won'’t let you enter the formula. Fortunately, Excel lends a hand in
helping you match parentheses. When you enter or edit a formula that has
parentheses, pay attention to the text. When the insertion point moves over a
parenthesis, Excel momentarily bolds it and its matching parenthesis. This lasts
for less than a second, so be alert.
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In some cases, if your formula contains mismatched parentheses, Excel may pro-
pose a correction to your formula. Figure 9-3 shows an example of the Formula
AutoCorrect feature. You may be tempted simply to accept the proposed correc-
tion, but be careful —in many cases, the proposed formula, although syntactically
correct, isn’t the formula that vou want.

Figure 9-3: Excel's Formula AutoCorrect feature often
suggests a correction to an erroneous formula.

Excel’s Built-in Functions

Excel provides a bewildering number of built-in worksheet functions that you can
use in your formulas. These include common functions (such as SUM, AVERAGE,
and SQRT) as well as functions designed for special purposes, such as statistics or
engineering. Functions can greatly enhance the power of your formulas. They can
simplify your formulas and make them easier to read; in many cases, functions
enable you to perform calculations that would not be possible otherwise. If you
can'’t find a worksheet function that you need, Excel even lets you create your own
custom functions.

Excel’s built-in functions are discussed in the next chapter, and Chapter 35 covers
the basics of creating custom functions by using VBA.

Entering Formulas

As mentioned earlier, a formula must begin with an equal sign to inform Excel that
the cell contains a formula rather than text. Basically, two ways exist to enter a
formula into a cell: enter it manually or enter it by pointing to cell references. Each
of these methods is discussed in the following sections.
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Entering Formulas Manually

Entering a formula manually involves, well, entering a formula manually. You simply
type an equal sign (=), followed by the formula. As you type, the characters appear
in the cell and in the formula bar. You can, of course, use all the normal editing keys
when entering a formula.

Entering Formulas by Pointing

The other method of entering a formula still involves some manual typing, but you
can simply point to the cell references instead of entering them manually. For exam-
ple, to enter the formula =A1+A2 into cell A3, follow these steps:

1. Move the cell pointer to cell A3.

2. Type an equal sign (=) to begin the formula. Notice that Excel displays Enter
in the status bar.

3. Press the up arrow twice. As you press this key, notice that Excel displays a
faint moving border around the cell and that the cell reference appears in cell
A3 and in the formula bar. Also notice that Excel displays Point in the status bar.

4. Type a plus sign (+). The faint border disappears and Enter reappears in the
status bar.

5. Press the up arrow one more time. A2 is added to the formula.
6. Press Enter to end the formula.

Pointing to cell addresses rather than entering them manually is usually more
accurate and less tedious.

When you create a formula that refers to other cells, the cell that contains the for-
mula has the same number format as the first cell it refers to.

Excel includes the Formula Palette feature that you can use when you enter or
edit formulas. To display the Formula Palette, click the Edit Formula button in the
Formula bar (the Edit Formula button looks like an equal sign). The Formula
Palette lets you enter formulas manually or use the pointing techniques described
previously. The Formula Palette, shown in Figure 94, displays the result of the
formula as it’s being entered. The Formula Palette usually appears directly below
the edit line, but you can drag it to any convenient location (as you can see in the
figure).
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Referencing Cells Outside the Worksheet

Formulas can refer to cells in other worksheets — and the worksheets don’t even
have to be in the same workbook. Excel uses a special type of notation to handle
these types of references.

Cells in Other Worksheets

To use a reference to a cell in another worksheet in the same workbook, use the
following format:

Sheethame!Cel TAddress

In other words, precede the cell address with the worksheet name, followed by an
exclamation point. Here’s an example of a formula that uses a cell on the Sheet2
worksheet:

=Al*Sheet2!Al

This formula multiplies the value in cell Al on the current worksheet by the value in
~cell Al on Sheet2.

if the worksheet name in the reference includes one or more spaces, you must
enclose it in single quotation marks. For example, here’s a formula that refers to a
cell on a sheet named All Depts:

=AL*¥"AT1 Depts'lAl

Cells in Other Workbooks

To refer to a cell in a different workbook, use this format:
=[WorkbookNamelSheetName!lCellAddress

In this case, the workbook name (in square brackets), the worksheet name, and an
exclamation point precede the cell address. The following is an example of a
formula that uses a cell reference in the Sheetl warksheet in a workbook named
Budget:

=[Budget.x1s]Shestl Al
If the workbook name in the reference includes one or more spaces, vou must
enclose it (and the sheet name) in single quotation marks. For example, here's a

formula that refers to a cell on Sheetl in a workbook named Budget For 1999:

=A1*'[Budget For 199971Sheetl' Al
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When a formula refers to cells in a different workbook, the other workbook doesn’t
need to be open. If the workbook is closed, you must add the complete path to the
reference. Here’s an example:

=A1*'C:\ MSOffice\Excel\[Budget For 19991Sheatl’ Al

File linking is covered in detail in Chapter 19.

Entering References to Cells Outside the Worksheet

To create formulas that refer to cells not in the current worksheet, use the pointing
technique described earlier (refer to the section “Entering Formulas by Pointing™).
Excel takes care of the details regarding the workbook and worksheet references.
The warkbook that you're using in your formula must be open to use the pointing
method.

if you point to a different worksheet or workbook when creating a formula, you'll
notice that Excel always inserts absolute cell references. Therefore, if you plan to
copy the formula to other cells, make sure that you change the cell references to
relative. This concept of absolute versus relative cell references is discussed in the
following section.

Absolute Versus Relative References

You need to be able to distinguish between relative and absolute cell references. By
default, Excel creates relative cell references in formulas except when the formula
includes cells in different worksheets or workbooks. The distinction becomes
apparent when you copy a formula to another cell.

Relative References

Figure 9-5 shows a worksheet with a formula in cell D2. The formula, which uses the
default relative references, is as follows:

=B2*CZ

When you copy this formula to the two cells below it, Excel doesn’t produce an
exact copy of the formula; rather, it generates these formulas:

« Cell D3: =B3*C3
» Cell D4: =B4*C4
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Excel adjusts the cell references to refer to the cells that are relative to the new
formula. Think of it like this: The original formula contained instructions to multiply
the value two cells to the left by the value one cell to the left. When you copy the
cell, these instructions get copied, not the actual contents of the cell. Usually, this is
exactly what you want. You certainly don’t want to copy the formula verbatim; if
you did, the new formulas would produce the same value as the original formula.

Figure 9-6: The formula in cell D2 will
be copied to the cell below.

When you cut and paste a formula (move it to another location), the cell refer-
ences in the formula aren't adjusted. Again, this is what you usually want to hap-
pen. When you move a formula, you generally want it to continue to refer to the
original cells.

Absolute References

Sometimes, however, you do want a cell reference to be copied verbatim. Figure 9-6
shows an example of a formula that contains an absolute reference. In this example,
cell B6 contains a sales tax rate. The formula in cell D2 is as follows:

=(B2*C2)*$B%6

Notice that the reference to cell B6 has dollar signs preceding the column letter and
the row number. These dollar signs indicate to Excel that you want to use an
absohite cell reference. When you copy this formula to the two cells below, Excel
generates the following formulas:

+ Cell D3: =(B3*C3)*$B$6
+ Cell D4: =(B4*C4)*$B$6

[n this case, the relative cell references were changed, but the reference to cell B6
wasn’t changed, because it’s an absolute reference.
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Figure 9-7: A formula that uses
an absolute cell reference.

Mixed References

An absolute reference uses two dollar signs in its address: one for the column letter
and one for the row number. Excel also allows mixed references in which only one
of the address parts is absolute. Table 9-3 summarizes all the possible types of cell
references.

When would you use a mixed reference? Figure 9-7 shows an example of a situation
in which a mixed reference is appropriate. This worksheet will contain a table of
values in which each cell consists of the value in column A multiplied by the value
in row 1. The formula in cell B2 is as follows:

=B$1*$AZ

Example Type

$A%1 Absolute reference

Ag1 Mixed reference (row number is absolute)

This formula contains two mixed cell references. In the B$1 reference, the row
number is absolute, but the column letter is relative. In the $A2 reference, the row
number is relative, but the column letter is absolute. You can copy this formula to
the range B2:E5 and each cell will contain the correct formula. For example, the
formula in cell E5 would be as follows:

=EF1*FAL
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Figure 9-8: This formula
uses a mixed reference.

Entering Nonrelative References

You can enter nonrelative references (absolute or mixed) manually by inserting
dollar signs in the appropriate positions. Or, you can use a handy shortcut: the F4
key. When you're entering a cell reference — either manually or by pointing—you
can press F4 repeatedly to have Excel cycle through all four reference types.

For example, if vou enter =A1 to start a formula, pressing F4 converts the cell
reference to =8A3$1. Pressing F4 again converts it to =A$1. Pressing it again displays
=$A1. Pressing it one more time returns to the original =Al. Keep pressing F4 until
Excel displays the type of reference that you want.

When you name a cell or range, Excel (by default) uses an absolute reference for
the name. For example, if you give the name SalesForecast to A1:A12, the Refers
to box in the Define Name dialog box lists the reference as $A%1:8A%12. This is
almost always what you want. If you copy a cell that has a named reference in its
formula, the copied formula contains a reference to the original name.

When a Formula Returns an Error

Sometimes when you enter a formula, Excel displays a value that begins with a
pound sign (#). This is a signal that the formula is returning an error value. You'll
have to correct the [ormula (or correct a cell that the formula references) to get rid

of the error display.

As noted previously in this chapter, Excel often suggests a correction for an
erroneous formula.

if the entire cell is filled with pound characters, this means that the column isn't
wide enough to display the value. You can either widen the column or change the
number format of the cell.
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Table 94 lists the types of error values that may appear in a cell that has a formula.
Formulas may return an error value if a cell ta which they refer has an error value,
This is known as the ripple effect —a single error value can make its way into lots
of other cells that contain formulas that depend on the cell.

Error Value  Explanation

#NAME? The formula uses a name that Excel doesn’t recognize. This can happen if you
delete a name that's used in the formula or if you have unmatched quotes
when using text.

#NULL! The formula uses an intersection of two ranges that don't intersect (this
concept is described later in the chapter)

#REF! The formula refers to a cell that isn't valid. This can happen if the cell has
been deleted from the worksheet.

Editing Formulas

You can edit your formulas just like you can edit any other cell. You might need to
edit a formula if you make some changes to your worksheet and need to adjust the
formula to accommodate the changes. Or, the formula may return one of the error
values described in the previous section, and you need to edit the formula to
correct the error.

The following are the four ways to get into cell-edit mode:

» Double-click the cell, which enables vou to edit the cell contents directly in
the cell.

* Press F2, which enables you to edit the cell contents directly in the cell.
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« Select the cell that you want to edit, and then click in the formula bar. This
enables you to edit the cell contents in the formula bar.

« Click the Edit Formula button in the Formula bar to access the Formula
Palstte.

Chapter 6 also discusses these methods.

While you're editing a formula, you can select multiple characters either by dragging
the mouse over them or by holding down Shift while you use the direction keys.

You might have a lengthy formula that you can’t seem to edit correctly — and Excel
won'’t let you enter it because of the error. In this case, yvou can convert the formula
to text and tackle it again later. To convert a formula to text, just remove the initial
equal sign (=). When you’re ready to try again, insert the initial equal sign to
convert the cell contents back to a formula.

Changing When Formulas Are Calculated

You've probably noticed that Excel calculates the formulas in your worksheet
immediately. If yvou change any cells that the formula uses, Excel displays the
formula’s new result, with no effort on your part. All this happens when Excel’s
Calculation mode is set to Automatic. In Automatic Calculation mode (which is
the default mnode), Excel follows these rules when calculating your worksheet:

*« When yvou make a change — enter or edit data or formulas, for example —
Excel calculates immediately those formulas that depend on new or edited
data.

» If Excel is in the middle of a lengthy calculation, it temporarily suspends the
calculation when vou need to perform other worksheet tasks; it resumes when
you're finished.

« Formulas are evaluated in a natural sequence. In other words, if a formula in
cell D12 depends on the result of a formula in cell D11, Excel calculates cell
D11 before calculating D12Z.

Sometimes, however, you may want to control when Excel calculates formulas. For
example, if vou create a worksheet with thousands of complex formulas, you'll find
that things can slow to a snail’s pace while Excel does its thing. In such a case, set

Excel’s calculation mode to Manual, which vou can do in the Calculation tab of the
Options dialog box (see Figure 9-9).

To select Manual calculation mode, click the Manual option button. When vou
switch to Manual calculation mode, Excel automatically places a check in the
Recalculate before save check box. You can remove the check if you want to
speed up file saving operations.
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If your worksheet uses any data tables {described in Chapter 26), you may want to
select the Automatic except tables aption. Large data tables calculate notoriously
slowly.

i3
i g LA iR i
Figure 9-9: The Options dialog box lets you control when
Excel calculates formulas.

When you're working in Manual calculation mode, Excel displays Calculate in the
status bar when you have any uncalculated formulas. You can use the following
shortcut keys to recalculate the formulas:

« F9: Calculates the formulas in all open workbooks

» Shift+F9: Calculates only the formulas in the active worksheet. Other
worksheets in the same workbook aren’t calculated.

» Ctrl+Alt+F9: This keyboard shortcut combination isn’t documented. It forces
a complete recalculation. This shorteut became popular when several
recalculation bugs in Excel 97 surfaced.

Excel's Calculation mode isn’t specific to a particular worksheet. When you change
Excel's Calculation mode, it affects all open workbooks, not just the active
workbook.

Handling Circular References

When you’re entering formulas, you may occasionally see a message from Excel like
the one shown in Figure 9-9, indicating that the formula you just entered will result
in a circular reference. A circular reference occurs when a formula refers to its own
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value — either directly or indirectly. For examnple, you create a circular reference if
you enter =A1+A2+A3 into cell A3, because the formula in cell A3 refers to cell A3,
Every time the formula in A3 is calculated, it must be calculated again because A3
has changed. The calculation would go on forever —in other words, the answer will
never be resolved.

Figure 9-10: Excel's way of telling you that your formula
contains a circular reference.

When you get the circular reference message after entering a formula, Excel gives
you two options:

= Click OK to attempt to locate the circular reference

s (lick Cancel to enter the formula as-is

Usually, yvou want to correct any circular references, so you should choose OK.
When yvou do so, Excel displays the Help topic on circular references and the
Circular Reference toolbar (see Figure 9-11). On the Circular Reference toolbar,
click the first cell in the Navigate Circular Reference drop-down list box, and then
examine the cell’s formula. If you cannot determine whether the cell is the cause of
the circular reference, click the next cell in the Navigate Circular Reference box.
Continue to review the formulas until the status bar no longer displays Circular.

If vou ignore the circular reference message (by clicking Cancel), Excel lets you
enter the formula, and displays a message in the status bar to remind you that a
circular reference exists. In this case, the message reads Circular: A3. If you
activate a different workbook, the message simply displays Circular (without the
cell reference).

Excel won't tell you about a circular reference if the Iteration setting is on. You can
check this in the Options dialog box {in the Calculation tab). If Iteration is on, Excel
performs the circular calculation the number of times specified in the Maximum
iterations field (or until the value changes by less than .001 — or whatever value is
in the Maximum change field). In a few situations, you may use a circular refer-
ence intentionally (explained in a following section). In these cases, the Iteration
setting must be on. However, keeping the Iteration setting turned off is best, so
that you are warned of circular references. Most of the time, a circular reference
indicates an error that you must correct.
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Figure 9-11: The Circular Reference toolbar.

Indirect Circular References

Usually, a circular reference is quite obvious and, therefore, easy to identify and
correct. Sometimes, however, circular references are indirect. In other words, a
formula may refer to a formula that refers to a formula that refers back to the original
formula. In some cases, it may require a bit of detective work ta get to the problem.

You may be able to get some assistance identifying a formula’s dependents and
precedents by using the tools on the Circular Reference toolbar, which are dis-
cussed in Chapter 31.

Intentional Circular References

As mentioned previously, you can use a circular reference to your advantage in
some situations. Figure 3-12 shows a simple example.

In this example, a company has a policy of contributing five percent of its net profit to
charity. The contribution itself, however, is considered an expense and is therefore
subtracted from the net profit figure. This produces a circular reference —but this
circular reference can be resolved if the Excel’s lteration setting is turned on.

This workboaok is available on the companion CD-ROM.
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toss fncome
spenses 137 500
ontributions 5,357 =5%*Met_Profit . . o
et Profit 107 143 =Gross_Income-Expenses-Contributions

Figure 9-12: An example of an intentional circular reference.

The Contributions cell contains the following formula:

=5%*Net_Profit
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The Net Profit cell contains the following formula:

=Gross_Income-Expenses-Contributions

These formulas produce a resolvable circular reference. Excel keeps calculating
until the formula results don’t change anymore. To get a feel for how this works,
substitute various values for Gross Income and Expenses. If the Iteration setting is
off, Excel displays its Circular Reference message and won'’t display the correct
result. If the [teration setting is on, Excel keeps calculating until the Contributions
value is, indeed, five percent of Net Profit. In other words, the result becomes
increasingly more accurate until it converges on the final solution. For your conve-
nience, [ include a button on the worksheet that toggles the Iteration setting on and
off by using a simple macro.

Depending on your application, you may need to adjust the settings in the
Maximum iterations field or the Maximum change field in the Options dialog box.
For example, to increase accuracy, you can make the Maximum change field
smaller. If the result doesn’t converge after 100 iterations, you can increase the
Maximum iterations field.

Advanced Naming Techniques

As promised in the preceding chapter, this section describes some additional
technigques that involve names.

Sheet-Level Names

Usually, you can use a range name that you create anywhere within the workbook.
In other words, names, by default, are “workbook level” names rather than “sheet
level” names. But what if you have several worksheets in a workbook and you want
to use the same name (such as Dept_Total) on each sheet? In this case, you need to
create sheet-level names.

To define the name Dept_Total in more than one worksheet, activate the worksheet
in which you want to define the name, choose Insert+ Name+ Define, and then, in
the Names in workbook box, precede the name with the worksheet name and an
exclamation point. For example, to define the name Dept_Total on Sheet2, activate
Sheet? and enter the following in the Define Name dialog box:

SheetZ!Dept_Total

If the worksheet name contains at least one space, enclose the worksheet name in
single quotation marks, like this:

*Adv Depl'!Depl_Tolal
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You also can create a sheet-level name by using the Name box (located at the left
side of the formula bar). Select the cell or range, click in the Name box, and enter
the name, preceded by the sheet’s name and an exclamation point (as shown
previously). Press Enter to create the name.

When you write a formula that uses a sheet-level name on the sheet in which it’s
defined, you don’t need to include the worksheet name in the range name (the
Name box won't display the worksheet name either). If yvou use the name in a
formula on a different worksheet, however, you must use the entire name (sheet
name, exclamation point, and name).

Only the sheet-level names on the current sheet appear in the Name box.
Similarly, only sheet-level names in the current sheet appear in the list when you
open the Paste Name or Define Name dialog boxes.

Using sheet-level names can become complicated if you have an identical book-level
name and sheet-level name (ves, Excel does allow this). In such a case, the sheet-
level name takes precedence over the book-level name — but only in the worksheet
in which you defined the sheet-level name. For example, vou might have defined a
book-level name of Total for a cell on Sheetl. You also can define a sheet-level name
of Total (in, say Sheet2). When Sheet?2 is active, Total refers to the sheet-level name.
When any other sheet is active, Total refers to the book-level name. You can refer to
a sheet-level name in a different worksheet, however, by preceding the name with
the worksheet name and an exclamation point (such as Sheetl!Total). To make your
life easier, just avoid using the same name at the book level and sheet level.

Using Multisheet Names

Names even can extend into the third dimension; that is, they can extend across
multiple worksheets in a workbook. You can’t simply select the multisheet range
and enter a name in the Name box, however. Excel makes vou do a little additional
work to define a multisheet name.

You must use the Define Name dialog box to create a multisheet name, and you
must enter the reference in the Refers to box manually. The format for a multisheet
reference is as follows:

FirstSheet: LastSheet!RangeReference

In Figure 9-13, a multisheet name is being defined for A1:C12 that extends across

Sheetl, Sheet2, and Sheet3.

After the name is defined, you can use it in formulas. This name won'’t appear in the
Name box, however, or in the Go To dialog box. In other words, Excel lets you
define the name, but it doesn’t give you a way to select automatically the cells to
which the name refers.
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Figure 9-13: Creating a multisheet name.

Naming Constants

Even many advanced Excel users don'’t realize that you can give a name to an item
that doesn’t even appear in a cell. For example, if formulas in your worksheet use a
sales tax rate, you would probably insert the tax rate value into a cell and use this
cell reference in your formulas. To make things easier, you would probably also
name this cell something like SalesTax.

Here's another way to do it: Choose Insert» Name+ Define (or press Ctrl+F3) to
bring up the Define Name dialog box. Enter the name (in this case, SalesTax) into
the Names in workbook field. Then, click the Refers to box, delete its contents, and
replace it with a value such as .075 (see Figure 9-14). Don’t precede the constant
with an equal sign. Click OK to close the dialog box.

Figure 9-14: Defining a name that refers to a constant.

You just created a name that refers to a constant rather than a cell or range. If you
type =SalesTax into a cell, this simple formula returns .075 —the constant that you
defined. You also can use this constant in a formula such as =Al1*SalesTax.

As with all names, named constants are stored with the workbook. They can be
used on any worksheet in the workbook.
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In the preceding example, the constant was a value. A constant also can be text,
however. For example, you can define a constant for your company’s name. If you
work for Microsoft, you can define the name MS for Microsoft Corpaoration.

Named constants dont appear in the Name box or in the Go To dialog box—
which makes sense, because these constants don't reside anywhere tangible. They
do appear in the Paste Names dialog box, however, which does make sense,
because you'll use these names in formulas.

As you might expect, you can change the value of the constant by accessing the
Define Name dialog box and simply changing the value in the Refers to box. When
you close the dialog box, Excel uses the new value to recalculate the formulas that
use this name.

Although this technique is useful in many situations, the value is rather difficult to
change. Having a constant located in a cell makes it much easier to modify. If the
value is truly a “constant,” however, vou won’t need to change it.

Naming Formulas

This section takes the preceding section to the next logical level: naming formulas.
Figure 9-15 shows an example of this. In this case, the name MonthlyRate refers to
the following formula:

=5heet3!$B$1/12

When you use the name MonthlyRate in a formula, it uses the value in Bl divided
by 12. Notice that the cell reference is an absolute reference.

Naming formulas gets more interesting when you use relative references rather
than absolute references. When vou use the pointing technique to create a formula
in the Refers to box, Excel always uses absolute cell references, which is unlike its
behavior when vou create a formuila in a cell.

Define Mame

MonthlyRate

Hf All_sales
2l SalesTa

Figure 9-15: Excel lets you give a name to a
formula that doesn't exist in the worksheet.
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Figure 9-16 shows a name, Power, being created for the following formula:

=Sheetl!Al”Sheetl!Bl1

Notice that cell C1 is the active cell, which is very important. When you use this
named formula in a worksheet, the cell references are always relative to the cell
that contains the name. For example, if you enter =POWER into cell D12, cell D12
displays the result of BI12 raised to the power of the value contained in cell C12.

h sheet1 /

Figure 9-16: Naming a formula that uses relative cell references.

Range Intersections

This section describes an interesting concept that is unique to Excel: range
intersections. Excel uses an intersection operator —a space —to determine the
overlapping references in two ranges. Figure 9-17 shows a simple example. The
formula in cell G5 is

=B1:B7 Ad4:E4

and returns 180, the value in cell B4 —that is, the value at the intersection of the
two ranges.
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Figure 9-17: An example of an intersecting range.

The intersection operator is one of three reference operators for ranges. Table 9-5
lists these operators.

, (comma) Spedifies the union of two ranges

The real value of knowing about range intersections is apparent when you use names.
Examine Figure 9-18, which shows a table of values. [ selected the entire table and
then used the Insert* name+ Create command to create names automatically, Excel
created the following names:

CiM Ex. 1052 Page 32



North =Sheetl!$B$2:$E$2 Qtrl =Sheet1!$B$2:$B$5

South =Sheetl!$Bs3:$E$3 Qtr2  =Sheetl1$C$2:$C$5
West  =Sheetl!$B$4:5E$4 Qtr2  =Sheetl!$D$2:$D$5
East =Sheet1'$B$5:3E$5 Qtr4 =Sheetl!1SE$2:3E$5

With these names defined, you’ll find that you can create formulas that are very
easy to read. For example, to calculate the total for Quarter 4, just use this formula:

=SUM(Otr4)

But things really get interesting when you use the intersection operator. Move to
any blank cell and enter the following formula:

=Gtrl West

Figure 9-18: This table demonstrates
how to use range intersections.

This formula returns the value for the first quarter for the West region. In other
words, it returns the value where the Qtrl range intersects with the West range.
Naming ranges in this manner can help you create very readable formulas.

Applying Names to Existing References

When vou create a new name for a cell or a range, Excel doesn’t automatically use
the name in place of existing references in vour formulas. For example, assume that
vou have the following formula in cell F10: =A1-A2.

If vou define a name Income for Al and Expenses for A2, Excel won’t automatically

change your formula to =Income-Expenses. Replacing cell or range references with
their corresponding names is fairly easy, however.
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To apply names to cell references in formulas after the fact, start by selecting the
range that you want to modify. Then, choose Inserte Name+ Apply. Excel displays
the Apply Names dialog box, shown in Figure 9-19 Select the names that you want
to apply by clicking them and then click OK. Excel replaces the range references
with the names in the selected cells.

The Apply Names dialog box has some options. If you click the Options button, the
dialog box expands to display even mwore options. Most of the time, the defaults
work just fine. For more control over the names that you apply, however, you may
want to use one or more of its options. These are described in Excel’s online Help.
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Figure 9-19: The Apply Names dialog
box lets you replace cell orrange
references with names.

Tips for Working with Formulas

This chapter concludes with a few additional tips and pointers relevant to formulas.

Don't “Hard Code” Values

When you create a formula, think twice before using a value in the formula. For
example, if vour formula calculates sales tax (which is 6.5 percent), you may be
tempted to enter a formula such as the following:

+A1%.065

A better approach is to insert the sales tax rate in a cell and use the cell reference.
Or, vou can define it as a named constant by using the technique presented earlier
in this chapter. Doing so makes modifying and maintaining vour worksheet easier.
For example, if the sales tax rate changed to 6.75 percent, you would have to modify
every formula that uses the old value. If the tax rate is stored in a cell, you simply
change one cell and Excel updates all the formulas.

Using the Formula Bar As a Calculator

If vou simply need to perform a calculation, you can use the formula bar as a
calculator. For example, enter the following formula—but don’t press Enter:

=(145*%1.05)/12

If you press Enter, Excel enters the formula into the cell. But because this formula
always returns the same result, you might prefer to store the formula’s result rather
than the formula. To do so, press F9, and then press Enter. Excel stores the formula’s
result (12.6875) rather than the formula. This also works if the formula uses cell
references.

This is most useful when you use worksheet functions. For exarple, to enter the
square root of 221 into a cell, enter =SQRT(221), press F9, and then press Enter.
Excel enters the result: 14.8660687473185. You also can use this technique to
evaluate only part of a formula. Consider this formula:

CiM Ex. 1052 Page 35



=(145*%1.05)/A1

If yvou want to convert to a value just the part in the parentheses, select the part of
the formula that you want to evaluate (that is, select 145%1.05). Then, press F9,
followed by Enter. Excel converts the formula to the following:

=152.25/A1

Making an Exact Copy of a Formula

As yvou know, when you copy a formula, Excel adjusts its cell references when you
paste the formula to a different location. Sometimes, you may want to make an
exact copy of the formula. One way to do this is to convert the cell references to
absolute values, but this isn’t always desirable. A better approach is to select the
formula in edit mode and then copy it to the Clipboards as text. You can do this in
several ways. Here's a step-by-step example of how to make an exact copy of the
formula in Al and copy it to AZ:

1. Double-click Al to get into edit mode.

2, Drag the mouse to select the entire formula. You can drag from left to right ar
from right to left.

3. Click the Copy button on the Standard toolbar. This copies the selected text
to the Clipboards.

4, Press Enter to end edit mode.
5. Select cell AZ,

6. Click the Paste button to paste the text into cell A2,

You also can use this technique to copy just part of a formula, to use that part in
another formula. Just select the part of the formula that you want to copy by
dragging the mouse; then, use any of the available techniques to copy the selection
to the Clipboard. You can then paste the text to another cell.

Formulas (or parts of formulas) copied in this manner won’t have their cell
references adjusted when they are pasted to a new cell, because the formulas are
being copied as text, not as actual formulas.

Converting Formulas to Values

If you have a range of formulas that will always produce the same result (that is,
dead formulas), you may want to convert them to values. As discussed in the previ-
ous chapter, you can use the Edit« Paste Special command to do this. Assume that
range Al:A20 contains formulas that have calculated results that will never change
or that you don’t want to change. For example, if you use the @RAND function to
create a set of random numbers, and you don’t want Excel to recalculate the ran-
dom numbers each time that you press Enter, convert the formulas to values. To
convert these formulas to values:
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1. Select A1:A20.
2. Click the Copy button.

3. Select Edit+ Paste Special. Excel displays its Paste Special dialog box.
4, Click the Values option button and then click OK.

5. Press Enter or Esc to cancel paste mode.

Array Formulas

Excel supports another type of formula called an array formula. Array formulas
can he extremely powerful, because they let you work with complete ranges of
cells rather than individual cells. You'll find that you can perform some amazing
feats by using array formulas. This is a rather advanced concept, which is
covered in Chapter 20.

Summary

This chapter introduces the concept of formulas. Formulas are entered into cells
and use values found in other cells to return a result. This chapter explains how to
enter and edit formulas, when to use absolute cell references, how to identify errors
in your formulas, and how to handle circular references (either accidental or inten-
tional). It also explains how to set Excel to Manual recalculation mode —and why
you would need to do so. The chapter continues by discussing some additional
naming techniques that can make your formulas even more powerful. This chapter
concludes with a series of tips that can help you get the most out of formulas.
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Using
Worksheet
Functions

I he preceding chapter discussed formulas. This chapter
continues with coverage of Excel's built-in worksheet
functions.

What Is a Function?

Functions, in essence, are built-in tools that you use in formu-
las. They can make your formulas perform powerful feats and
save you a lot of time. Functions can do the following:

» Simplify your formulas

* Allow formulas to perform calculations that are
otherwise impossible

« Speed up some editing tasks

= Allow “conditional” execution of formulas — giving them
rudimentary decision-making capability

Function Examples

A built-in function can simplify a formula significantly. To cal-
culate the average of the values in ten cells (A1:A10) without
using a function, you need to construct a formula like this:

= (AL +AZHABTAL+ALTAGFAT+ABHAGHALD) /10

Not very pretty, is it? Even worse, you would need to edit this
formula if you added another cell to the range. You can replace
this formula with a much simpler one that uses one of Excel’s
built-in worksheet functions:

=AVERAGE(AL:ALQ)
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Next, look at how using a function can enable you to perform calculations that would
not be possible otherwise. What if you need to determine the largest value in a range?
A formula can’t tell you the answer without using a function. Here's a simple formula
that returns the largest value in the range A1:D100:

=MAX(AL:D100)

Functions also can sometimes eliminate manual editing. Assume that you have a
worksheet that contains 1,000 names in cells A1:A1000, and all the names appear in
all capital letters. Your boss sees the listing and informs you that the names will be
mailmerged with a form letter and that alluppercase is not acceptable; for example,
JOHN F. CRANE must appear as John F. Crane. You could spend the next several
hours reentering the list — or you could use a formula like the following, which uses
a function to convert the text in cell Al to proper case:

=PROPER{AL)

Enter this formula once in cell Bl and then copy it down to the next 999 rows. Then,
select B1:B1000 and use the Edit* Paste Special command (with the Values option)
to convert the formulas to values. Delete the original column, and you've just
accomplished several hours of work in less than a minute.

One last example should convince you of the power of functions. Suppose that you
have a worksheet that calculates sales commissions. If the salesperson sold more
than $100,000 of product, the commission rate is 7.5 percent; otherwise, the com-
mission rate is 5.0 percent. Without using a function, vou would have to create two
different formulas and make sure that you use the correct formula for each sales
amount. Here’s a formula that uses the IF function to ensure that you calculate the
correct commission, regardless of the sales amount:

=IF{AI<100000,A1*5% Al*7 . 5%)

More About Functions

All told, Excel includes more than 300 functions. And if that’s not enough, you can
purchase additional specialized functions from third-party suppliers, and even
create your own custom functions (using VBA), if you're so inclined.

You can easily be overwhelmed by the sheer number of functions, but you’ll proba-
bly find that you use only a dozen or so of the functions on a regular basis. And as
you'll see, Excel’s Paste Function dialog box (described later in this chapter) makes
it easy to locate and insert a function, even if it's not one that you use frequently.

Appendix B contains a complete listing of Excel’s worksheet functions, with a brief
description of each.
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Function Arguments

In the preceding examples, you may have noticed that all the functions used paren-
theses. The information inside the parentheses is called an argument. Functions
vary in how they use arguments. Depending on the function, a function may use:

L]

L]

No arguments

One argument

A fixed number of arguments

An indeterminate number of arguments

Optional arguments

The RAND function, which returns a random number between 0 and 1, doesn’™ use
an argument. Even if a function doesn’t use an argument, however, you must still
provide a set of empty parentheses, like this:

=RANDC)

If a function uses more than one argument, you must separate each argument by
a comma. The examples at the beginning of the chapter used cell references for
arguments. Excel is quite flexible when it comes to function arguments, however.
An argument can consist of a cell reference, literal values, literal text strings, or
expressions.
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Using Names As Arguments

As you've seen, functions can use cell or range references for their arguments. When
Excel calculates the formula, it simply uses the current contents of the cell or range
to perform its calculations. The SUM function returns the sum of its argument(s). To
calculate the sum of the values in A1:D20, vou can use:

=SUMCAL:AZ20)

And, not surprisingly, if vou've defined a name for A1:A20 (such as Sales), you can
use the name in place of the reference:

=S5UM(5ales)

In some cases, you may find it useful to use an entire column or row as an
argument. For example, the formula that follows sums all values in column B:

=SUM(E:B)

This technique is particularly useful if the range that you're summing changes (if
you're continually adding new sales figures, for instance). If you do use an entire
row or column, just make sure that the row or column doesn’t contain extraneous
information that you don’t want included in the sum. You might think that using
such a large range (a column consists of 65,536 cells) might slow down calculation
time — this isn’t true. Excel’s recalculation engine is quite efficient.

Literal Arguments

A literal argument is a value or text string that you enter into a function. For
example, the SQRT function takes one argument. In the following example, the
formula uses a literal value for the function’s argument:

=SQRT(225)

Using a literal argument with a simple function like this one defeats the purpose of
using a formula. This formula always returns the same value, so it could just as
easily be replaced with the value 15. Using literal arguments makes more sense with
formulas that use more than one argument. For example, the LEFT function (which
takes two arguments) returns characters from the beginning of its first argument;
the second argument specifies the number of characters. If cell Al contains the text
Budget, the following formula returns the first letter, or B:

=LEFT(AL, 1)

Expressions As Arguments

Excel also lets you use expressions as arguments. Think of an expression as a
formula within a formula. When Excel encounters an expression as a function’s
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argument, it evaluates the expression and then uses the result as the argument’s
value. Here'’s an example:

=SQRT (AL 2)+(A272))

This formula uses the SQRT function, and its single argument is the following
expression:

(A1ANZ2)+(A272)

When Excel evaluates the formula, it starts by evaluating the expression in the
argument and then computes the square root of the result.

Other Functions As Arguments

Because Excel can evaluate expressions as arguments, vou shouldn’t be surprised
that these expressions can include other functions. Writing formulas that have
functions within functions is sometimes known as nesting functions. Excel starts by
evaluating the most deeply nested expression and works its way out. Here’s an
example of a nested function:

=SINCRADIANS(BY})

The RADIANS function converts degrees to radians — which is the unit used by all
of Excel’s trigonometric functions. If cell B9 contains an angle in degrees, the
RADIANS function converts it to radians, and then the SIN function computes the
sine of the angle.

With a few exception, you can nest functions as deeply as you need, as long as you
don’t exceed the 1,024-character limit for a formula.

Ways to Enter a Function

You have two ways available to enter a function into a formula: manually or by
using the Paste Function dialog box.

Entering a Function Manually

If you're familiar with a particular function —you know how many arguments it
takes and the types of arguments —vou may choose simply to type the function
and its arguments into vour formula. Often, this method is the most efficient.
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When you enter a function, Excel always converts the function’s name to upper-
case. Thus, always using lowercase when you type functions is a good idea: if Excel
doesn’t convert it to uppercase when you press Enter, then Excel doesn’t recognize
your entry as a function — which means that you spelled it incorrectly.

If you omit the closing parenthesis, Excel adds it for you automatically. For exam-
ple, if you type =SUM(A1:C12 and press Enter, Excel corrects the formula by adding
the right parenthesis.

Pasting a Function

Formula Palette assists you by providing a way to enter a function and its arguments
in a semiautomated manner. Using the Formula Palette ensures that the function is
spelled correctly and has the proper number of arguments in the correct order.

To insert a function, start by selecting the function from the Paste Function dialog
box, shown in Figure 10-1. You can open this dialog box by using any of the follow-
ing methods:

« Choose the Insert* Function command from the menu

» Click the Paste Function button on the Standard toolbar

* Press Shift+F3
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Figure 10-1: The Paste Function dialog box.

The Paste Function dialog box shows the Function category list on the left side of
the dialog box. When you select a category, the Function name list box displays the
functions in the selected category.

The Most Recently Used category lists the functions that you've used most recently.
The All category lists all the functions available across all categories. Use this if you
know a function’s name, but aren’t sure of its category.

To select a function quickly in the Most Recently Used category, click the Edit
Formula icon in the formula bar and then select the function from the function list
(which occupies the space usually used by the Name box).

When vou select a function in the Function name list box, notice that Excel displays
the function (and its argument names) in the dialog box, along with a brief descrip-
tion of what the function does.

When you locate the function that you want to use, click OK. Excel’s Formula
Palette appears, as in Figure 10-2, and the Name box changes to the Formula List
box. Use the Formula Palette to specify the arguments for the function. You can
easily specify a range argument by clicking the Collapse Dialog button (the icon at
the right edge of each box in the Formula Palette). Excel temporarily collapses the
Formula Palette to a thin box, so that you can select a range in the worksheet.
When you want to redisplay the Formula Palette, click the button again.

The Formula Palette usually appears directly below the formula bar, but you can
move it to any other location by dragging it.
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Figure 10-2: The Formula Palette.

Inserting a function: An example

This section presents a step-by-step example that explains how to insert a function
into a formula. The formula uses the AVERAGE function to compute the average of a
range of cells. To insert a function into a formula, proceed as follows:

1. Open a new workbook and enter values into HI:H6 (any values will do).
2. Select cell H7. This cell will contain the formula.

3. Click the Insert Function button on the Standard toolbar. Excel displays its
Paste Function dialog box.

4. Because the AVERAGE function is in the Statistical category, click Statistical in
the Function category list box. The Function name list box displays the
statistical functions.

5. Click AVERAGE in the Function name list box. The dialog box shows the
function and its list of arguments. It also displays a brief description of the
function.

6. Click the OK button. Excel closes the Paste Function dialog box and displays
the Formula Palette (see Figure 10-3) to prompt you for the function’s
arguments.
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‘The Formula Palette, offering assistance with a function’s argument
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More about entering functions
The following are some additional tips to keep in mind when you use the Formula
Palette to enter functions:

Click the Help button (or press F1) at any time to get help about the function
that you selected.

If you're starting a new formula, the Formula Palette automatically provides
the initial equal sign for you.

If the active cell is not empty when you invoke the Formula Palette, you will
be able to edit the formula.

You can use the Paste Function dialog box to insert a function into an existing
formula. Just edit the formula and move the insertion point to the location
where you want to insert the function. Then, open the Paste Function dialog
box and select the function.

If you change your mind about entering a function, click the Cancel button.

The number of boxes that you see in the Formula Palette is determined by the
number of arguments used by the function that you selected. If a function
uses no arguments, you won't see any boxes. If the function uses a variable
number of arguments (such as the AVERAGE function), Excel adds a new box
every time that you enter an optional argument.

On the right side of each box, vou’'ll see the current value for each argument.

A few functions, such as INDEX, have more than one form. If you choose such
a function, Excel displays another dialog box that lets you choose which form
you want to use.

If you only need help remembering a function’s arguments, type an equal
sign and the function’s name, and then press Ctrl+Shift+A. Excel inserts the
function with placeholders for the arguments. You need to replace these
placeholders with actual arguments.

To locate a function quickly in the Function name list that appears in the
Paste Function dialog box, open the list box, type the first letter of the func-
tion name, and then scroll to the desired function. For example, if you have
selected the All category and want to insert the SIN function, click anywhere
on the Function name list box and press S. Excel selects the first function
that begins with 5 —very close to SIN.

If you’re using the Formula Palette and want to use a function as the argument
for a function (a nested function), click in the bax where you want the argument
to appear. Then, open the Function List and select the function. Excel will insert
the nested function and prompt vou for its arguments.

If the active cell contains a formula that uses one or more functions, the

Formula Palette lets you edit each function. In the formula bar, click the

function that you want to edit. Figure 10-4 shows a formula with multiple
functions.
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Figure 10-4: If the formula contains multiple functions, click the function in the formula
bar to edit it.

Function Examples

This section presents examples of formulas that use functions. [t covers all cate-
gories listed in the Paste Function dialog box, but not every available function. For
more information about a particular function, consult the online Help. For a list of
all functions by category, use the Paste Function dialog box.

You can also look at Appendix B for more functions by category.

Mathematical and trigonometric functions

Excel provides 50 functious in this category, more than enough to do some serious
number crunching. The category includes common functions, such as SUM and INT,
as well as plenty of esateric functions.

INT

The INT function returns the integer (non-decimal) portion of a number by
truncating all digits after the decimal point. The example that follows returns 412:

=INT(412.98)
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RAND

The RAND function, which takes no arguments, returns a uniform random number
that is greater than or equal to 0 and less than 1. “Uniform” means that all numbers
have an equal chance of being generated. This function often is used in worksheets,
to simulate events that aren’t completely predictable —such as winning lottery
numbers — and returns a new result whenever Excel calculates the worksheet.

In the example that follows, the formula returns a random number between 0 and
12 (but 12 will never be generated):

=RAND()*12

The following formula generates a random integer between two values. The cell
named Lower contains the lower bound, and the cell named Upper contains the
upper bound:

=INT((Upper-Lower+L)*RAND()+Lower}

ROMAN

The ROMAN function converts a value to its Roman-numeral equivalent ¢hey, |
never said all the functions were useful). Unfortunately for old-movie bulffs, no
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function exists to convert in the opposite direction. The function that follows
returns MCMXCVIIL

=ROMAN{1998)

ROUND

The ROUND function rounds a value to a specified digit to the left or right
of the decimal point. This function is often used to control the precision of
yvour calculation. ROUND takes two arguments: the first is the value to be
rounded; the second is the digit. If the second argument is negative, the
rounding occurs to the left of the decimal point. Table 10-1 demonstrates,
with some examples, how this works.

Function Result

—ROUND(123.457,1) 123.50

—ROUND(123.457-1)  120.00

=ROUND(123.457,-3) 0.00

Don't confuse rounding a value with number formatting applied to a value. When
a formula references a cell that has been rounded with the ROUND function, the
formula uses the rounded value. If a number has been formatted to appear
rounded, formulas that refer to that cell use the actual value stored.

if your work involves rounding, also check out the ROUNDUP and ROUNDDOWN
functions. In addition, the FLOOR and CEILING functions let you round to a specific
multiple —for example, you can use FLOOR to round a value down to the nearest
multiple of 10 (124.5 would be rounded to 130).

Pl

The Pl function returns the value of & significant to 14 decimal places. [t doesn’t
take any arguments and is simply a shorteut for the value 3.14159265358979. In the
example that follows, the formula calculates the area of a circle (the radius is stored
in a cell named Radius):

=PI{)*(Radius”2;
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SIN

The SIN function returns the sine of an angle. The sine is defined as the ratio between
the opposite side and the hypotenuse of a triangle. SIN takes one argument—the
angle expressed in radians. To convert degrees to radians, use the RADIANS function
(a DEGREES Flunction also exists to do the opposite conversion). For example, if cell
F21 contains an angle expressed in degrees, the formula that follows returns the sine:

=SINCRADIANS(F21))

Excel contains the full complement of trigonometric functions. Consult the online
Help for details.

SQRT
The SQRT function returns the square root of its argument. If the argument is
negative, this function returns an error. The example that follows returns 32:

=SORT(1024)

To compute a cube root, raise the value to the /3 power. The example that follows
returns the cube root of 32768 — which is 32, Other roots can be calculated in a
similar manner.

=32768+(1/3)

SUm

If you analyze a random sample of workbooks, vou’ll likely discover that SUM is the
most widely used function. It's also among the simplest. The SUM function takes
from 1 to 30 arguments. To calculate the sum of three ranges (A1:A10, C1:10, and
E1:E10), you use three arguments, like this:

=SUM(AL:A10,C1:10,E1:E1D)

The arguments don’t have to be all the same type. For example, you can mix and
match single cell references, range references, and literals, as follows:

=SUM(AL,C1:10,125)

Because the SUM function is so popular, the Excel designers made it very accessi-
ble —automatic, in fact. To insert a formula that uses the SUM function, just click
the AutoSum button on the Standard toolbar. Excel analyzes the context and sug-
gests a range for an argument. If it suggests correctly (which it usually does), press
Enter or click the AutoSum button again. If Excel’s guess is incorrect, just drag the
mouse and make the selection yourself. To insert a series of SUM formulas —to add
several columns of numbers, for example — select the entire range and then click
AutoSum. In this case, Excel knows exactly what you want, so it doesn’t ask you to
confirm it.
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SUMIF

The SUMIF function is useful for calculating conditional sums. Figure 10-5 displays
a worksheet with a table that shows sales by month and by region. The SUMIF
function is used in the formulas in column F. For example, the formula in F2 is as
follows:

=SUMIF(B:B,EZ2,C:C)

HRegional Sales.xls

i

] _|_Regional Summa

Sauth
e st
East
TOTAL

Monthly Summa
Jan 6,611
Fehb S7E2Y
Mar 79,155
Apr 43,783
TOTAL 217,088

Figure 10-5: The SUMIF function returns the sum of values if the
values meet specified criteria.

SUMIF takes three arguments. The first argument is the range that you’re using in
the selection criteria—in this case, the entire columm B. The second argument is
the selection criteria, a region name in the example. The third argument is the
range of values to sum if the criteria are met. In this example, the formula in F2
adds the values in column C only if the corresponding text in column B matches
the region in column E.

The figure also shows the data summarized by month. The formula in F9 is the
following:

=SUMIFCAIAL,ES,C:C)
You also can use Excel's pivot table feature to perform these aperations.

Pivot tables are covered in Chapter 25.
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Text Functions

Although Excel is primarily known for its numerical prowess, it has 23 built-in
functions that are designed to manipulate text, a few of which are demonstrated in
this section.

CHAR

The CHAR function returns a single character that corresponds to the ANSI code
specified in its argument (these codes range from 1 to 255). The CODE function
performs the opposite conversion., The formula that follows returns the letter A:

=CHAR(ES)

This function is most useful for returning symbols that are difficult or immpossible to
enter from the keyboard. For example, the formula that follows returns the
copyright symbol (©):

=CHAR(169)

Figure 10-6 shows the characters returned by the CHAR function for arguments
from 1 to 255 (using the Arial font).

Not all codes produce printable characters, and the characters may vary depend-
ing on the font used.
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Figure 10-6: Characters returned by the CHAR function.
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LEFT

The LEFT function returns a string of characters of a specified length from another
string, beginning at the leftmost position. This function uses two arguments. The
first argument is the string and the second argument (optional) is the number of
characters. If the second argument is omitted, Excel extracts the first character
from the text. In the example that follows, the formula returns the letter B:

=LEFT("B.B. King™)
The formula that follows returns the string Alber:
=LEFT("Albert King",5)
Excel also has a RIGHT function that extracts characters from the right of a string of

characters and a MID function (described after the next section) that extracts char-
acters from any position.

LEN

The LEN function returns the number of characters in a string of text. For example,
the following formula returns 12:

=LEN("Stratocaster”)

If you don’t want to count leading or trailing spaces, use the LEN function with a
nested TRIM function. For example, if you want to know the number of characters
in the text in cell Al without counting spaces, use this formula:

=LENCTRIM(AL))

MID

The MID function returns characters from a text string. It takes three arguments.
The First argument is the text string. The second argument is the position at which
you want to begin extracting. The third argument is the number of characters that
you want to extract. If cell Al contains the text Joe Louis Walker, the formula that
follows returns Louis:

=MID(AL,5,5)

REPLACE

The REPLACE function replaces characters with other characters. The first argu-
ment is the text containing the string that vou're replacing. The second argument is
the character position at which you want to start replacing. The third argument is
the number of characters to replace. The fourth argument is the new text that will
replace the existing text. In the example that follows, the formula returns Albert
Collins:

=REPLACE("Albart King".,8,4,"Collins")
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SEARCH

The SEARCH function lets you identify the position in a string of text in which
another string occurs. The function takes three arguments. The first argument is
the text for which you're searching. The second argument is the string that you
want to search. The third argument (optional) is the position at which you want to
start searching. If you omit the third argument, Excel starts searching from the
beginning of the text.

In the example that follows, assume that cell Al contains the text John Lee Hooker.
The formula searches for a space and returns 5, because the first space character
was found at the fifth character position.

=SEARCH{" ",Al,1)

To find the second space in the text, use a nested SEARCH function that uses the
result of the first search (incremented by one character) as the third argument:

=SEARCH{™ " ,AL,SEARCH(" " AL,1)+1)

The following formula uses the LEFT function to return the characters to the left of
the first space in the text in cell Al. For example, if Al contains Jimmy Dawkins, the
formula would return the first name Jimmy:

=LEFTCAL,SEARCH(™ ", Al))

The preceding formula has a slight flaw: if the text in cell Al contains no spaces, the
formula results in an error. Here's an improved version that returns the entire string
in Al if it doesn’t contains a space:

=[F{ISERROR(SEARCH(™ " Al)) ALl,LEFT(AL,SEARCH{" ", ALl)))

UPPER

The UPPER function converts characters to uppercase. If cell Al contains the text
Lucille, the formula that follows returns LUCILLE:

=UPPER(CAL)
Excel also has a LOWER function (to convert to lowercase) and a PROPER

function (to convert to proper case). In proper case, the first letter of each word is
capitalized.

Logical Functions

The Logical category contains only six functions (although several other functions
could, arguably, be placed in this category). This section discusses three of these
functions: IF, AND, and OR.
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IF

The IF function is one of the most important of all functions. This function can give
your formulas decision-making capability.

The IF function takes three arguments. The first argument is a logical test that must
return either TRUE or FALSE. The second argument is the result that you want the
formula to display if the first argument is TRUE. The third argument is the result
that you want the formula to display if the first argument is FALSE.

In the example that follows, the formula returns Positive if the value in cell Al is
greater than zero, and returns Negative otherwise:

=I[F{AL>0,"Positive”,"Negative")

Notice that the first argument (Al>0) evaluates to logical TRUE or FALSE. This
formula has a problem in that it returns the text Negative if the cell is blank or
contains 0. The solution is to use a nested [F function to perform another logical
test. The revised formula is as follows:

=L[F{AL>0,"Positive™, IF{AL<O, "Negative™,  "Zerao"))

The formula looks complicated, but when vou break it down, you see that it’s rather
simple. Here’s how the logic works. If Al is greater than 0, the formula displays
Positive, and nothing else is evaluated. If Al is not greater than zero, however, the
second argument is evaluated. The second argument is as follows:

IF(ALLO, "Negative™,"Zero")

This is simply another IF statement that performs the test on Al again. If it’s less
than 0, the formula returns Negative. Otherwise, it returns Zero. You can nest [F
statements as deeply as you need to—although it can get very confusing after
three or four levels.

Using nested IF functions is quite common, so understanding how this concept
works is in your best interest. Mastering IF will definitely help you to create more
powerful formulas.

Figure 10-7 shows an example of using the IF function to calculate sales commis-
sions. In this example, the usual commission rate is 5.5 percent of sales. If the total
sales of a sales rep exceeds the sales goal, the commission rate is 6.25 percent. The
formula in cell C6, shown next, uses the IF function to make a decision regarding
which commission rate to use based on the sales amount:

=[F{(B6>=SalesGoal ,B5*BonusRate,B6*CommissionRate)
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$160,000
5.50%
5.25%

Sales issi
$149 823 $8,240
§$152 023 43 501
$209 122 ~_$13070
§122.023 §6,711

$83 233 §4 578
$209 323 $13,083
§148 744 $8,181
§159 872 §9 992

sales commissions.

AND

The AND function returns a logical value (TRUE or FALSE) depending on the logical
value of its arguments. I all its arguments return TRUE, the AND function returns
TRUE. If at least one of its arguments returns FALSE, AND returns FALSE.

In the example that follows, the formula returns TRUE if the values in cells A1:A3
are all negative:

=AND(AL<O,A2<0,A3<0)

The formula that follows uses the AND function as the first argument for an [F
function. If all three cells in A1:A3 are negative, this formula displays All Negative.
If at least one is not negative, the formula returns Not All Negative:

=[F{AND(ALIL0,A2<0,A3<0),"A1T Negative”,"Not ATl Negative”}

OR

The OR function is similar to the AND function, but it returns TRUE if at least one of
its arguments is TRUE; otherwise, it returns FALSE. In the example that follows, the
formula returns TRUE if the value in any of the cells—Al, A2, or A3—is negative:

=0R{ALL0,A2<0,A3<D)

Information Functions

Excel’s 15 functions in the Information category return a variety of information
about cells. Many of these functions return a logical TRUE or FALSE.
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CELL

The CELL function returns information about a particular cell. It takes two arguments.
The first argument is a code for the type of information to display. The second argu-
ment is the address of the cell in which you're interested.

The example that follows uses the "type” code, which returns information about
the type of data in the cell. It returns b if the cell is blank, {if it contains text (a
label), or ¢ if the cell contains a value or formula. For example, if cell Al contains
text, the following formula returns £

=CELL("type", 6 Al}

If the second argument contains a range reference, Excel uses the upper-left cell in
the range.

Excel has other functions that let you determine the type of data in a cell. The fol-
lowing functions may be more useful: ISBLANK, ISERR, ISERRCR, ISLOGICAL, ISNA,
ISNONTEXT, ISNUMBER, ISREF, ISTEXT, and TYPE.

Table 10-2 lists the possible values for the first argument of the CELL function.
When using the CELL function, make sure that you enclose the first argument in
quotation marks.

Type What It Returns

col Column number of the cell

contents The contents of the cell

format Text value corresponding to the number format of the cell

0 if the cell is not locked; 1 if the cell is locked

type Text value corresponding to the type of data in the cell
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INFO

The INFO function takes one argument —a code for information about the operating
environment. [n the example that follows, the formula returns the path of the current
folder (that is, the folder that Excel displays when you choose Files Open):

=INFO("directory"™)

Table 10-3 lists the valid codes for the INFO function. The codes must be enclosed
in quotation marks.

Code What It Returns

memavail Amount of memory available, in bytes

numfile Number of worksheets in all open workbooks (including hidden workbooks
and add-ins)

osversion Current operating system version, as text

release Version of Excel

totmem Total memory available on the system, in bytes

ISERROR

The ISERROR function returns TRUE if its argument returns an error value.
Otherwise, it returns FALSE. This function is useful for controlling the display of
errors in a worksheet.

Figure 10-8 shows a worksheet that is set up to track monthly sales. Each month,
the worksheet is updated with two figures: the number of sales reps on staff and the
total sales for the month. Formulas in columms E and F, respectively, calculate the
percentage of the sales goal (Actual Sales divided by Sales Goal) and the average
sales per sales rep. Notice that the formulas in column F display an error when the
data is missing. Cell F2 contains a simple formula:

=pz2/C2
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To aveid displaying an error for missing data, change the formula to the following
formula and copy it to the cells that follow. If the division results in an error, the
formula displays nothing. Otherwise, it displays the result.

=[F{ISERROR(DZ2/C2),"",D2/C2)

Manthly Sales Tracking. xls

“Actual

Sales

500,000

510,233
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625 000

618,733

39%

550 000
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5€0,£23

8%

600,000

625000]
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100%]|

0%

650,000

Q%

675 000

0%

700,000

0%

726 000

0%

750,000

0%

775,000

0%

refer to missing data.

Date and Time Functions

If you use dates or times in your worksheets, you owe it to vourself to check out

Excel’s 14 functions that work with these types of values. This section

demonstrates a few of these functions.

TODAY

Excel offers several other functions that let you trap error values: ERRORTYPE,
ISERR, and ISNA. Also, note that the preceding formula could have used the
ISBLANK function to test for missing data.

To work with dates and times, you should be familiar with Excel's serial number
date-and-time system. Refer to Chapter 6.

The TODAY function takes no argument. It returns a date that corresponds to the
current date —that is, the date set in the system. If you enter the following formula

into a cell on June 16, 1998, the formula returns 6/16/98:

=10DAY ()
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Excel also has a NOW function that returns the current system date and the current
system time.

DATE

The DATE function displays a date based on its three arguments: year, month, and
day. This function is useful if vou want to create a date based on information in
your worksheet. For example, if cell Al contains 1998, cell Bl contains 12, and cell
C1 contains 25, the following formula returns the date for December 25, 199&:

=DATE(ALl,B1,C1)

DAY

The DAY function returns the day of the month for a date. If cell Al contains the
date 12/25/98, the following formula returns 25:

=DAY(AL)

Excel also includes the YEAR and MONTH functions that extract from a date the
year part and month part, respectively.

3

WEEKDAY

The WEEKDAY function returns the day of the week for a date. It takes two argu-
ments: the date and a code that specifies the type of result (the second argument is
optional). The codes are listed in Table 10-4.

Code What It Returns

2 Numbers 1-7, corresponding to Monday through Sunday

If cell Al contains 12/25/98, the formula that follows returns 6 —which indicates
that this date is a Friday:

=WEEKDAY (AL)

You also can format cells that contain dates to display the day of the week as part
of the format. Use a custom format code of ddd (for abbreviated days of the week)
or dddd (for fully spelled days of the week).
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TIME

The TIME function displays a time based on its three arguments: hour, minute, and
second. This function is useful if you want to create a titne based on information in
your worksheet. For example, if cell Al contains 8, cell B1 contains 15, and cell C1
contains 0, the following formula returns &:15:00 AM:

=TIME(ALl,B1,C1;

HOUR

The HOUR function returns the hour for a time. If cell Al contains the time 8:15:00
AM, the following formula returns 8:

=HOURC(AL)

Excel also includes the MINUTE and SECOND functions, which extract the minute
part and second part, respectively, from a time.

Financial Functions

The Financial function category includes 16 functions that are designed to perform
calculations that involve money.

Depreciation functions

Excel offers five functions to calculate depreciation of an asset over time. The
function that you choose depends on the type of depreciation that vou use. Figure
10-9 shows a chart that depicts how an asset is depreciated over time, using each
of the five depreciation functions.

Depreciation Methoo Comparison

$30.000
—e— Straight-line
$745.000 —s— Declining halance
—&— Double-declining balance
$20,000 - —i— Sum-of-the years digits
—— Variable-declining halance

Value o1 Assel
%
o
[an }
=
&

$.0,000
$2.000
bile] :
P El ] & / g El
Period

Figure 10-9: A comparison of Excel’s five depreciation functions.
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Table 10-5 summarizes the depreciation functions and the arguments used by each.
For complete details, consult the online Help system.

Function Depreciation Method Arguments*

DB Declining balance Cost, Salvage, Life, Period, [Month]

SYD Sum-of-the year's digits Cost, Salvage, Life, Period

* Argurnents in brackets are optional

The arguments for the depreciation functions are described as follows:

» Cost: Original cost of the asset.

» Salvage: Salvage cost of the asset after it has been fully depreciated.
» Life: Number of periods over which the asset will be depreciated.

» Period: Period in the Life for which the calculation is being made.

= Month: Number of months in the first year; if omitted, Excel uses 12.

» Factor: Rate at which the balance declines; if omitted, it is assumed to be 2
(that is, double-declining).

+ Rate: Interest rate per period. If payments are made monthly, for example,
you must divide the annual interest rate by 12,

Loan and annuity functions
Table 10-6 lists the functions that can help you perform calculations related to
loans and annuities.

Notice that these functions all use pretty much the same arguments — although
the exact arguments that are used depend on the function. To use these functions
successfully, you must understand how to specily the arguments correctly. The
following list explains these arguments:

» Nper: Total number of payment periods. For a 30-year mortgage loan with
monthly payments, Nper is 360.

* Per: Period in the loan for which the calculation is being made; it must be a
number between 1 and Nper.
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« Pmt: Fixed payment made each period for an annuity or a loan. This usually
includes principal and interest (but not fees or taxes).

« FV: Future value {or a cash balance) after the last payment is made. The
future value for a loan is (. If FV is omitted, Excel uses (.

« Type: Either 0} or 1, and indicates when payments are due. Use ( if the pay-
ments are due at the end of the period, and 1 if they are due at the beginning
of the period.

* Guess: Used only for the RATE function. It’s your best guess of the internal
rate of return. The closer your guess, the faster Excel can calculate the exact
result.

|

Function Calculation

PV Present value Rate, Nper, Pmt, [FV], [Type]

ISPMT Payment interest Rate, Per, Nper, PV

NPER Number of periods Rate, Pmt, PV, [FV], [Type]

* Arguments in brackels are optional

This book’s CD-ROM contains an example workbook that demonstrates the use of the
PMT, PPMT, and IPMT functions to calculate a fixed-interest amortization schedule.

Lookup and Reference Functions

The 17 functions in the Lookup and Reference category, some of which are demon-
strated in this section, are used to perform table lookups and obtain other types of
information.

VLOOKUP

The VLOOKUP function can be quite useful when vou need to use a value from a
table, such as a table of tax rates. This function retrieves text or a value from a
table, based on a specific key in the first column of the table. The retrieved result
is at a specified horizontal offset from the first row of the table.
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Figure 10-10 shows an example of a lookup table (named PartsList) in range D2:F9.
The worksheet is designed so that a user can enter a part number into cell B2
(which is named Part), and formulas in cells B4 and B5 retum the appropriate
information for the part by using the lookup table. The formulas are as follows:

« Cell B4: =VLOOKUP(Part,PartsList,2,FALSE)
« Cell B5: =VLOOKUP(Part,PartsList,3,FALSE)

R AL

Part Humber Unit Cost

145 Meash Rod $5.95

155 Puddle Jaint §12.958]
187 Penguin Bold §1.29

205 |Finger Mut $0.98

225 Toz Holt $0.49

319 Piana Nail $0.99

377 hule Pip $9.95

i i I LB L IR LR EIS L
Figure 10-10: A vertical lookup table.

The formula in B4 looks up the value in the cell named Part in the first column of
the table named PartsList. It returns the value in the column that corresponds to its
third argument (column 2). The fourth argument tells Excel that it must find an
exact match. If the fourth argument is TRUE (or omitted), Excel returns the next
largest value that is less than the lookup value (the values in the first column must
be in ascending order). Using an inexact match is useful for income tax tables, in
which a line doesn’t exist for every possible income.

If you enter a value that doesn’t appear in the table, the formula returns #N/A. You
can change the formula to produce a more user-friendly error message by using the
[SNA function. The revised formula is as follows:

=[F{ISNACVLOOKUP{Part,PartsList,2,FALSE)),"NotFound", VLOOKUP (Pa
rt,PartsList,2,FALSE))

If you enter a part that is not in the list, this formula returns Not Found rather than
#IN/A.

The HLOOKUP function works exactly like VLOOKUP except that it looks up the
value horizontally in the table’s first row.
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MATCH

The MATCH function searches a range for a value or text and returns the relative
row or column in which the item was found. Figure 10-11 shows a simple example.

The worksheet contains the month names in Al:Al12. Cell D2 contains the following
formula:

=MATCH(DL ,A1:A12,0)

The formula returns 7, because cell D1 contains July, and July is the seventh
element in the range A1:A12.

The third argument for the MATCH function specifies the type of match that vou

want (0 means an exact match). Use the values of 1 and -1 when you are willing to
accept an inexact match.

Result:

Blowambar
December

Figure 10-11: Using the MATCH function to return a
relative position in a range.

INDEX

The INDEX function returns a value from a range using a row index (for a vertical
range), column index (for a horizontal range), or both (for a two-dimensional
range). The formula that follows returns the value in A1:J10 that is in its fifth row
and third colummn:

=INDEX(AL1:J10,5.3)

On the CD-ROM, you'll find a workbook that demonstrates the INDEX and MATCH
functions. The workbook, shown in Figure 10-12, displays the mileage between
selected U.S. cities.

The OFFSET function performs a similar function.
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This worksheet
Enter the city hames in cells BS and B6.

City Hame index
MNew Orleans 17
St. Louis 23

Mileage bebueen
Mew Orleans and 673
St. Louis:

| : [tovput o AR B S
Figure 10-12: This workbook uses the INDEX and MATCH functions
to look up the mileage between selected U.S. cities.

INDIRECT

The INDIRECT function returns the value in a cell specified by its text argument. For
example, the following formula returns the value (or text) in cell Al:

=LNDIRECI("AL")

This function is most useful when you use a reference as its argument (not a literal,
as shown previously). For example, suppose cell C9 contains the text Sales and, in
your worksheet, vou have defined the name Sales for cell Al; Al (or Sales) contains
the value 46. The following formula returns 46, the value in the cell named Sales:

=INDIRECT(C9)

This concept can be a bit difficult to grasp, but after you master it, you can put it
to good use. Figure 10-13 shows a multisheet workbook with formulas that use the
INDIRECT function to summarize the information in the other worksheets in the
workbook. Cell B2 contains the following formula, which was copied to the other
cells:

=INDIRECT(" " ™&$AZ2&"""&" ["&B%$1)

This formula builds a cell reference by using text in row 1 and column A. Excel
evaluates the argument as follows:

‘Denver'!Sales

The Denver sheet has a range named Sales. Therefore, the indirect function returns
the value in the cell named Sales on the Denver worksheet.

This file is available on the book’s CD-ROM.
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237 300 536,000
378,309 508,311
143988 443,104
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Figure 10-13: These formulas use the INDIRECT function to
summatize values contained in the other workbooks.

Statistical Functions

The Statistical category contains a whopping 80 functions that perform various
calculations. Many of these are quite specialized, but several are useful for
nonstatisticians.

AVERAGE

The AVERAGE function returns the average (arithmetic mean) of a range of values.
The average is the sum of the range divided by the number of values in the range.
The formula that follows returns the average of the values in the range A1:A100:

=AVERAGE(AL:A100)

If the range argument contains blanks or text, Excel doesn’t include these cells in
the average calculation. As with the SUM formula, you can supply any number of
arguments.

Excel also provides the MEDIAN function (which returns the middle-most value in
a range) and the MODE function (which returns the value that appears most fre-
quently in a range).

COUNTIF

The COUNTIF function is useful if you want to count the number of times that a
specific value occurs in a range. This function takes two arguments: the range that
contains the value to count and a criterion used to determine what to count. Figure
10-14 shows a worksheet set up with student grades. The COUNTIF function is used
in the formulas in column E. For example, the formula in E2 is as follows:

=COUNTIF(B:B,D2)

Notice that the first argument consists of a range reference for the entire column B,
enabling you to insert new names easily without having to change the formulas.
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Figure 10-14: Using the COUNTIF function to create
a distribution of grades.

: You also can use the Analysis ToolPak add-in to create frequency distributions. See
»% Chapter 28 for details.

COUNT, COUNTA, COUNTBLANK, and COUNTIF

The COUNT function returns the number of values in a range. The COUNTA function
returns the number of nonblank cells in a range. For example, the following formula
returns the number of nonempty cells in column A:

=COUNTA("A:A™)

COUNTBLANK counts the number of blank cells in a range, and COUNTIF counts
the number of cells within a range that meet the criteria that you specify in the
argument.

MAX and MIN

Use the MAX function to return the largest value in a range, and the MIN function
to return the smallest value in a range. Both MAX and MIN ignore logical values
and text. The following formula displays the largest and smallest values in a range
named Data; using the concatenation operator causes the result to appearin a
single cell:

="Smallest: "&MIN(Data)&" Largest: "&MAX{(Data)

For example, if the values in Data range from 12 to 156, this formula returns
Smallest: 12 Largest: 156.
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MAXA and MINA are new to Excel 2000. These functions work like MAX and MIN,
respectively, but MAXA and MINA don't ignore logical values and text.

LARGE and SMALL

The LARGE function returns the nth-largest value in a range. For example, to display
the second-largest value in a range named Data, use the following formula:

=LARGE{(Data,2)

The SMALL function works just as you would expect; it returns the nth-smallest
valuie in a range.

Database Functions

Excel’s Database function category consists of a dozen functions that you use
when working with database tables (also known as lists) stored in a worksheet.
These functions all begin with the letter I, and they all have non-database equiva-
lents. For example, the DSUM function is a special version of the SUM function
that returns the sum of values in a database that meet a specified criterion. A
database table is a rectangular range with field names in the top row. Each subse-
quent row is considered a record in the database.

To use a database function, you must specify a special criteria range in the
worksheet. This type of criteria range is the same one that you use with Excel’s
Data+ Filter+ Advanced Filter command.

This topic is discussed in Chapter 23.

The DSUM function calculates the sum of the values in a specified field, filtered
by the criteria table. For example, to calculate the total sales for the North region,
enter North under the Region field in the criteria range. Then, enter the following
formula into any cell (this assumes that the database table is named Data and that
the criteria range is named Criteria):

=0SUM(Data,"Sales",Criteria)
The formula retums the sum of the Sales lield, but only for the records that meet
the criteria in the range named Criteria. You can change the criteria, and the
formula displays the new result. For example, to calculate the sales for January,

enter Jan under the Month field in the Criteria range (and delete any other entries).

If yvou want to use several DSUM formulas, vou can have each of them refer to a
different criteria range (you can use as many criteria ranges as you need).

Excel’s other database functions work exactly like the DSUM function.
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Analysis ToolPak Functions

When you begin to feel familiar with Excel’s worksheet functions, you can explore
those that are available when you load the Analysis ToolPak. This add-in provides
you with dozens of additional worksheet functions.

When you load this add-in, the Paste Function dialog box displays a new category,

Engineering. It also adds new functions to the following function categories:

Financial, Date & Time, Math & Trig, and Information.

the Analysis ToolPak function.

Creating Megaformulas

The Analysis ToolPak is discussed in Chapter 28. See Appendix B for a summary of

Often, spreadsheets require intermediate formulas to produce a desired result. After you
get the formulas working correctly, you often can eliminate the intermediate formulas
and use a single megaformula instead (this term is my own—no official name exists for
such a formula). The advantages? You use fewer cells (less clutter) and recalculation
takes less time. Besides, people in the know will be impressed with your formula-building

abilities. The disadvantage? The [ormula may be impossible to decipher or modify.

Imagine a worksheet with a column of people’s names. And suppose that you've
been asked to remove all middle names and middle initials from the names — but
not all of the names have a middle name or initial. Editing the cells manually would

take hours, so you opt for a formula-based solution. Although this task is not a

difficult one, it normally involves several intermediate formulas. Also assume that
you want to use as few cells as possible in the solution.

Figure 10-15 shows the solution, which requires six intermediate formulas. The

names are in column A; the end result is in column H. Columns B through G hold
the intermediate formulas. Table 10-7 shows the formulas used in this worksheet,

along with a brief description of each.

megaformula. xls

Eoh T TEob Smit

S

th

Piks A, Jones Mike A Janes

Jones

Mike Jonas

Ray Johnson  1Jirn Hay Jahnson

Johnsan

Jirn Johnsan

Tom Alvin Jacohs

Jacobs

Tom Jscobs

hdr. Fred Kingsley  [Mr. Fred Kingsley

P. Smithers | J.F. Smithars

_Kingsley

Srithers

Mr. Kingsley
J.P. Smither

intermediate formulas.
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Cell Intermediate Formula What it Does

Locates first space

E1 =IF(ISERROR(D1),C1,D1)

Uses the first space if no second space

G1 =RIGHT(B1,LEN(B1)-E1) Extracts the last name

You can eliminate all the intermediate formulas by creating a huge formula (what [
call a megaformula). You do so by starting with the end result and then replacing
each cell reference with a copy of the formula in the cell referred to (but don’t copy
the equal sign). Fortunately, you can use the Clipboard to copy and paste. Keep
repeating this process until cell H1 contains nothing but references to cell Al. You
end up with the following megaformula in one cell:

=LEFT{TRIMCAL) ,FINDC" ", TRIMCAL) , 1) )&QRIGHTCTRIMCAL ), LENCTRIM(AL)
J-IFCLSERRORCFINDC™ ", TRIMCAL),FINDC™ ", TRIMCAL),1)+1)),FINDC"
"LUTRIMCALY 1) FINDC™ " TRIMCAL) ,FINDC™ ", TRIMCAL),1)+1)))

When you're satisfied that the megaformula is working, you can delete the columns
that hold the intermediate formulas, because they are no longer used.

The megaformula performs exactly the same task as all the intermediate formulas —
although it's virtually impossible for anyone (even the original author) to figure out.
If you decide to use megalormulas, make sure that the intermediate formulas are
petforming correctly before you start building a megaformula. Even better, keep a
copy of the intermediate formulas somewhere, in case you discover an error or need
to make a change.

Your only limitation is that Excel’s formulas can be no more than 1,024 characters.
Because a megaformula is so complex, you may think that using one would slow
down recalculation. Actually, the opposite is true. As a test, | created a worksheet
that used a megaformula 20,000 times. Then, I created another worksheet that used
six intermediate formulas rather than the megaformula. As you can see in Table
10-8, the megaformula recalculated faster and also resulted in a much smaller file.

This workbook is available on the CD-ROM.
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Method Recalc Time (seconds) File Size

Megaformula 5.1 2.5MB

Creating Custom Functions

Although Excel offers more functions than you'll ever need, you may eventually
search for a function that you need and not be able to find it. The solution is to
create your own.

If vou don’t have the skills to create your own functions, you may be able to pur-
chase custom Excel functions from a third-party provider that specializes in your
industry. Or, you can hire a consultant to develop functions that meet your needs.

To create a custom function, you must be wellversed in Visual Basic for Applications
(VBA). When you create a custom function, you can use it in your worksheet, just like
the built-in functions.

Custom worksheet functions are covered in Chapter 36.

Learning More About Functions

This chapter has just barely skimmed the surface, Excel has hundreds of functions
that [ haven’t mentioned. To learn more about the functions available to you, |
suggest that you browse through them by using the Paste Function dialog box and
click the Help button when you see something that looks useful. The functions are
thoroughly described in Excel’s online Help system.

Summary

This chapter discusses the built-in worksheet functions available in Excel. These

functions are arranged by category, and you can enter them into your formulas either
manually (by typing them) or by using the Paste Function dialog box and the Formula
Palette. Many examples of functions across the various categories are also discussed.

& SNGERINIEE  KNSSSAIRNERS
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Worksheet
Formatting

‘ hapter 6 discussed number formatting, which enables

you to change the way that Excel displays values in their
cells. This chapter covers what | refer to as stylistic formatting,
which is purely cosmetic.

Overview of Stylistic Formatting

The stylistic formatting that you apply to worksheet cells
doesn’t affect the actual content of the cells. Rather, you
should use stylistic formatting with the goal of making your
work easier to read or more attractive. In this chapter, you'll
learn about the following types of formatting:

» Using different type fonts, sizes, and attributes

« Changing the way the contents of cells are aligned
within cells

« Using colors in the background or foreground of cells
» Using patterns for cell background

« Using borders around cells

« Using a graphic background for your worksheet

This book’s CD-ROM contains a file that demonstrates many
of the techniques used in this chapter.

Why Bother Formatting?

Some users tend to shy away from formatting. After all, it
doesn’t do anything to make the worksheet more accurate,
and formatting just takes valuable time.

I'll be the first to admit that stylistic formatting isn’t essential
for every workbook that you develop. If no one except you will
ever see vour workbook, you may nat want to bother. If
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anyone else will use your workbook, however, [ strongly suggest that you spend
some time applying simple formatting. Figure 11-1 shows how even simple
formatting can significantly improve a worksheet’s readability.

J Betore and After xds1

Smith-Jackson Associates
Income and Expenses
Manth Revenue Expenses Net lncame |
Jan-37 31258 18Iz 18424 J
Feb-37 35344 Before and After.xls:2
Mar-87 29833
Apr-g7 39532
tay-97 31443
Jun-97 23444
Julkg7 25445

Augd7 55984 FrA e
Sep-37 43012 31 256 19 424
Oct87 31338 35 944 23622
Now37 39083 29,833 8,850
Dec-97 31444 39,832 24,389 ’I
433059 1 443 125101 U
26 444 19522 | i
25 445 15,323 ‘
655954 44951 | e
43012 6221 |
31,339 18,769 [
39,083 25862 |
31,444 17.009 | (L
§ 433050 § 160,166 § 272893

Figure 11-1: Before and after apymg simple hsti formtting.

On the other hand, some users go overboard with formatting. I've downloaded
many Excel worksheets from the Internet and online services, such as CompuServe.
Some of these worksheets are hideous and don’t convey a professional image. You
disguise your work and make it difficult to read and understand if you use too many
different fonts, font sizes, colors, and borders.

Eventually, you'll strike a happy medium with your stylistic formatting: not too
much, but enough to clarify what you're trying to accomplish with your waorksheet.

When to Format

When you're developing a warksheet, you can apply stylistic formatting at any time.
Some people prefer to format their work as they go along (I'm in this group). Others
wait until the workbook is set up and then apply the formatting as the linal step
(the icing on the cake). The choice is yours.
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The Formatting Toolbar

Chapter 6 introduced the Formatting toolbar, shown in Figure 11-2, which you use
to apply simple stylistic formatting quickly.

Figure 11-2: The Formatting toolbar contains
many tools to apply formats.

In many cases, this toolbar may contain all the formatting tools that you need. But
some types of formatting require that yvou use the Format Cells dialog box. This
chapter covers the finer points of stylistic formatting, including options not
available on the Formatting toolbar.

The Format Cells Dialog Box

This chapter refers repeatedly to the Format Cells dialog box. This is a tabbed
dialog box from which you can apply nearly any type of stylistic formatting (as well
as number formatting). The formats that you choose in the Format Cells dialog box
apply to the cells that you have selected at the time.

After selecting the cell or range to format, you can display the Format Cells dialog
box by using any of the following methods:

» Choose the Format+ Cells command
« Press Ctrl+1
» Right-click the selected cell or range and choose Format Cells from the

shortcut menu

The Format Cells dialog box contains six tabs. When you first open this dialog box,
you see the Number tab. You can choose another tab by clicking any of the other
tabs. When you open this dialog box again, Excel displays the tab that you used last.

Working with Fonts

Fonts are one of the elements that distinguish a graphical user interface (GUL), such
as Windows, from a character-hased interface (such as plain-old DOS). A GUI can
display different fonts in different sizes and with different attributes (bold, italic,
underline). A character-based display typically shows one font of the same size and
may be capable of handling different font attributes.
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You can use different fonts, sizes, or attributes in your worksheets to make vatious
parts stand out, such as the headers for a table. You also can adjust the font size to
make more information appear an a single page.

Reducing the font size so that your report fits on a certain number of pages isn’t
always necessary.

Excel has a handy option that automatically scales your printed output to fit on a
specified number of pages, which is discussed in Chapter 12.

About Fonts

When you select a font, Excel displays only the fonts that are installed on your
system. Windows includes several fonts, and Microsoft Office 2000 includes many
additional fonts that you can install on your system. You can acquire fonts from a
variety of other sources, too, such as the Internet and omnline services. For best
results, you should use TrueType fonts. You can display and print these fonts in any
size, without the “jaggies” (jagged edges) that characterize nonscalable fonts.

Although you can obtain fonts from many different locations, remember that fonts
take up space on your hard drive and use memory. In addition, using too many
fonts in a workbook can confuse the reader. You may not ever need any fonts
other than those that come with Windows.

If you plan to distribute a workbook to other users, you should stick with the fonts
that are included with Windows. If you open a workbook and your system doesn’t
have the font with which the workbook was created, Windows attempts to use a
similar font. Sometimes this works, and sometimes it doesn’t. To be on the safe
side, use the following fonts only if you plan to share your workbook with others:

« Arial

« Courier New

» Symbol

» Times New Roman

+ Wingdings

The Default Font

By default, the information that you enter into an Excel worksheet uses the 10-point
Arial font. A font is described by its typeface (Arial, Times New Roman, Courier
New, and so on) as well as by its size, measured in points (there are 72 points in one
inch). Excel’s row height, by default, is 12.75 points. Therefore, 10-point type
entered into 12.75-point rows leaves a small amount of blank space between the
characters in adjacent rows.
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if you have not manually changed a row's height, Excel automatically adjusts the
row height based on the tallest text that you enter into the row. You can, of course,
override this adjustment and change the row height to any size that you like by
using 0.25-point increments. For example, if you enter a row height of 15.35, Excel
makes the row 15.5 points high (it always rounds up).

The default font is the font specified by the Normal style for the workbook. All cells
use the Normal style unless you specifically apply a different style. If you want to
change the font for all cells that use the Normal style, you simply change the font
used in the Normal style by using these steps:

1. Choose the Format« Style command. Excels displays the Style dialog box.

2. Make sure that Normal appears in the Style name drop-down box and click the
Modify button. Excel displays the Format Cells dialog box.

3. Click the Font tab and choose the font and size that you want as the default.
4. Click OK to return to the Style dialog box.
5. Click OK again to close the Style dialog box.

The font for all cells that use the Normal style changes to the font that you

specified. You can change the font for the Normal style at any time. Excel’s style
feature is discussed later in this chapter.

if you want to change the default font permanently, create a template named
booluxlt that uses a different font for the Normal style. Templates are covered in
Chapter 34.

Changing Fonts in Excel 2000

Use the Font and Font Size tools on the Formatting toolbar to change the font or
size for selected cells. Just select the cells, click the appropriate tool, and then
choose the font or size from the drop-down list. In Excel 2000, you can see samples
of the fonts when you open the Font list box on the Formatting toolbar (see Figure
11-3). If you prefer the behavior of earlier versions of Excel, in which you don’t see
font samples when you open this list box, you can change this behavior in the
Options dialog box.

You also can use the Font tab in the Format Cells dialog box, as shown in Figure 114,
This tab enables you to control several other attributes of the font —from a single
dialog box— and preview the font before vou select it. Notice that you also can
change the font style (bold, italic), underlining, color, and effects (strikethrough,
superscript, or subscript). If you click the check box labeled Normal Font, Excel
displays the selections for the font defined for the Normal style.
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Figure 11-3: The Font list on
the Formatting toolbar shows
samples as well as choices.

Notice in Figure 11-5 that Excel provides four different underlining styles. In the
two accounting underline styles, dollar signs and percent signs aren’t underlined.
In the two nonaccounting underline styles, the entire cell contents are always
underlined.

Al il

Figure 11-4: The Font tab in the Format Cells
dialog box.

Figure 11-5 shows examples of font formatting.
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Figure 11-5: Examples of font formatting.

Using Multiple Formatting in One Cell

If a cell contains text (not a formula or a value), Excel also enables you to format
individual characters in the cell. To do so, switch into edit mode (double-click the
cell) and then select the characters that you want to format. You can select
characters either by dragging the mouse over them or by holding down the Shift
key as you press the left- or right-arrow key. Then, use any of the standard
formatting techniques. The changes apply to only the selected characters in the
cell. This technique doesn’t work with cells that contain values or formulas.

Figure 11-6 shows a few examples of using different fonts, sizes, and attributes in
a cell.
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Changing Cell Alignment

Cell alignment refers to how a cell’s contents are situated in the cell. The contents
of a cell can be aligned both vertically and horizontally. The effect that you see
depends on the cell’s height and width. For example, if the row uses standard
height, you may not notice any changes in the cell’s vertical alignment (but if you
increase the row’s height, these effects are apparent).

Excel also enables you to display text at a specified orientation —you choose
the angle.

Figure 11-7 shows some examples of cells formatted with the various horizontal and
vertical alignment options.

Horizontal Alignment Options

You can apply most of the horizontal alignment options by using the tools on the
Formatting toolbar. Or, you can use the Alignment tab in the Format Cells dialog
box, as shown in Figure 11-8.

The horizontal alignment options are as follows:

» General: Aligns numbers to the right, aligns text to the left, and centers
logical and error values. This option is the default alignment.

CiM Ex. 1052 Page 81



« Left: Aligns the cell contents to the left side of the cell. If the text is wider than
the cell, it spills over to the cell to the right. If the cell to the right is not
empty, the text is truncated and not completely visible.

* Center: Centers the cell contents in the cell. If the text is wider than the cell, it
spills over to cells on either side, if they are empty. If the adjacent cells aren’t
empty, the text is truncated and not completely visible.

» Right: Aligns the cell contents to the right side of the cell. If the text is wider
than the cell, it spills over to the cell to the left. If the cell to the left isn’t
empty, the text is truncated and not completely visible.

» Fill: Repeats the contents of the cell until the cell’s width is filled. If cells to
the right also are formatted with Fill alignment, they also are filled.

» Justify: Justifies the text to the left and right of the cell. This option is
applicable only if the cell is formatted as wrapped text and uses more than
one line.

» Center across selection: Centers the text over the selected columns. This
option is useful for precisely centering a heading over a number of columns.

Centamac
hatizantally and
vettically with word
wrap

Vertical text

Mine cells merged into one

Ten cells merged intn one

Figure 11-7: Examples of Excel’s alignment options.
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Figure 11-8: The Alignment panel in the Format
Cells dialog box.

Vertical Alignment Options

To change the vertical alignment, yvou must use the Alignment tab of the Format
Cells dialog box (these options are not available on the Formatting toolbar). The
vertical alignment options are as follows:

L]

Top: Aligns the cell contents to the top of the cell
Center: Centers the cell contents vertically in the cell
Bottom: Aligns the cell contents to the bottom of the cell

Justify: Justifies the text vertically in the cell; this option is applicable only if
the cell is formatted as wrapped text and uses more than one line

Text Control Options

The Alignment tab of the Format Cells dialog hox offers three additional options,
which are discussed in the following sections.

Wrap Text

The Wrap text option displays the text on multiple lines in the cell, if necessary.
Use this option to display lengthy headings without having to make the columns
too wide.
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Shrink to Fit

Excel includes a Shrink to fit option, which reduces the size of the text so that it fits
into the cell without spilling over to the next cell.

If you apply wrap text formatting to a cell, you can't use the shrink-to-fit formatting.

Merging Cells

When you merge cells, you don’t combine the contents of cells. Rather, you
combine a group of cells that occupy the same space into a single cell. Figure 11-9
shows two sets of merged cells. Range C3:G3 has been merged into a single cell that
holds the table’s title. Range B5:B9 has also been merged to hold a title for the
table’s rows.

Figure 11-9: The titles for this table appear in merged cells.

You can merge any number of cells, occupying any number of rows and columns.
However, the range that you intend to merge should be empty, except for the upper-
left cell. If any of the other cells that you intend to merge are not empty, Excel
displays a warning.

To merge cells, select the cells that you want to merge and then click the Merge and
Center tool on the Formatting toolbar. The only way to “unmerge” cells is to use the
Format Cells dialog box. Select the merged cell(s), open the Format Cells dialog
box, and, on the Alignment tab, remove the check from the Merge cells box.

Changing a Cell’s Orientation

You can display text horizontally, vertically, or specify an angle. To change the
orientation, select the cell or range, open the Format Cells dialog box, and select
the Alignment tab. Use the gauge to specify an angle between —90 and +90 degrees.
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Region }
Narth 452 | 585 434 1451
South 873 892 923 2688
West 10009 1287 1083 3479
_iEast

Orientation JETHEEE]

Figure 11-10: An example of rotated text.

Colors and Shading

Excel provides the tools to create some very colorful worksheets. I've known
peaple who avoid using color because they are uncertain of how the colors will
translate when printed on a black-and-white printer. With Excel, that’s not a valid
concern. You can instruct Excel to ignore the colors when you print. Choose

File* Page Setup to display the Page Setup dialog box. Click the Sheet tab and place
a check in the Black and White check box.

You control the color of the cell’s text in the Font tab of the Format Cells dialog box,
and yvou control the cell’s background color in the Patterns tab. You can also use
tools on the Formatting toolbar (Font Color and Fill Color) to change the color of
these items.

A cell’s background can be solid (one color) or consist of a pattern that uses two
colors. To select a pattern, click the Pattern drop-<down list in the Format Cells
dialog box. It expands as shown in Figure 11-11. Choose a pattern from the top part
of the box and a second color from the battom part. The first pattern in the list is
“None” —use this option if you want a solid background. The Sample box to the
right shows how the colors and pattern will look. i you plan to print the worksheet,
you need to experiment to see how the color patterns translate to your printer.
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Figure 11-11: Choosing a pattern for a cell
background.

You might want to use a background color to make a large table of data easier to
read. You probably are familiar with computer printer paper that has alternating
green-and-white horizontal shading (often referred to as “green bar™). You can use
background colors to simulate this effect in Excel. See Figure 11-12 for an example.

Here's a quick way to apply shading to every other row. This technique assumes
that you want to shade every odd-numbered row in the range A1:F100. Start by
shading A1:F1 with the color that you want. Then, select A1:F2 (row 1 is shaded
and row 2 is not) and copy the range to the Clipboard. Next, select A3:F100 and
choose Edit+ Paste Special (with the Formats option).

To hide quickly the contents of a cell, make the background color the same as the
font text color. The cell contents are still visible in the formula bar when you select

the cell, however.
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Figure 11-12: Shading alternate lines can make a lengthy table easier
to read.

Borders and Lines

Borders often are used to group a range of similar cells or simply to delineate rows
or columns. Excel offers 13 different styles of borders, as vou can see on the Border
tab in the Format Cells dialog box (see Figure 11-13). This dialog box works with the
selected cell or range and enables you to specify which border style to use for each
border of the selection.

Before you open this dialog box, select the cell or range to which you want to add
borders. First, choose a line style and then choose the border position for the line
style by clicking one of the icons.

Notice that the Border tab has three “presets,” which can save you some clicking. If
you want to remaove all borders from the selection, click None. To put an outline
around the selection, choose Outline preset. To put borders inside the selection,
click Inside preset.

Excel displays the selected border style in the dialog box. You can choose different
styles for different border positions and choose a color for the border. Using this
dialog box may require some trial and error, but yvou'll get the hang of it. Figure
11-14 shows examples of borders in a worksheet.
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Figure 11-13: The Border tab of the Format

Cells dialog box.
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Figure 11-14: Examples of using borders in a worksheet.

When you apply diagonal lines to a cell or range, the selection locoks like it has been
crossed out.

if you use border formatting in your worksheet, you might want to turn off the grid
display, to make the borders more pronounced. Use the View tab of the Options
dialog box to do this.

CiM Ex. 1052 Page 89



CiM Ex. 1052 Page 90



Adding a Worksheet Background

Excel also enables you to choose a graphics file to serve as a background for a
worksheet —similar to the wallpaper that you may display on vour Windows
desktop. The image that you choose is repeated, so that it tiles the entire
worksheet.

Thousands of background graphics files are available on the World Wide Web.
Many Web sites use graphics files for backgrounds, and these files are designed to
tile nicely. In addition, these files are usually very small. If you encounter a Web
site that uses a good graphic as a background, you can save the file to your hard
drive and use it in your Excel workbooks.
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To add a background to a worksheet, choose FormatSheet+ Background. Excel
displays a dialog box that enables yau to choose a graphics file. When vou locate a
file, click OK. Excel tiles your worksheet with the graphic. Some backgrounds make
viewing text difficult, so you may want to use a solid background color for cells that
contain text (see Figure 11-15). You'll also want to turn off the gridline display,
because the gridlines show through the graphic.

The graphic background on a worksheet is for display only—it isn't printed when
you print the worksheet.

e d‘ )
First Quarter Saies
January... ........cceeeee.. 395,093
February......c..cuw....  $87,321
March...c..covecvenvvcnene. $104,983

1 ckgroun il | : » il i | | ‘
Figure 11-15: This worksheet has a graphic background, but cells that
contain text use a white background, which overrides the graphic.

AutoFormatting

So far, this chapter has described the individual formatting commands and tools at
your disposal. Excel also has an AutoFormatting feature that can automatically
perform many types of formatting for you. Figure 11-16 shows an unformatted table
in a worksheet (left side) and the same table formatted using one of Excel’s
AutoFormats.

You also can apply AutoFormatting to PivotTables; see Chapter 25.
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i Month Revenue

Jan-g7 31256
Fah-g7 35944
Mar-g? 29833
Aprgy 39832
May-37 31443
Jur-97 28444
Julg7 26445
AugS7 £5384
Sep97 43012
Oct-a7 31339
MNov-37 39083
! Dec-97 31444
L Annusl 433059

Mo ks Revanus Expenges  Net Inceme
Jan97 § 3126600 ¢ 1183200 § 1842400
Feb-97 35.944.00 12,322.00 2352200
Wiar-97 297833.00 10,983.00 18,850 00
Apr-97 39,832.00 15,433.00 24 399.00

May-97 3144300 18,933.00 12,510.00
Jun87 7844400 8,522.00 19,522.00
Julg7 2544500 9,122.00 16,323.00
Aug-97  B5,984.00 21,033.00 44 951.00
Sep-97 4301200 11,390.00 31,522 00
Oct-97  31,329.00 12 540.00 18,799 00
Now97 3908300 13,221.00 25,362.00
Dec-97 3144400 14,435.00 17.,000.00

Anpusf  $433059.00 F160,166.00 §272,393.00

eted] ]
Figure 11-16: A worksheet table before and after using AutoFormat.

Using AutoFormats

To apply an AutoFormat, move the cell pointer anywhere within a table that you
want to format; Excel determines the table’s boundaries automatically. Then,
choose Formats AutoFormat. Excel responds with the dialog box shown in Figure
11-17. Choose one of the 17 AutoFormats from the list and click OK. Excel formats
the table for you.
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Figure 11-17: The AutoFormat dialog box.

Excel applies AutoFormatting rather intelligently. For example, Excel analyzes the
data contained in the table and then formats the table to handle items such as
subtotals. Figure 11-18 shows an example of a table that contains a subtotal line for
each department. When [ applied an AutoFormat, Excel took these subtotals into
account and produced an attractive table in about one second.

AL T : 3 ‘ g TR 43 B
e BlRlais sl e
Midwest Tatal S20 813 00
Grand Total 4,182 336 30

H

¥ mrawtn i
Figure 11-18: AutoFormatting even accommodates
subtotals in a table.
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Controlling AutoFormats

Although you can’t define your own AutoFormats, you can control the type of
formatting that is applied. When you click the Options button in the AutoFormat
dialog box, the dialog box expands to show six options (see Figure 11-19).

Figure 11-19: The AutoFormat dialog box, expanded to
show its options.

[nitially, the six check boxes are all checked —which means that Excel will apply
formatting from all six categories. If you want it to skip one or more categories, just
remove the check from the appropriate box before you click OK. For example, when
[ use AutoFormats, | hardly ever want Excel to change the column widths, so [ turn
off the Width/Height option. lf you've already formatted the numbers, you may warnt
to turn off the Number option.

Using Conditional Formatting

Excel’s conditional formatting feature changes cell formats based on the contents of
the cell. For example, if the cell contains a negative number, the cell appears bold
with a red background. To apply conditional formatting to a cell or range, select the
range and then choose Format+ Conditional Formatting. You’'ll see the dialog box
shown in Figure 11-20, which enables you to specify up to three conditions for the
selected cells.
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Conditional Formatting
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Figure 11-20: Excel enables you to specify formats based on the
cell’s value.

The condition can be based on either the cell’s value or a formula that yvou specify
(the formula must be a logical formula and return either True or False). Follow
these steps to apply conditional formatting:

1. In the first drop-down list, choose either Cell Value [s or Formula [s.

2, If you chose Cell Value Is in Step 1, specify the conditions by using the
contrals in the dialog box. For example, you can specify between 0 and 100.
You can enter values or cell references.

3. If you chose Formula Is in Step 1, specify a reference to the formula.
Remember, the formula must return either True or False.

4. Click the Format button and specify the formatting that will be used when the
condition is true.

5. If you want to specify another conditional format for the selection, click the
Add button. The dialog box expands so that vou can repeat Steps 1 through 4
for another condition.

6. When you finish, click OK.

Conditional formatting is a great feature, but it's not foolproof. If you copy a value
and paste it into a cell that has conditional formatting, the formatting will not be
applied. In fact, copying a value to a cell that has conditional formatting wipes out
the conditional formatting information. In other words, the feature works only for
data that is entered into a cell manually or calculated by a formula.

Using Named Styles

The named style feature — borrowed from word processing —is, perhaps, one of the
most underutilized features in Excel (named styles may also be the most
underutilized feature in word processors).

If you find that you continually are applying the same combination of fonts, lines,
and shading in your worksheets, you can save time and effort if vou create and use
named styles. Named styles apply, in a single step, the formats that you specify,
helping you to apply consistent formats across your worksheets.
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The real power of styles lies in what happens when you change a component of a
style; in this case, all the cells that use that named style automatically incorporate
the change. Suppose that you apply a particular style to a dozen cells scattered
throughout vour worksheet. Later, you realize that these cells should have a font
size of 14 points rather than 12 points. Rather than change each cell, simply edit the
style. All cells with that particular style change automatically.

A style can consist of settings for six different attributes, although a style doesn’t
have to use all the attributes. You may recognize these attributes; they correspond
to the six tabs in the Format Cells dialog box. The attributes that make up a style
are the following:

» Number format

» Font (type, size, and color)

+ Alignment (vertical and horizontal)

» Borders

» Pattern

* Protection (locked and hidden)

By default, all cells have the Normal style. In addition, Excel provides five other
built-in styles — all of which control only the cell’s number format. The styles that
are available in every workbook are listed in Table 11-1. If these styles don’t meet
your needs (and they probably don’t), you can easily create new styles.

Style Name Description Nimber Format Example

Comma* Comma with two 1,234.00
decimal places

Currency* Left-aligned dollar sign $1,234.00
with two decimal places

Percent* Percent with no decimal places 12%

*This style can be applied by clicking a button the Standard toolbar.
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Applying Styles

This section discusses the methods that you can use to apply existing styles to
cells or ranges.

Toolbar Buttons

As mentioned in the preceding section, you can use three buttons on the Standard
toolbar to attach a particular style to a cell or range. You need to understand that
when you use these buttons to format a value, you're really changing the cell’s
style. Consequently, if vou later want to change the Normal style, cells formatted
with any of these buttons won’t be affected by the change.

Using the Style Tool

If you plan to work with named styles, vou might want to make an addition to one of
your toolbars. In fact, [ strongly suggest that you do so. Excel has a handy Style tool
available. However, this tool (oddly) is not on any of the built-in toolbars — maybe
this is why the named style feature is underutilized. To add the Style tool to a
toolbar (the Formatting toolbar is a good choice), follow these steps:

1. Right-click any toolbar and choose Customize from the shortcut menu. Excel
displays its Customize dialog box.

2. Click the Commands tab.

3. In the Categories list box, click Formatting. The Buttons box displays all
available tools in the Formatting category.

4. Click the Style tool (it’s a list box labeled Style) and drag it to your Formatting
toolbar. If yvou drag the Style tool to the middle of the toolbar, the other tools
scoot over to make room for it.

5. Click the Close button in the Customize dialog box.

The new Style tool displays the style of the selected cell and also lets you quickly

apply a style— or even create a new style. To apply a style by using the Style tool,
select the cell or range, open the Style list box, and then choose the style that you
want to apply.

Using the Format« Style Command

You also can apply a style by using the Format+ Style command, which prompts
Excel to display its Style dialog box. Just choose the style that you want to apply
from the Style Name drop-down list. However, using the Style tool, as described in
the previous section, is a much quicker way to apply a style.

The CD-ROM for this book contains a workbook that defines several styles. You may
want to open this workbook and experiment.
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Creating New Styles

Two ways are available to create a new style: use the Format+ Style command
or use the Style tool. To create a new style, first select a cell and apply all the
formatting that you want to include in the new style. You can use any of the
formatting that is available in the Format Cells dialog box.

After you format the cell to your liking, choose Format+ Style. Excel displays its
Style dialog box, shown in Figure 11-21. Excel displays the name of the current
style of the cell (probably Normal) in the Style Name drop-down. This box is
highlighted, so that you can simply enter a new style name by typing it. When you
do so, Excel displays the words By Example to indicate that it’s basing the style on
the current cell.

The check hoxes display the current formats for the cell. By default, all check boxes
are checked. If you don’t want the style to include one or more format categories,
remove the check(s) from the appropriate box(es). Click OK to create the style.

You also can create a style from scratch in the Style dialog box. Just enter a style
name and then click the Modify button to select the formatting.

e HEHIES
Figure 11-21: You can create a new style by
using the Style dialog box.

if you added the Style tool to one of your toolbars, you can create a new style
without using the Style dialog box. Just format a cell, click inside the Style tool list
box, and then type the name. Using this methad, you can't specify which format-
ting categories to omit from the style, but, as you learn next, you can easily modify
an existing style.

Overriding a Style

After you apply a style to a cell, you can apply additional formatting to it by using
any formatting method discussed in this chapter. Formatting modifications that you
make to the cell don't affect other cells that use the same style.
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Modifying a Style

To change an existing file, open the Style dialog box. From the Style name drop-down
box, choose the style that you want to modify. You can make changes to the check
boxes to include or exclude any of the format categories, or you can click the Modify
button to display the familiar Format Cells dialog box. Make the changes that yvou
want and click OK. Click OK again to close the Style dialog box. Excel modifies all the
cells formatted with the selected style by applying the new formatting.

You also can use the Style tool to change a style. Start by modifying the formatting
of a cell that uses the style. Then, dick inside the Style tool list box, select the style
name, and press Enter. Excel asks whether you want to redefine the style based on
the selection. Respond in the affirmative to change the style —and all of the cells
that use the style.

Deleting a Style

[f vou no longer need a styvle, you can delete it. To do so, open the Style dialog box,
choose the style from the list, and then click Delete. All the cells that had the style
revert back to the Normal style.

Suppose that you applied a style to a cell and then applied additional formatting. If
you delete the style, the cell retains all of its additional formatting.

Merging Styles from Other Workbooks

You may create one or more styles that you use frequently. Although you could
go through the motions and create these styles for every new warkbaok, a better
approach is to merge the styles from a workbook in which you previously
created them.

To merge styles from another workbook, open both the workbook that contains
the styles that you want to merge and the workbook into which you want to merge
styles. From the workbook info which you want to merge styles, choose

Format+ Style and click the Merge button. Excel displays a list of all open
workbooks, as shown in Figure 11-22. Select the workbook that contains the styles
you want to merge and click OK. Excel copies styles from the workbook that vou
selected into the active workbook.

When you’re merging styles, colors are based on the palette stored with the
workbook in which you use the style. Therefore, if the two workbooks involved in
the merge use different color palettes, the colors used in the styles may not look
the same in each workbook.
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Figure 11-22: Merging styles from another
workbook is a good way to make your
workbooks look consistent.

Controlling Styles with Templates

When you start Excel, it loads with several default settings, including the settings
for stylistic formatting. If you spend a lot of time changing the default elements, you
should know about templates.

Here's an example. You may prefer to use 12-point Arial rather than 10-point Arial as
the default font. And maybe you prefer Wrap Text to be the default setting for
alignment. Templates provide an easy way to change defaults.

The trick is to create a workbook with the Normal style modified to the way that
vou want it. Then, save the workbook as a template in your XLStart folder. After
doing so, you can select File+ New to display a dialog box from which you can
choose the template for the new workbook. Template files also can store other
named styles, providing vou with an excellent way to give vour workbooks a
consistent look.

Chapter 34 discusses templates in detail.

Summary

This chapter explores all topics related to stylistic formatting: different fonts and
sizes, alignment options, applving colors and shading, and using borders and lines.
It discusses Excel’s AutoFormat feature, which can format a table of data automati-
cally. The chapter concludes with a discussion of named styles, an important con-
cept that can save you time and make your worksheets look more consistent.

& SEREERNESEE  SESSSUIISES
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Printing Your
Work

Many of the worksheets that you develop with Excel
are designed to serve as printed reports. You'll find

that printing from Excel is quite easy, and vou can generate
attractive, well-formatted reports with minimal effort. But, as
you'll see, Excel has plenty of options that provide you with a
great deal of control over the printed page. These options are
explained in this chapter.

One-Step Printing

The Print button on the Standard toolbar is a quick way to
print the current worksheet, using the default settings. Just
click the button, and Excel sends the worksheet to the printer.
If vou've changed any of the default print settings, Excel uses
the new settings; otherwise, it uses the following default
settings:

« Prints the active worksheet (or all selected worksheets),
including any embedded charts or drawing objects

» Prints one copy

» Prints the entire worksheet

+ Prints in portrait mode

» Doesn’t scale the printed output

+ Uses l-inch margins for the top and bottom and .75-inch
margins for the left and right

+ Prints with no headers or footers

» For wide worksheets that span multiple pages, it prints
down and then across
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As you might suspect, you can change any of these default print settings.

When you print a worksheet, Excel prints only the active area of the worksheet. In
other words, it won't print all four million cells —just those that have data in them.
If the worksheet contains any embedded charts or drawing objects, they also are
printed (unless vou have modified the Print Object property of the object).

if you create a workbook based on a template, the template may contain different
default print settings. Templates are discussed in Chapter 34.

Adjusting Your Print Settings

You adjust Excel’s various print settings in two different dialog boxes:

» The Print dialog box (accessed either with the File+ Print command or
Ctrl+P).

» The Page Setup dialog box (accessed with the File + Page Setup command).
This is a tabbed dialog box with four tabs.

Both of these dialog boxes have a Print Preview button that previews the printed
output onscreen.

Settings in the Print Dialog Box

You actually start the printing process from the Print dialog box, unless you use the
Print button on the Standard toolbar. After vou select your print settings, click OK
from the Print dialog box to print your work.

Selecting a Printer

Before printing, make sure that you have selected the correct printer (applicable
only if you have access to more than one printer) by using the Print dialog box,
shown in Figure 12-1. You can select the printer from the Printer drop-down list.
This dialog box also lists information about the selected printet, such as its status
and where it’s connected.

Clicking the Properties button displays a property box for the selected printer. The
exact dialog box that you see depends on the printer. The Properties dialog box
lets you adjust printer-specific settings. In most cases, you won't have to change
any of these settings, but you should be familiar with the settings that you can
change.
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Figure 12-1: Select a printer in the Print dialog box.

If vou check the Print to file check box, Excel stores the output in a file, prompting
you for a filename before printing. The resulting file will not be a standard text file.
Rather, it will include all the printer codes that are required to print your
worksheet. Printing to a file is useful if you don’t have immediate access to a
printer. You can save the output to a file and then send this file to your printer at a
later time,

if you want to save your workbook as a text file, use the File« Save As command,
and select one of the text file formats from the drop-down list labeled Save as

type.

Before printing, vou might want to view your worksheets in Page Break Preview
mode. To enter this mode, choose the Viewe Page Break Preview command. The
worksheet display changes, and you can see exactly what will be printed and where
the page breaks occur. To change the print range, drag any of the dark borders.
This feature is discussed in more detail later in this chapter.

After you print a worksheet (or view it in Page Break Preview made), Excel displays
dashed lines to indicate where the page breaks occur. This is a useful feature,
because the display adjusts dynamically. For example, if you find that your printed
output is too wide to fit on a single page, you can adjust the column widths
(keeping an eye on the page-break display) until they are narrow enough to print on
one page.

if you don't want to see the page breaks displayed in your worksheet, open the
5%7":@ Options dialog box, click the View tab, and remove the check mark from the
% Automatic Page Breaks check box.
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Printing Selected Pages

If vour printed output uses multiple pages, you can select which pages to print, in
the Print dialog box. In the Page range section, indicate the number of the first and
last pages to print. You can either use the spinner controls or type the page
numbers in the edit boxes.

Specifying What to Print
The Print what section of the Print dialog box lets you specify what to print. You
have three options:

* Selection: Prints only the range that you selected before issuing the File«
Print command.

« Selected sheelt(s): Prints the active sheet or sheets that you selected. You
can select multiple sheets by pressing Ctrl and clicking the sheet tabs. If you
select multiple sheets, Excel begins printing each sheet on a new page.

« Entire workbook: Prints the entire workboaok, including chart sheets.
You can also select File« Print Area« Set Print Area to specify the range or ranges

to print. Before you choose this command, select the range or ranges that you
want to print. To clear the print area, select File+ Print Area« Clear Print Area.

Printing Multiple Copies

The Print dialog box also enables you to select the number of copies to print. The
upper limit is 32,767 copies —not that anyone would ever need that many. You also
can specify that you want the copies collated. If you choose this option, Excel
prints the pages in order for each set of output. lf you're printing only one page,
Excel ignores the Collate setting.

Settings in the Page Setup Dialog Box

Using the Page Setup dialog box, you can control page settings and margins, create
headers and footers, and adjust sheet settings. Choose File+ Page Setup to open
the Page Setup dialog box; in Figure 12-2, you see the Page tab of the Page Setup
dialog box.
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Figure 12-2: You control page settings in the Page tab
of the Page Setup dialog box.

Controlling Page Settings

The Page tab of the Page Setup dialog box enables you to control the following
settings:

» Orientation: Choose either Portrait (tall pages) or Landscape (wide pages).
Landscape orientation might be useful if you have a wide range that doesn’t fit
on a vertically oriented page.

» Scaling: You can set a scaling factor manually or let Excel scale the output
automatically to fit on the number of pages that you specify. Scaling can range
from 10 percent to 400 percent of normal size. If you want to return to normal
scaling, enter 100 in the box labeled % normal size.

» Paper size: This setting enables yvou to select the paper size that you're using.
Click the box and see the choices.

» Print quality: If the installed printer supports it, you can change the printer’s
resolution —which is expressed in dots per inch (dpi). Higher numbers
represent better print quality, but higher resolutions take longer to print.

» First page number: You can specify a page number for the first page. This is
useful if the pages that you’re printing will be part of a larger document and
you want the page numbering to be consecutive. Use Auto if you want the
beginning page number to be 1 —or to correspond to the pages that you
selected in the Print dialog box. If you're not printing page numbers in vour
header or footer, this setting is irrelevant.
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Adjusting Margins

A margin is the blank space on the side of the page. Wider margins leave less space
available for printing. You can control all four page margins from the Margins tab of
the Page Setup dialog box, shown in Figure 12-3.

To change a margin, click the appropriate spinner (or you can enter a value
directly).

Page Setup

Figure 12-3: The Margins tab of the Page Setup dialog box.

The Preview box in the center of the dialog box is a bit deceiving, because it doesn't
really show you how your changes look in relation to the page. Rather, it simply
displays a darker line to let you know which margin you're adjusting.

In addition to the page margins, you can adjust the distance of the header from the
top of the page and the distance of the footer from the bottom of the page. These
settings should be less than the corresponding margin; otherwise, the header or
footer may overlap with the printed output.

Normally, Excel aligns the printed page at the top and left margins. If you would
like the output to be centered vertically or horizontally, check the appropriate
check box.

You also can change the margins while you're previewing your output —ideal for

last-minute adjustments before printing. Previewing is explained later in the
chapter.
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Changing the Header or Footer

A header is a line of information that appears at the top of each printed page. A
footer is a line of information that appears at the bottom of each printed page. You
can align information in headers and footers at the left margin, in the center of the
header or footer, and at the right margin. For example, you can create a header that
prints your name at the left margin, the worksheet name centered in the header,
and the page number at the right margin. By default, new workbooks do not have
any headers or footers.

The Header/Footer tab of the Page Setup dialog box appears in Figure 12-4. This
dialog box displays the current header and footer and gives you other header and
footer options in the drop-down lists labeled Header and Footer.

e | LD T
Figure 12-4: The Header/Footer tab of the Page Setup
dialog box.

When you click the Header (or Footer) drop-down list, Excel displays a list of
predefined headers (or footers). lf vou see one that you like, select it. You then can
see how it looks in context — which part is left-justified, centered, or right-justified.
If you don’t want a header or footer, choose the option labeled (none) for both the
Header and Footer drop-down list baxes,

If vou don’t find a predefined header or footer that is exactly what you want, you
can define a custom header or footer. Start by selecting a header or footer that’s
similar to the one that you want to create (yvou’ll use the selected header or footer
as the basis for the customized one). Click the Custom Header or Custom Footer
button, and Excel displays a dialog box like the one shown in Figure 12-5.
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Figure 12-5: If none of the predefined headers or footers is satisfactory,
you can define a custom header or custom footer.

This dialog box enables vou to enter text or codes in each of the three sections. To
enter text, just click in the section and enter the text. To enter variable information,
such as the current date or the page number, vou can click one of the buttons.
Clicking the button inserts a special code. The buttons and their functions are
listed in Table 12-1.

Button Code Function

File &[File] Inserts the workbook name

You can combine text and codes and insert as many codes as you like into each
section. lf the text that you enter uses an ampersand (&), you must enter the
ampersand twice (because Excel uses an ampersand to signal a code). For example,
to enter the text Kesearch & Development into a section of a header or footer, enter
Resecarch && Development.

You also can use different fonts and sizes in vour headers and footers. Just select
the text that you want to change and then click the Font button. Excel displays its
Fonts dialog box so that you can make your choice. i you don’t change the font,
Excel uses the font defined for the Normal style.
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You can use as many lines as you like. Use Alt+Enter to force a line break for
multiline headers or footers.

After you define a custom header or footer, it appears at the bottom of the
appropriate drop-down list on the Header/Footer tab of the Page Setup dialog box.
You can have only one custom header and one custom footer in a workbook. So, if
you edit a custom header, for example, it replaces the existing custom header in the
drop-down list.

Unfortunately, yvou can’t print the contents of a specific cell in a header or footer.
For example, you might want Excel to use the contents of cell Al as part of a
header. To do so, you need to enter the cell's contents manually — or write a macro
to perform this operation.

Excel 2000 still doesn't implement one of the most requested features: the ability to
print a workbook’s full path and filename in a header or footer. You can print the file
name, but you find an option to print the path. The companion CD-ROM contains an
add-in that | developed that adds this feature to Excel.

Controlling Sheet Options

The Sheet tab of the Page Setup dialog box (shown in Figure 12-6) contains several
additional options. Each is described in the sections that follow.

Figure 12-6: The Sheet
tab of the Page Setup
dialog box.

Print area

The Print area box lists the range defined as the print area. If you select a range of
cells and choose the Selection option in the Print dialog box, the selected range
address appears in this box. Excel also defines this as the reference for the
Print_Area name,.
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If the Print area box is blank, Excel prints the entire worksheet. You can activate
this box and select a range (Excel will modify its definition of Print_Area), or you
can enter a previously defined range name into the box.

Print titles

Many worksheets are set up with titles in the first row and descriptive names in the
first colummn. If such a worksheet requires more than one page, reading subsequent
pages may be difficult, because the text in the first row and first column won't be
printed on subsequent pages. Excel offers a simple solution: print titles.

Don't confuse print titles with headers; these are two different concepts. Headers
appear at the top of each page and contain information such as the worksheet
name, date, or page number. Print titles describe the data being printed, such as
field names in a database table or list.

You can specify particular rows to repeat at the top of every printed page, or
particular columns to repeat at the left of every printed page. To do so, just activate
the appropriate box and select the rows ar coelumns in the warksheet. Or, you can
enter these references manually. For example, to specify rows 1 and 2 as repeating
rows, enter 1:2.

In the old days, users often were surprised to discover that print titles appeared
twice on the first page of their printouts. This occurred because they defined a
print area that included the print titles. Excel now handles this automatically,
however, and doesn’t print titles twice if they are part of the print area.

You can specify different print titles for each worksheet in the workbook. Excel
remembers print titles by creating sheet-level names (Print_Titles).

Print

The section labeled Print contains five check boxes:

« Gridlines: If checked, Excel prints the gridlines to delineate cells. If you turn
off the gridline display in the worksheet (in the View tab of the Options dialog
box), Excel automatically removes the check from this box for you. In other
words, the default setting for this option is determined by the gridline display
in your worksheet.

» Black and white: If checked, Excel ignores any colors in the worksheet and
prints everything in black and white. By taking advantage of this option, you
can format your worksheet for viewing on your monitor and still get readable
print output.

» Draft quality: If checked, Excel prints in draft mode. In draft mode, Excel
doesn’t print embedded charts or drawing objects, cell gridlines, or borders,
which reduces the printing time.

* Row and column headings: If checked, Excel prints the row and column
headings on the printout, enabling you to identify easily specific cells from a
printout.
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« Comments: [f checked, Excel prints cell notes by using the option that you
specify: either At the end of the sheet or As displayed on sheet.

Printer-Specific Options

The Print dialog box has a button labeled Options (refer to Figure 2-2). Clicking this
button displays another dialog box that enables you to adjust properties that are
specific to the selected printer. See Figure 12-7 for an example. You can also open
this dialog box from the Page Setup dialog box (click the Options button).

NEC SilentWriter 95 Pro

you set printer-specific options.

Some of the printer settings can be set directly from Excel. Other settings may not
be accessible from Excel, and you can change them in this dialog box. For example,
if your printer uses multiple paper trays, you can select which tray to use.

Using Print Preview

Excel’s print preview feature displays an image of the printed ocutput on your
screen. This is a handy feature that enables vou to see the result of the options that
you set, before you actually send the job to the printer. I’ll save you lots of time —
not to mention printing supplies.
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Accessing Print Preview

Several ways exist to preview your document:

» Select the File» Print Preview command.

» C(lick the Print Preview button on the Standard toolbar. Or, you can press Shift
and click the Print button on the Standard toolbar (the Print button serves a
dual purpose).

» C(lick the Print Preview button in the Print dialog box.
» Click the Print Preview button in the Page Setup dialog box.

Any one of these methods changes Excel’'s window to a preview window, as shown
in Figure 12-8.

% Microsalt Excel

T

PECERREERRIEERER

Figure 12-8: The print preview feature enables you to see the printed output
before you send it to the printer.

The preview window has several buttons along the top:

» Next: Displays an image of the next page.

« Previous: Displays an image of the previous page.
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« Zoom: Zooms the display in or out. This button toggles between the two
levels of zooming that are available. You also can simply click the preview
image to toggle between zoom modes.

= Print: Sends the job to the printer.

= Setup: Displays the Page Setup dialog box, so that you can adjust some
settings. When you close the dialog box, you return to the preview screen, so
that vou can see the effects of your changes.

» Margins: Displays adjustable columns and margins, described in the next
section.

» Page Break Preview: Displays the worksheet in Page Break Preview mode.
* C(lose: Closes the preview window.

* Help: Displays help for the preview window.

Making Changes While Previewing

When you click the Margins button in the preview window, Excel adds markers to
the preview that indicate column borders and margins (see Figure 12-9). You can
drag the column or margin markers to make changes that appear onscreen.

Figure 12-9: You can adjust column widths or margins directly from the print
preview window.
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For example, if you print a worksheet and discover that Excel is printing the last
column on a second page, you can adjust the column widths or margins in the
preview window to force all the columns to print on a single page. After vou drag one
of these markers, Excel updates the display so that you can see what effect it had.

When yvou make changes to the column widths in the preview window, these
changes also are made to your worksheet. Similarly, changing the margins in the
preview window changes the settings that appear in the Margins tab of the Page
Setup dialog box.

Dealing with Page Breaks

If you print lengthy reports, you know that it’s often important to have control over
the page breaks. For example, you normally wouldn’t want a row to print on a page
by itself. Fortunately, Excel gives you superb control over page breaks.

As you may have discovered, Excel handles page breaks automatically. After you
print or preview your worksheet, it even displays dashed lines to indicate where
page breaks occur. Sometimes, however, you’ll want to force a page break—either a
vertical or a horizontal one. For example, if vour worksheet consists of several
distinct areas, you may want to print each area on a separate sheet of paper.

Inserting a Page Break

To insert a vertical manual page break, move the cell pointer to the cell that will
begin the new page, but make sure that you place the pointer in column A;
otherwise, you'll insert a vertical page break and a horizontal page break. For
example, if you want row 14 to be the first row of a new page, select cell Al4. Then,
choose [nsert+ Page Break. Excel displays a dashed line to indicate the page break.
The dashed line for manual page breaks is slightly thinner than the lines for natural
page breaks.

To insert a horizontal page break, move the cell pointer to the cell that will begin
the new page, but in this case, make sure that you place the pointer in row one.
Select Insert+ Page Break to create the page break.

Removing a Page Break

To remove a vertical manual page break, move the cell pointer anywhere in the first
row beneath the manual page break and then select [nsert+* Remove Page Break
(this command appears only when you place the cell pointer in the first row
following a manual page break).

To remove a horizontal manual page break, perform the same procedure, but
position the cell pointer anywhere in the first column following a horizontal
page break.
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To remove all manual page breaks in the worksheet, click the Select All button (or
press Ctrl+A); then, choose Insert. Remove Page Break.

Using Page Break Preview

Page Break Preview mode makes dealing with page breaks easy. To use Page Break
Preview, choose View+ Page Break Preview. The screen changes, as shown in
Figure 12-10.
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Flgure 12-10: Page Break Preview mode gives you a bird’s-eye view of your
worksheet and shows exactly where the page breaks occur.

When you enter Page Break Preview mode, Excel does the following:

» Changes the zoom factor so that you can see more of the worksheet
» Displays the page numbers overlaid on the pages

» Displays the current print range with a white background; nonprinting data
appears with a gray background

« Displays all page breaks
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When you’re in Page Break Preview mode, vou can drag the borders to change the
print range or the page breaks. When you change the page breaks, Excel
automatically adjusts the scaling so that the information fits on the pages, per your
specifications.

In Page Break Preview mode, you still have access to all of Excel’'s commands. You
can change the zoom factor if you find the text to be too small.

To return to normal viewing, select the View+ Normal cornmand.

Using Custom Views

Workbooks commonly are used to store a variety of information, and often, several
different reports are printed from such workbooks. If this sounds familiar, you need
to know about Excel’s custom views feature.

The custom views feature enables you to give names to various views of your
worksheet, and yvou can quickly switch among these named views. A view includes
settings for the following:

« Print settings, as specified in the Page Setup dialog box (optional)
» Hidden rows and columns (optional)
» Display settings, as specified in the Options Display dialog box
» Selected cells and ranges
» The active cell
« Window sizes and positions
» Frozen panes
For example, you might define a view that hides a few columns of numbers, another

view with a print range defined as a summary range only, another view with the
page setup set ta landscape, and so on.

To create a named custom view, first set up your worksheet with the settings that
you want to include in the view. These settings can include any of the settings listed
previously. For example, you might create a view that has a specific range of cells
defined as the print range. Then, select View+ Custom Views, and Excel displays a
dialog box that lists all named views. Initially, this list is empty, but you can click
the Add button to add a view in the Add View dialog box, shown in Figure 12-11.

Enter a name for the view and make any adjustments to the check boxes. Click OK,
and Excel saves the view. You can add as many views as yvou want and easily switch
among them — just highlight the custom view that yvou want to display from the
Custom Views dialog box and then click the Show button.
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Figure 12-11: Use the Add View dialog box
to supply a name for a new custom view.

More About Printing

A few issues related to printing just don’t fit anywhere other than a “miscellaneous”
section. This section serves as that “miscellaneous” section and provides some
additional information regarding printing.

Problems with Fonts (When WYS Isn't WYG)

Sometimes, you may find that the printed output doesn’t match what you see
onscreen. You almost always can trace this problem to the fonts that vou use. If
your printer doesn’t have a font that you use to display your worksheet, Windows
attempts to match the font as best as it can. Often, the match just isn’t good
enough.

Simply using TrueType fonts almost always solves this problem; these scalable
fonts are designed for both screen viewing and printing.

Printing Noncontiguous Ranges on a Single Page

You may have discovered that Excel lets you specify a print area that consists of
noncontiguous ranges (a multiple selection). For example, if you need to print, say,
A1:C50, D20:F24, and M11:P16, you can press Ctrl while vou select these ranges and
then issue the File « Print command and choose the Selection option. Better yet,
give this multiple selection a range name so that you can quickly choose the same
ranges the next time.

Printing multiple ranges is a handy feature, but you may not like the fact that Excel
prints each range on a new sheet of paper —and this behavior can’t be changed.

You might consider creating live snapshots of the three ranges and pasting these
snapshots to an empty area of the worksheet. Then, you can print this new area
that consists of the snapshots, and Excel won'’t skip to a new page for each range.
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To create a live snapshot of a range, select the range and copy it to the Clipboard.
Then, to paste a live link (see the Note that follows), select the cell in which vou
want to paste the snapshot (an empty worksheet is a good choice), press and hold
the Shift key, and choose Edit+ Paste Picture Link. Repeat this procedure for the
other ranges. After you paste them, you can rearrange the snapshots any way you
like. Notice that these are truly live links: change a cell in the original range and the
change appears in the linked picture. Figure 12-12 shows an example of snapshots

made from several ranges.

Figure 12-12: These two objects are linked pictures of ranges that exist elsewhere
in the workbook, which enables you to print nonadjacent ranges on a single sheet.

Hiding Cells Before Printing

You may have a worksheet that contains confidential information. You may want to
print the worksheet, but not the confidential parts. Several techniques prevent
certain parts of a worksheet from printing:

*» When vou hide rows or columns, the hidden rows aren’t printed.

» You can effectively hide cells or ranges by making the text color the same
color as the background color.
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You can hide cells by using a custom number format that consists of three
semicolons ;).

* You can mask off a confidential area of a worksheet by covering it with a
rectangle object. Click the Rectangle tool on the Drawing toolbar and drag the

rectangle to the proper size. For best results, you can make the rectangle
white with no border.

» You can use a text box object, available by using the Text Box tool on the
Drawing toolbar, to mask off a range. The advantage to using a text box is

that you can add text to it with information about the concealed data (see
Figure 12-13).
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Figure 12-13: You can use a text box to hide confidential data so
that it won't print.

If you find that you must regularly hide data before you print certain reports,
consider using the custom views feature to create a named view that doesn’t show
the confidential information.

Using a Template to Change Printing Defaults

If you are never satisfied with Excel’'s default print settings, you may want to create
a template with the print settings that you use most often. After doing so, you can
create a new workbook based on the template, and the workbook will have your
own print settings for defaults.

Chapter 34 discusses template files.
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Summary

This chapter presents the basics —and some finer points — of printing in Excel.
You learn how to use the Print dialog box and the Page Setup dialog box to control
what gets printed and how it is printed. You also learn about the print preview
feature that shows how the printed output will lock before it hits the paper. The
chapter covers features such as manual page breaks, custom views, Page Break
Preview mode, tips on printing noncontiguous ranges on a single sheet, and hiding
cells that contain confidential information.
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Chart-Making
Basics

‘ harts — also known as graphs —have been an integral

part of spreadsheets since the early days of Lotus 1-2-3.
Charting features have improved significantly over the years,
and vou’ll find that Excel provides you with the tools to create
a wide variety of highly customizable charts. In fact, Excel has
so much capability in this area that trvo chapters are needed
to present the information. This chapter presents the basic
information that you need to know to create charts and make
simple modifications to them. Chapter 16 continues with a
discussion of advanced options and a slew of chart-making
tricks and techniques.

Overview of Charts

Basically, a chart presents a table of numbers visually.
Displaying data in a well-conceived chart can make the data
more understandable, and you often can make your point
movre quickly as a result. Because a chart presents a picture,
charts are particularly useful for understanding a lengthy
series of numbers and their interrelationships. Making a chart
helps you to spot trends and patterns that would be nearly
impossible to identify when examining a range of numbers.

You create charts from numbers that appear in a worksheet.
Before you can create a chart, you must enter some numbers
in a worksheet. Normally, the data that is used by a chart
resides in a single worksheet, within one file—but that’s not a
strict requirement. A single chart can use data from any
nummber of worksheets or even from different warkbooks.

When you create a chart in Excel, you have two options for
where to place the chart:
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« Insert the chart directly into a worksheet as an object. A chart like the one
that appears in Figure 13-1 is known as an embedded chart.

» Create the chart as a new chart sheet in your workbook (see Figure 13-2). A
chart sheet differs from a worksheet in that a chart sheet can hold a single
chart and doesn’t have cells.
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Figure 13-2: This chart appears on a separate chart sheet.
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See the “Reference: Excel’'s Chart Types” section later in this chapter for a complete
listing of Excel’s chart types.

Which Chart Type to Use?

Beginning chart makers commonly ask how to determine the most appropriate
chart type for the data. No good answer exists to this question, and I'm not aware
of any hard-and-fast rules for determining which chart type is best for yvour data.
Perhaps the best rule is to use the chart type that gets vour message across in the
simplest way.

Figures 13-3, 13-4, and 13-5 show the same data plotted using three different chart
types. Although all three charts represent the same information, they look quite
different.

Customer Cumplaints by Month

e T e
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Figure 13-3: An example of a column chart.

Customer Camplants by Manth
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Figure 13-4: An example of an area chart.
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Figure 13-6: One of several dialog boxes
displayed by the Chart Wizard.

Creating a Chart with One Keystroke

For a quick demonstration of how easily you can create a chart, follow these
instructions. This example bypasses the Chart Wizard and creates a chart on a
separate chart sheet.

1. Enter data to be charted into a worksheet. Figure 13-7 shows an example of
data that’s appropriate for a chart.

2, Select the range of data that you entered in Step 1, including the row and
column titles. For example, if you entered the data shown in Figure 13-7, select
Al:C4.

3. Press F11. Excel inserts a new chart sheet (named Chartl) and displays the
chart, based on the selected data. Figure 13-8 shows the result.
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« Pie charts and doughnut charts have no axes (but they do have calories). A
pie chart can display only ane data series. A doughnut chart can display
multiple data series.

» A radar chart is a special chart that has one axis for each point in the data
series. The axes extend from the center of the chart.

» True 3D charts have three axes: a category axis, a value axis, and a series axis
that extends into the third dimension, Refer to the upcoming sidebar, “3D or
Not 3D? That [s the Question,” for a discussion about Excel’s 3D charts.

A chart is not stagnant. You can always change its type, add custom formatting, add
new data series to it, or change an existing data series so that it uses data in a
different range.

Before you create a chart, you need to determine whether you want it to be an
embedded chart or a chart that resides on a chart sheet.
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Embedded Charts

An embedded chart basically floats on top of a worksheet, on the worksheet’s draw
layer. As with other drawing objects (such as a text box or a rectangle), you can
move an embedded chart, resize it, change its proportions, adjust its borders, and
perform other operations.

Chapter 14 discusses Excel's drawing objects and the draw layer.

To make any changes ta the actual chart in an embedded chart object, you must
click it to select the chart; Excel’'s menus, which swap places with the toolbars
when you select a chart, include commands that are appropriate for working with
charts. In addition, a Chart menu replaces the Data menu. Using embedded charts
enables yvou to print the chart next to the data that it uses.

Figure 139 shows an example of a report with a chart embedded.
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gure 13-9: This report includes an embedded chart.
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Chart Sheets

When you create a chart on a chart sheet, the chart occupies the entire sheet. If
you plan to print a chart on a page by itself, using a chart sheet is your best choice.
[f you have many charts to create, you may want to create each one on a separate
chart sheet, to avoid cluttering your worksheet. This technique also makes locating
a particular chart easier, because you can change the names of the chart sheets’
tabs to correspond to the chart that it contains.

Excel’s menus change when a chart sheet is active, similar to the way that they
change when vou select an embedded chart. The Chart menu replaces the Data
menu, and other menus include commands that are appropriate for working with
charts.

Excel displays a chart in a chart sheet in WYSIWYG mode: the printed chart looks
just like the image on the chart sheet. If the chart doesn’t fit in the window, yvou can
use the scrollbars to scroll it or adjust the zoom factor.

You also can size the chart in a chart sheet according to the window size by using
the View+ Sized with Window command. When this setting is enabled, the chart
adjusts itself when vou resize the workbook window (it always fits perfectly in the
window). In this mode, the chart that you're working on may or may not
correspond to how it looks when printed.

If you create a chart on a chart sheet, vou can easily convert it to an embedded
chart. Choose Chart+ Location and then select the worksheet that holds the
embedded chart from the As object in list box. Excel deletes the chart sheet and
moves the chart to the sheet that you specify. This operation also works in the
opposite direction: You can relocate an embedded chart to a new chart sheet.

Creating Charts

You can create hoth embedded charts and charts on chart sheets with or without
the assistance of the Chart Wizard.

Excel always has a default chart type. Normally, the default is a column chart (but
you can change this type, as you'll see later). If you create a chart without using
the Chart Wizard, Excel creates the chart by using the default chart type. If you use
the Chart Wizard, Excel prompts you for the chart type, so the default chart type
becomes irrelevant.
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Creating an Embedded Chart with Chart Wizard

To invoke the Chart Wizard to create an embedded chart:

1. Select the data to be charted (optional).

2. Choose Insert+ Chart (or, click the Chart Wizard tool on the Standard
toolbar).

3. Make yvour choices in Steps 1 through 3 of the Chart Wizard.
4, In Step 4 of the Chart Wizard, select the option labeled As object in.

The Chart Wizard is explained in detail later in this chapter.

Creating an Embedded Chart Directly

To create an embedded chart without using the Chart Wizard:

1. Make sure that the Chart toolbar is displayed.

2. Select the data to be charted.

3. Click the Chart Type tool on the Chart toolbar and then select a chart type
from the displayed icons.

Excel adds the chart to the worksheet by using the default settings.

The Chart Type tool on the Chart toolbar displays an icon for the last selected
chart. However, this tool works like a list box; you can expand it to display all
18 chart types (see Figure 13-10). Just click the arrow to display the additional
chart types.

Figure 13-10: The Chart Type tool expands so
that you can create the type of chart you want.
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Creating a Chart on a Chart Sheet with the
Chart Wizard

To start the Chart Wizard and create an embedded chart:

1. Select the data that you want to chart (optional).

2. Choose Insert+ Chart (or click the Chart Wizard tool on the Standard
toolbar).
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3. Make your choices in Steps | through 3 of the Chart Wizard.

4. In Step 4 of the Chart Wizard, select the option labeled As new sheet.

To create a new chart on a chart sheet by using the default chart type, select the
data to be charted and then press the F11 key. This command inserts a new chart
sheet. The chart is created from the selected range, without accessing the Chart

Wizard.

Creating a Chart with the Chart Wizard

The Chart Wizard consists of four dialog boxes that prompt you for various settings
for the chart. By the time that you reach the last dialog box, the chart is usually just
what you need.

Selecting the Data

Before you start the Chart Wizard, select the data that you want to include in the
chart. This step isn’t necessary, but it makes creating the chart easier for you. lf
you don’t select the data before invoking the Chart Wizard, you can select it in the
second Chart Wizard dialog box.

When you select the data, include items such as labels and series identifiers (row
and column headings). Figure 13-11 shows a worksheet with a range of data set up
for a chart. This data consists of monthly sales for two regions. You would select

the entire range for this worksheet, including the month names and region names.

Monthly Sales Chart. xls

D sheers AHHTHAN
Figure 13-11: Data

The data that you plot doesn’t have to be contiguous. You can press Ctrl and make
a multiple selection. Figure 13-12 shows an example of how to select noncontiguous
ranges for a chart. In this case, Excel uses only the selected cells for the chart.
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Figure 13-12: Selecting noncontiguous ranges to
be charted.

After you select the data, start the Chart Wizard, either by clicking the Chart Wizard
button on the Standard toolbar or by selecting Insert+ Chart. Excel displays the
first of four Chart Wizard dialog boxes.

At any time while using the Chart Wizard, you can go back to the preceding step by
clicking the Back button. Or, you can click Finish to close the Chart Wizard. I[f you
close the Chart Wizard early, Excel creates the chart by using the information that
you provided up to that point.

Don’t be too concerned about creating the perfect chart. You later can change, at
any time, every choice that you make in the Chart Wizard.

Chart Wizard — Step 1 of 4

Figure 13-13 shows the first Chart Wizard dialog box, in which you select the chart
type. This dialog box has two tabs: Standard Types and Custom Types. The
Standard Types tab displays the 14 basic chart types and the subtypes for each.
The Custom Types tab displays some customized charts (including user-defined
custom charts).

When you work in the Custom Types tab, the dialog box shows a preview of your
data with the selected chart type. In the Standard Types tab, you get a preview by
clicking the button labeled Click and Hold to View Sample. When you click this
button, keep the mouse button pressed.

When you decide on a chart type and subtype, click the Next button to move to the
next step.
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Figure 13-13: The first of four
Chart Wizard dialog boxes.

Chart Wizard — Step 2 of 4

In the second step of the Chart Wizard (shown in Figure 13-14), you verify the data
ranges and specify the orientation of the data (whether it's arranged in rows or
columns). The orientation of the data has a drastic effect on the look of your chart.
Usually, Excel guesses the orientation correctly —but not always.

Figure 13-14: In the second
Chart Wizard dialog
‘ box, you verify the range and
e 'm 25,000 ﬂ 'j. ‘ i specify whether to
1 R : plot by columns or rows.
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If vou select the Series tab, you can verify or change the data that is used for each
series of the chart. Click the Next button to advance to the next dialog box.

Chart Wizard — Step 3 of 4

In the third Chart Wizard dialog box, shown in Figure 13-15, you specify most of the
options for the chart. This dialog box has six tabs:

« Titles: Add titles to the chart.

« Axes: Turn on or off axes display and specify the type of axes.

* Gridlines: Specify gridlines, if any.

* Legend: Specify whether to include a legend and where to place it.

» Data Labels: Specify whether to show data labels and what type of labels.

» Data Table: Specify whether to display a table of the data.

The options available depend on the type of chart that you selected in Step 1 of
the Chart Wizard.

Figure 13-15: You specify the chart options in the third
Chart Wizard dialog box.

Chart Wizard — Step 4 of 4

Step 4 of the Chart Wizard, shown in Figure 13-16, lets you specify where to place
the chart. Make your choice and click Finish.

Excel creates and displays the chart. If vou place the chart on a worksheet, Excel
centers it in the worksheet window and selects it.
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Figure 13-16: Step 4 of the Chart Wizard asks you
where to put the chart.

Basic Chart Modifications

After you create a chart, you can modify it at any time. The maodifications that vou
can make to a chart are extensive. This section covers some of the more common
chart modifications:

» Moving and resizing the chart

» Changing a chart’s location

= Changing the chart type

» Moving chart elements

* Deleting chart elements

Other types of chart modifications are discussed in Chapter 16.

Activating a Chart

Before you can modify a chart, it must be activated. To activate an embedded chart,
click it, which also activates the element that you click. To activate a chart on a
chart sheet, just click its sheet tab.

Moving and Resizing a Chart

If your chart is on a chart sheet, you can’t move or resize it. You can, however,
change the way that it’s displayed by selecting View + Sized with Window.

If you embedded the chart, you can freely move and resize it. Click the chart’s
border to select the chart; eight handles (small black squares) appear on the
chart’s border. Drag the chart to move it, or drag any of the handles to resize the
chart.
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Changing a Chart’s Location

Use the Chart » +Location command to relocate an embedded chart to a chart
sheet, or convert a chart on a chart sheet to an embedded chart. This command
displays the Chart Location dialog box.

if you select an embedded chart and choose an existing chart sheet as its new
location, Excel will ask if you'd like to embed the chart on the chart sheet. If you
respond Yes, the chart sheet will contain an additional chart. This is a way to over-
come the normal limit of one chart per chart sheet. Even better, you can delete the
original chart on the chart sheet and then rearrange your embedded charts on a
single chart sheet.

Changing the Chart Type

To change the chart type of the active chart, use either of the following methods:

= Click the Chart Type button’s drop-down arrow on the Chart toolbar. The
button expands to show I8 basic chart types.

» Chowose the Chart* Chart Type command.

The Chart+ Chart Type command displays the dialog box shown in Figure 13-17.
You may recognize this dialog box as the first of the Chart Wizard dialog boxes.
Click the Standard Types tab to select one of the standard chart types (and a
subtype), or click the Custom Types tab to select a customized chart. After you
select a chart type, click OK; the selected chart will be changed to the type that
you selected.

Figure 13-17: The Chart Type
dialog box enables
you to change the chart’s type.
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if you've customized some aspects of your chart, choosing a new chart type from
the Custom Types tab may override some or all the changes that you've made. For
example, if you've added gridlines to the chart and then select a custom chart type
that doesn't use gridlines, your gridlines disappear. Therefore, you should make
sure that you're satisfied with the chart before you make too many custom
changes to it. However, you can always use Edit+ Undo to reverse your actions.

In the Custom Types tab, if you click the User-defined option, the list box displays
the name of any user-defined custom formats. If you haven't defined any custom
formats, this box shows Default, referring to the default chart type. Changing the
default chart type is discussed later in this chapter.

Chapter 16 explains how to create custom formats.

Moving and Deleting Chart Elements

Some of the chart parts can be moved (any of the titles, the legend, or data labels).
To move a chart element, simply click it to select it and then drag it to the desired
location in the chart. To delete a chart element, select it and then press Delete.

Other Modifications

When a chart is activated, you can select various parts of the chart to change.
Modifying a chart is similar to evervthing else you do in Excel. First, you make a
selection (in this case, select a chart part). Then, you issue a command to do
something with the selection.

You can use the Fill Color tool on the Formatting toolbar to change colors. For
example, if vou want to change the color of a series, select the series and choose
the color that you want from the Fill Color tool. You’ll find that many other toolbar
tools work with charts. For example, you can select the chart’s legend and then
click the Bold tool to make the legend text bold.

When you double-click a chart element (or press Ctrl+1 after selecting it), its
Formatting dialog box appears, which varies, depending on the item selected. In most
cases, the dialog box is of the tabbed variety. Many modifications are selfevident —
for example, changing the font used in a title. Others, however, are a bit trickier.

Chapter 16 discusses these chart modifications in detail.

Changing the Default Chart Type

The default chart type is mentioned many times in this chapter. Excel’s default
chart type is a 2D columm chart with a light-gray plot area, a legend on the right,
and horizontal gridlines.
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If you don’t like the looks of this chart or if you typically use a different type of
chart, you can easily change the default chart in the following manner:

1. Select the Chart+ Chart Type command.

2. Choose the chart type that you want to use as the default chart. This can be a
chart from either the Standard Types tab or the Custom Types tab.

3. Click the button labeled Set as default chart type. You are asked to verify your
choice.

if you have many charts of the same type to create, changing the default chart for-
mat to the chart type with which you're working is much more efficient than sep-
arately formatting each chart. Then, you can create all of your charts without hav-
ing to select the chart type.

Printing Charts

Printing embedded charts is nothing special; you print them the same way that you
print a worksheet (see Chapter 12). As long as you include the embedded chart in
the range that vou want to print, Excel prints the chart as it appears onscreen.

if you select an embedded chart and then choose File« Print (or click the Print
button), Excel prints the chart on a page by itself and does not print the worksheet.

If you print in Draft mode, Excel doesn’t print embedded charts. Also, if you don’t
want a particular embedded chart to appear on your printout, right-click the chart
and choose Format Chart Area from the shortcut menu. Click the Properties tab in
the Format Chart Area dialog box and remove the check mark from the Print Object
check box.

If you created the chart on a chart sheet, Excel prints the chart on a page by itself.
If you open Excel’s Page Setup dialog box when the chart sheet is active, the Sheet
tab is replaced with a tab named Chart. Figure 13-18 shows the Chart tab of the
Page Setup dialog box.

This dialog box has several options:

« Use full page: Excel prints the chart to the full width and height of the page
margins. This usually isn’t a good choice, because the chart’s relative propor-
tions change and vou lose the WYSIWYG advantage.

« Scale to fit page: Expands the chart proportionally in both dimensions until
one dimension fills the space between the margins. This option usually results
in the best printout.

« Custom: Prints the chart as it appears on your screen. Select View+ Sized
with Window to make the chart correspond to the window size and propor-
tions. The chart prints at the current window size and proportions.
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Figure 13-18: The Chart tab of the Page Setup dialog box.

The Printing quality options work just like those for worksheet pages. If you choose
the Draft quality option for a chart sheet, Excel prints the chart, but its quality may
not be high (the actual effect depends on your printer). Choosing the Print in black
and white option prints the data series with black-and-white patterns rather than
colors.

Because charts usually take longer to print than text, using the print preview fea-
ture before you print a chart is an especially good idea. This feature enables you to
see what the printed output will look like, so that you can avoid surprises.

Reference: Excel’s Chart Types

For your reference, this chapter concludes with a discussion of Excel's chart types
and a listing of the subtypes for each. This section may help you determine which
chart type is best for your data.

Column Charts

Column charts are one of the most common chart types. This type of chart is useful
for displaying discrete data (as opposed to continuous data). You can have any
number of data series, and the coluimms can be stacked on top of each other. Figure
13-19 shows an example of a column chart.
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Figure 13-19: This stacked column chart displays each series as
a percentage of the total. It may substitute for several pie charts.

Table 13-2 lists Excel's seven column chart subtypes.

Chart Type Description

Stacked Column Column chart with data series stacked

3-D 100% Stacked Column Column chart with a perspective look. Excel stacks the data
series and expresses them as percentages.

Bar Charts

A bar chart is essentially a column chart that has been rotated 90 degrees to the
left. The advantage in using a bar chart is that the category labels may be easier to
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read (see Figure 13-20 for an example). You can include any number of data series in
a bar chart. In addition, the bars can be stacked from left to right. Table 13-3 lists
Excel’s six bar chart subtypes.

Survey Item #12:
“I like Go-Go Grocery's TV Advertising”

wstrongty Agree
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Figure 13-20: If you have lengthy category labels, a bar chart may be
a good choice.

Table 13-3 lists Excel’s six bar chart subtypes.

Chart Type Description

Stacked Bar Bar chart with data series stacked

3-D Clustered Bar Standard bar chart with a perspective look.

3-D 100% Stacked Bar Bar chart with a perspective look. Excel stacks data series and
expresses them as percentages.
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Line Charts

Line charts are frequently used to plot data that is continuous rather than discrete.
For example, plotting daily sales as a line chart may let vou spot trends over time.
See Figure 13-21 for an example.
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Figure 13-21: A line chart often can help you spot trends
in your data.

Table 13-4 lists Excel’s seven line chart subtypes.

Chart Type Description

Stacked Line Line chart with stacked data series.

Line with Data Markers Line chart with data markers.

100% Stacked Line Line chart with stacked data series and line markers, expressed
with Data Markers as percenitages.
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Pie Charts

A pie chart is useful when you want to show relative proportions or contributions to
a whole. Figure 13-22 shows an example of a pie chart. Generally, a pie chart should
use no more than five or six data points; otherwise, it's difficult to interpret. A pie
chart can use only one data series.

You can explode a slice of a pie chart. Activate the chart and select the slice that
you want to explode. Then, drag it away from the center.
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u

Galiformia Population
Oy Hthraclty (1294)

Figure 13-22: A pie chart with one slice exploded.

Table 13-5 lists Excel’s six pie chart subtypes.

Chart Type Description

Pie chart with perspective look.

Exploded Pie Pie chart with ene or more slices exploded.

Bar of Pie Pie chart with one slice broken into a column.
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The Pie of Pie and Bar of Pie chart types enable you to display a second chart that
clarifies one of the pie slices. You can use the Options tab of the Format Data
Series dialog box to specify which data is assigned to the second chart. Refer to
Chapter 16 for details.

XY (Scatter) Charts

Another common chart type is XY (Scatter) charts (also known as scattergrams). An
XY chart differs from the other chart types in that both axes display values (there
is no category axis).

This type of chart often is used to show the relationship between two variables.
Figure 13-23 shows an example of an XY chart that plots the relationship between
sales calls and sales. The chart shows that these two variables are positively related:
months in which more calls were made typically had higher sales volumes.
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Figure 13-23: An XY (Scatter) chart.

Table 13-6 lists Excel’s five XY (Scatter) chart subtypes.

Chart Type Description

Scatter with Smoothed Lines XY chart with markers and smoothed hneS.
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Chart Type Description

Scatter with Lines and XY chart with lines and no markers.
No Data Markers

Area Charts

Think of an area chart as a line chart that has been colored in. Figure 13-24 shows
an example of a stacked area chart. Stacking the data series enables you to see
clearly the total plus the contribution by each series.

$3,200 oales by Gtate

Jan +eh Mar Apr May Jun

Figure 13-24: An area chart

Table 13-7 lists Excel’s six area chart subtypes.

Chart Type Description

3-D Area A true 3D area chart with a third axis.

3-D 100% Stacked Area Area chart with a perspective look, expressed as percentages.
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Doughnut Charts

A doughnut chart is similar to a pie chart, except that it has a hole in the middle.
Unlike a pie chart, a doughnut chart can display more than one series of data. Figure
13-25 shows an example of a doughnut chart (the arrow and series descriptions were
added manually; these items aren’t part of a doughnut chart).

Notice that Excel displays the data series as concentric rings. As you can see, a
doughnut chart with more than one series to chart can be difficult to interpret.
Sometimes, a stacked column chart for such comparisons expresses your meaning
better than a doughnut chart.

California Population by Ethnicity
199, and Projections for 2015 and 2040

@ Black
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FAHspanic
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Figure 13-25: A doughnut chart.

Table 13-8 lists Excel’s two doughnut chart subtypes.
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Radar Charts

You may not be familiar with radar charts. A radar chart has a separate axis for each
category, and the axes extend from the center. The value of the data point is plotted
on the appropriate axis. [f all data points in a series have an identical value, it
produces a perfect circle. See Figure 13-26 for an example of a radar chart.
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Figure 13-26: A radar chart.

Table 13-9 lists Excel’s three radar chart subtypes.

Chart Type Subtype

Radar with Data Markers Radar chart with lines data markers.

Surface Charts

Surface charts display two or more data series on a surface. As Figure 13-27 shows,
these charts can be quite interesting. Unlike other charts, Excel uses color to
distinguish values, not to distinguish the data series. You can change these colors
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only by modifying the workbook’s color palette, using the Color tab in the Options
dialog box.

SIN{SIN(X)) "COS(YIX)

Figure 13-27: A surface chart.

Table 13-10 lists Excel’s four 3D surface chart subtypes.

Chart Type Description

D Surface (wireframe)

urface (top view wireframe)

Bubble Charts

Think of a bubble chart as an XY (Scatter) chart that can display an additional data
series. That additional data series is represented by the size of the bubbles.

Figure 13-28 shows an example of a bubble chart. In this case, the chart displays the
results of a weight-loss program. The x axis represents the original weight, the y axis
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shows the length of time in the program, and the size of the bubbles represents the
amaount of weight lost.

wWeignt L oss as a Function af Weeks in Frogram and
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Figure 13-28: A bubble chart.

Table 13-11 lists Excel’s two bubble chart subtypes.

Charl Type Subtype

Stock Charts

Stock charts are most useful for displaying stock market information. These charts
require three to five data series, depending on the subtype.

Figure 13-29 shows an example of a stock chart. This chart uses the High-Low-Close
subtype that requires three data series.
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Figure 13-29: A stock chart.

Table 13-12 lists Excel’s four stock chart subtypes.

Chart Type Subtype

Open-High-Low-Close Displays the stock’s opening, high, low, and closing
prices.

Volume-Open-High-Low-Clase Displays the stock’s volume, open, high, low, and
closing prices.

Cylinder, Cone, and Pyramid Charts

These three chart types are essentially the same — except for the shapes that are
used. You usually can use these charts in place of a bar or column chart.

Figure 13-30 shows an example of a pyramid chart.

Each of these chart types has seven subtypes, which are described in Table 13-13.

CiM Ex. 1052 Page 153



Neariber ol Emeloyees

el
Ul
‘v

Al
20
auy
40
el
10

u

1891 1992 1983 1992 395 96 1997

Figure 13-30: A pyramid chart.

Chart Type Subtype

Stacked Column Column chart with data series stacked.

Clustered Bar Standard bar chart.

cked

Summary

This chapter introduces Excel’s chart-making feature. Charts can be embedded on a
worksheet or created in a separate chart sheet. You can either use the Chart Wizard
to walk you through the chart-making process or create a default chart in a single
step. This chapter also describes how to change the default chart type.

After a chart is created, you can make many types of madifications. A few simple
modifications are discussed; Chapter 16 presents additional chart information.
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Printing charts works much like printing worksheets, although you should be
familiar with the page setup options when vou're printing chart sheets. The chapter
concludes with a complete listing and description of Excel’s chart types and
subtypes.

 SONEIEISIRE  SEOEIUIN SN
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Enhancing Your
Work with
Pictures and
Drawings

In Chapter 13, you learned how to create charts from the
numbers in your worksheet. This chapter continues in the
same vein by discussing pictures and drawings. Like charts,
these objects can be placed on a worksheet’s draw layer to
add pizzazz to an otherwise boring report. (See the sidebar,
“A Word About the Draw Layer,” later in this chapter.)

This chapter discusses three major types of images:
» Bitmap and line-art graphics imported directly into a
workbook or copied from the Clipboard
« Objects created by using Excel’s drawing tools
» Objects inserted by using other Microsoft Office tools,

such as WordArt and Organization Chart

Excel also can create another type of graphic image: maps.
But that's the topic of Chapter 17.

Importing Graphics Files

Excel can import a wide variety of graphics files into a
worksheet. You have several choices:

* Use the Microsoft Clip Gallery to locate and insert an
image
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« Directly import a graphic file
+ Copy and paste the image by using the Windows Clipboard

» Import the image from a digital camera or scanner

Using the Clip Gallery

The Clip Gallery is a shared application that is also accessible from other Microsoft
Office products.

Besides providing an easy way to locate and insert images, the Clip Gallery
enables you to insert sound and video files.

The Clip Gallery is available in both Excel 97 and Excel 2000, but the feature works
a bit differently in Excel 2000. In addition, Excel 2000 gives you direct access to
Microsoft's Clip Gallery Live on the Web.

You access the Clip Gallery by selecting the Insert» Picture+ Clip Art command.
This displays the Insert ClipArt dialog box, shown in Figure 14-1. Click the Pictures
tab and then click a category, and the images in that category appear. Locate the
image that you want and click it. A graphic menu pops up from which you can
choose to insert the image, preview the image, add the image to your “favorites,”
or find similar images. You can also search for clip art by keyword — just enter
some text in the Search for clips box, and the matching images are displayed.

Il

Figure 14-1: The Insert ClipArt dialog box enables you to insert
pictures, sounds, or video.
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If you select the insert option, the image is embedded in your worksheet. You can
then either select additional images from the Clip Gallery or close the Insert ClipArt
dialog box.

When an image is selected, Excel displays its Picture toolbar, which contains tools
that enable vou to adjust the image.

You also can add new files to the Clip Gallery. You might want to do this if you
tend to insert a particular graphic file into your worksheets (such as your company

logo). Use the Import Clips button to select the file and specify the category for the
image.

if you can’t find a suitable image, you can go online and browse through the clip
art at Microsofi’'s Web site. In the Insert ClipArt dialog box, click the Clips Online
button. Your Web browser will be activated, and you can view the images (or
listen to the sounds) and download those that you want. Figure 14-2 shows
Microsoft's online Clip Gallery
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Figure 14-2: Microsoft's Clip Gallery Live enables you to download additional clip art.
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Importing Graphics Files

If the graphic image that vou want to insert is available in a file, vou can easily
import the file into your worksheet by choosing Insert» Picture+ From File. Excel
displays the Insert Picture dialog box, shown in Figure 14-3. This dialog box works
just like the Open dialog box. By default, it displays only the graphics files that
Excel can import. If you choose the Preview option, Excel displays a preview of the
selected file in the right panel of the dialog box.
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Figure 14-3: The Insert Picture dialog box enables you to embed a
picture in a worksheet.

Excel 2000 supports animated GIF files — sort of. If you insert an animated GIF file,
the image will be animated only if you save your workbook as a Web page and
then view it in a Web browser. Figure 14-4 shows an example of a graphics file in
a worksheet.

Figure 14-4 shows an example of a graphic image in a worksheet.
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Figure 14-4: An example of a graphics file embedded in a worksheet.

gg Using bitmap graphics in a worksheet can dramatically increase the size of your
: workbook, resulting in more memory usage and longer load and save times.

Table 14-1 lists the graphics file types that Excel can import. The most comrmon
graphics file formats are GIF, JPG, and BMP.
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File Type Description

CDR CorelDRAW graphics

DXF AutoCAD format 2D

EPS Encapsulated PostScript

HGL HP Graphics Language

PCX Bitmap graphics

RLE Windows bitmap

TIF Tagged Interchange Format

erfect graphics

if you want to use a graphic image for a worksheet's background (similar to wall-
. Ppaper on the Windows desktop), select Format+ Sheet+ Background and then
W selecta graphics file. The selected graphics file is tiled on the worksheet. It won't
be printed, however.

Copying Graphics by Using the Clipboard

In some cases, you may want to use a graphic image that is not stored in a separate
file or that is in a file that Excel can’t import. For example, yvou may have a drawing
program that uses a file format that Excel doesn’t support. You may be able ta
export the file to a supported format, but it may be easier to load the file into the
drawing program and copy the image to the Clipboard. Then, you can activate Excel
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and paste the image to the draw layer. (See the sidebar, “A Word About the Draw
Layer,” later in this chapter.)

This capability also is useful if you don't want to copy an entire image. For example,
a drawing may consist of several components, and you may want to use only one
element in Excel. [n this case, using the Clipboard is the only route.

Suppose that you see a graphic displayed onscreen but you can't select it — it may
be part of a program’s logo, for example. In this case, you can copy the entire
screen to the Clipboard and then paste it into Excel. Most of the time, you don’t
want the entire screen — just a portion of it. The solution is to capture the entire
screen (or window), copy it to the Windows Paint program, and then copy just the
part that vou want (or crop out what you don’t want) and paste it to your Excel
worksheet. Figure 14-5 demonstrates this technique using Paint. In this case, a
window was copied and pasted to Paint.
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Figure 14-5: The window was captured and pasted to Paint. You can copy
the part that you want and paste it to Excel.

Use the following keyboard commands, as needed:

PrintScreen: Copies the entire screen to the Clipboard

Alt+PrintScreen: Copies the active window to the Clipboard
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Importing from a Digital Camera or Scanner

You can bring in an image directly from a digital camera or a scanner. To use this
feature, make sure that your device is connected and set up properly. Then, choose
[nsert+ Picture+ From Scanner or Camera. The exact procedure varies, depending on
your camera or scanner. [n most cases, the image appears in Microsoft Photo Editor.
You can adjust the image, if necessary, and then select Files Exit and Return to Excel.

&

Importing images from a digital camera or scanner is a new feature in Excel 2000.

Modifying Pictures

When you insert a picture on a worksheet, you can modify the picture in various
ways by using the Picture toclbar, shown in Figure 14-6. This toolbar appears
automatically when you select a picture object. The tools are described in Table
14-2, in left-to-right order on the toolbar.

Figure 14-6: The Picture toolbar
enables you to adjust a picture.

Tool Name What the Too! Does

Image Control Enables you to change a picture to gray-scale, black and white,
or a watermark (semitransparent).

Less Contrast Decreases the contrast of the picture.

Less Brightness Decreases the brightness of the picture.

Set Transparent Color Selects a color that will be transparent. Underlying cell contents
appear through the selected transparent color. This option is not
ilable for all types of picture:
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Using Excel’s Drawing Tools

The discussion so far has focused on using graphic images from other sources. If
your needs invalve simple (or not so simple) graphic shapes, you can use the
drawing tools built into Excel to create a variety of graphics.

Beginning with Excel 97, the drawing features have been improved significantly.
These tools also are available in the other Microsoft Office applications.

The Drawing Toolbar

Excel’'s drawing tools are available from the Drawing toolbar, shown in Figure 14.7.
The drawing objects feature is one of the few features in Excel that’s not available
from the menus. Notice that the Standard toolbar has a tool named Drawing. Clicking
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this tool toggles the Drawing toolbar on and off. Normally, the Drawing toolbar
appears at the bottom of Excel’s window, but (as with all toolbars) you can place it
anywhere that you like. As you'll see, this toolbar includes more than meets the eye.

Figure 14-7: Display the Drawing toolbar to create and modify drawings.

Table 14-3 describes the tools in the Drawing toolbar. The tools are listed in the
order in which they appear, from left to right.

Tool Name What the Tool Does

Select Objects Selects one or more graphic objects. If you have several objects and you
want to select a group of them, use this tool to drag the outline so that
it surrounds all the objects. Click the button again to return to normal
selection mode.

AutoShapes Displays a menu of seven categories of shapes. Drag this menu to
create an AutoShapes toolbar. You also can display the AutoShapes
toalbar with the Insert+ Picture+ AutoShapes command

Arrow Inserts an arrow.

Oval Inserts an oval or a circle.

WordArt Displays the WordArt Gallery dialog box, which enables you to create
attractive titles using text. You also can display this dialog box by
selecting Insert» Picture+ WordArt

Fill Color Select a fill color or fill effect for an object.
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Tool Name What the Too! Does

3-D Specify the type of perspective effect for an object and settings for the
effect.

&

;@& Insert Clip Art and Line Color are two new tools of Excel 2000.

Drawing AutoShapes
Drawing objects with the AutoShapes tool is quite intuitive. The AutoShapes tool
expands to display the following shape categories:

» Lines: Six styles of lines, including arrows and freehand-drawing capabilities.

» Connectors: Nine styles of lines designed to indicate connections between
other objects. These objects automatically “snap to” other objects.

« Basic Shapes: Thirty-two basic shapes, including standard shapes, such as
boxes and circles, and nonstandard shapes, such as a smiley face and a heart.

» Block Arrows: Twenty-eight arrow shapes.
« Flowchart: Twenty-seven shapes suitable for Howchart diagrams.

* Stars and Banners: Sixteen stars and banners. Stars are handy for drawing
attention to a particular cell.

« Callouts: Twenty callouts, suitable for annotating cells.

* More AutoShapes: In Excel 2000, vou can get even more AutoShapes. Clicking
this button brings up a dialog box named More AutoShapes — which contains
several additional shapes (actually, these are clip art images).

More AutoShapes is a new feature of Excel 2000.

Click a tool and then drag in the worksheet to create the shape (the mouse
pointer changes shape, reminding yvou that you're in draw mode). When you release
the mouse button, the object is selected and its name appears in the Name box (see
Figure 14-8).
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Figure 14-8: This shape was drawn on the worksheet.
Its name, AutoShapel, appears in the Name box.

Formatting AutoShape Objects

You can format the AutoShape objects at any time. First, yvou must select the object.
If the object is filled with a color or pattern, you can click anywhere on the object to
select it. If the object is not filled, you must click the object’s border.

You can make some modifications by using the toolbar buttons —for example,
change the fill color. Other modifications require that you use the Format AutoShape
dialog box. After selecting one or more objects, you can bring up this dialog box by
using any of the following techniques:

» Choose the Format+ AutoShape command

+ Press Ctrl+1

« Double-click the object

» Right-click the object and choose Format AutoShape from the shortcut menu
The Format AutoShape dialog box has several tabs, the number of which depends

on the type of object and whether it contains text. Each of these tabs is discussed
in the following sections.

The Colors and Lines tab

Select the Colors and Lines tab to adjust the colors, lines, and arrow used in the
object.

This dialog box contains more than meets the eye, and it can lead to other dialog
boxes. For example, click the Color drop-down list and you can select Fill Effects —
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which brings up another multitabbed dialog box that enables you to specify a wide
variety of fill effects.

Beginning with Excel 97, you'll find many new types of fill effects. Spend some time
experimenting with these effects, and 'm sure that you'll be impressed.

The Size panel

The Size tab of the Format AutoShape dialog box (shown in Figure 14-9) enables you
to adjust the size, rotation, and scale of the object. If the object is a picture, you can
use the Reset button to return the object to its original dimensions and rotation.

£

i
e
E i ik

Figure 14-9: The size tab of the Format
AutoShape dialog box.

Contrary to what you might expect, if you rotate an aobject that contains text, the
text will not rotate along with the object. You can also change the object’s size
directly by dragging the object. You can change the rotation directly by clicking the
Free Rotate tool on the Drawing toolbar.

The Protection tab

The Protection tab determines whether the object is “locked.” Locking has no
effect, however, unless the worksheet is protected and the Objects option is in
effect. You can protect the worksheet with the Tools+ Protection+ Protect Sheet
command.
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Locking an object prevents the object from being moved or resized. After you for-
mat all of your objects to your satisfaction, you should lock all objects and protect
the sheet.

&

The Properties tab

The Properties tab of the Format AutoShape dialag box deterrmines how an object
is moved and sized with respect to the underlying cells. (See the sidebar “A Word
About the Draw Layer,” earlier in this chapter.)

The Font tab

The Font tab appears only if the shape contains text. It should be familiar, because
its options are the same as for formatting cells.

The Alignment tab

The Alignment tab appears only if the shape contains text. You can specify the
vertical and horizontal alignment of the text, and choose the orientation. Unlike
text that is contained in cells, you cannot specify an angle for the orientation
(you’re limited to 90 degrees).

If you click the Automatic size option, the shape’s size adjusts to fit the text that it
contains.

The Margins tab
The Margins tab appears only if the shape contains text. Use the controls in this
panel to adjust the amount of space along the sides of the text.

The Web tab

If you plan to save your worksheet as a Web page, you can specify some alternative
text for the object in this tab. The alternative text appears when the user hovers

the mouse pointer over the image in a Web browser.
#

The Web tab is a new feature of Excel 2000.

Changing the Stack Order of Objects

As vou add drawing objects to the draw layver of a worksheet, your'll find that
objects are “stacked” on top of each other in the order in which you add them.
New objects are stacked on top of older objects. Figure 14-10 shows an example
of drawing objects stacked on top of one another.
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Figure 14-10: These drawing objects are stacked
on top of one another.

If you find that an object is obscuring part of another, you can change the order in
this stack. Right-click the object and select Order from the shortcut menu. This
leads to a submenu with the following choices:

» Bring to Front: Brings the object to the top of the stack.
* Send to Back: Sends the object to the bottom of the stack.

» Bring Forward: Brings the object one step higher toward the top of the stack.

« Send Backward: Sends the object one step lower toward the bottom of the
stack.

Ll L
Grouping Objects
Excel enables you to combine two or more drawing objects into a single object,
which is known as grouping. For example, if you create a design that uses four
separate drawing objects, you can combine them into a group. Then, you can
manipulate this group as a single object (move it, resize it, and so on).

To group two or more objects, select all the objects and then right-click. Choose
Grouping« Group from the shortcut menu.

Later, if you need to modify one of the objects in the group, you can ungroup them

by right-clicking and selecting Grouping « Ungroup from the shortcut menu. This
breaks the object into its original components.
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Aligning Objects
When you have several drawing objects on a worksheet, vou may want to align

these objects with each other. You can either drag the objects (which isn’t very
precise) or use the automatic alignment options.

Figure 14-11 shows objects before and after they were aligned to the left.

Figure 14-11:
aligned. Those on the right are aligned to the left.

To align objects, start by selecting them. Then, click the Draw tool on the Drawing
toolbar. This tool expands to show a menu. Select the Align or Distribute menu
option, followed by any of the six alignment options: Align Left, Align Center, Align
Right, Align Top, Align Middle, or Align Bottom.

Unfortunately, you can't specify which object is used as the basis for the align-
ment. When you're aligning objects to the left, they are always aligned with the
leftmost object. When you're aligning objects to the tap, they are always aligned
with the topmost object. Alignment in other directions works the same way.

Spacing Objects Evenly

Excel can also “distribute” three or more objects such that they are equally spaced,
horizontally or vertically. Select the objects and then click the Draw tool on the
Drawing toolbar. This tool expands to show a menu. Select the Align or Distribute
menu option, followed by either Distribute Horizontally or Distribute Vertically.
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Changing the AutoShape Defaults

You can change the default settings for the AutoShapes that you draw. For example,
if you prefer a particular text color or fill color, you can set these as the defaults for
all new AutoShapes that you draw.

To change the default settings, create an object and format it as you like. You can
change colors, fill effects, line widths and styles, and shadow or 3D effects. Then,
select the formatted object, right-click, and select Set AutoShape Defaults from the
shortcut menu. You can also access this command from the Draw tool on the
Drawing toolbar (this tool expands to show a menu).

Adding Shadows and 3D Effects

You can apply attractive shadow and 3D effects to AutoShapes (except for those in
the Line and Connectors categories). Use the Shadow and 3D tools on the Drawing
toolbar to apply these effects.

Shadows and 3D effects are mutually exclusive. In other words, you can apply
either a shadow or a 3D effect to an AutoShape —not both.

To apply either of these effects, select an AutoShape that you've drawn on a
worksheet and then click either the Shadow or the 3D tool. The tool expands to
show a list of options (see Figure 14-12). Select an option, and it’s applied to the
selected shape.

Figure 14-12: Clicking the Shadow tool displays a list of shadow options.
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You can adjust the Shadow or 3D settings by clicking the appropriate tool and then
selecting the Shadow Settings or 3D Settings option. Both of these options display a
toolbar that enables you to fine-tune the effect. You'll find that loss of options are
available, and they're all quite straightforward. The best way to become familiar
with these effects is to experiment.

Using WordArt

WordArt is an application that’s included with Microsoft Office. You can insert a
WordArt image either by using the WordArt tool on the Drawing toolbar or by
selecting Insert» Picture« WordArt. Either method displays the WordArt Gallery
dialog box (see Figure 14-13). Select a style and then enter your text in the next
dialog box. Click OK, and the image is inserted in the worksheet.

Worddat Gallery

i

I Hiid ik A I 1
Figure 14-13: The WordArt Gallery dialog box
enables you to select a general style far your image.

When you select a WordArt image, Excel displays the WordArt toolbar. Use these
tools to modify the WordArt image. You'll find that you have lots of flexibility with
these tools. In addition, you can use the Shadow and 3D tools to further manipulate
the image. Figure 14-14 shows an example of a WordArt image inserted on a
worksheet.
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Drawing Tips

Although drawing objects is quite intuitive, several tips can make this task easier.
This section lists some tips and techniques that you should know:

* To create an object with the same height and width, press Shift while you
draw the object.

» To constrain a line or arrow object to angles that are divisible by 15 degrees,
press Shift while you draw the object.

» To make an object snap to the worksheet row and column gridlines, press the
Alt key while you draw the object.

« [If you press Alt while moving an object, its upper-left corner snaps to the row
and column gridlines.

« To select multiple objects, press Ctrl while you click them. Or, use the Select
Objects tool on the Drawing toolbar to select objects by “lassoing” them.

» To select all objects on a worksheet, select Edits Go To (or press F5) and
then click the Special button in the Go To dialog box. Choose the Objects
option button and click OK. All objects are selected. Use this technique if you
want to delete all objects (select them all and then press Delete).

« You can insert text into most of the AutoShapes (the exceptions are the
shapes in the Connectors and Lines categories). To add text to a shape, right-
click it and select Add Text from the shortcut menu.

* You might find that working with drawing objects is easier if you turn off the
worksheet grid line. The snap-to-gridline features work, even if the grid lines
aren’t visible.
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* You can control how objects appear onscreen by using the View tab of the
Options dialog box. Narmally, the Shaw All option is selected. You can hide all
objects by choosing Hide All, or display objects as placeholders by choosing
Show Placeholders (this may speed up things if you have complex objects
that take a long time to redraw).

» To copy an object with the mouse, single-click it to select it and then press
Ctrl while vou drag it.

= If an object contains text, you can rotate the text 90 degrees by using the
Alignment tab on the Format Object dialog box.

» By default, drawn objects are printed along with the worksheet. If you don’t
want the objects to print, access the Sheet panel of the Page Setup dialog box
and select the Draft option. Or, right-click the object, select Format from the
shorteut menu, and then uncheck the Print Object check box in the Properties
panel.

* If you want the underlying cell contents to show through a drawn object,
access the Colors and Lines tab in the Format dialog box and then set the Fill
option to No Fill. You can also select the Semitransparent option, which
enables you to choose a fill color and have the cell contents show.

= If vou save your file as a Web page, each drawn object is stored as a separate
GIF file.

A Gallery of Drawing Examples

This section provides you with some examples of using Excel’s drawing tools.
Perhaps these examples will get your own creative juices flowing.

Calling Attention to a Cell

The AutoShapes in the Stars and Banners category are useful for calling attention to
a particular cell or range to make it stand out from the others. Figure 14-15 shows
twao examples (one subtle, one more flamboyant) of how you can make one cell’s
value jump out.

Creating Shapes with Shadow and 3D Effects

Figure 14-16 shows a sample of several objects that have various shadow and 3D
effects applied. As you can see, the effects can be quite varied.
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Figure 14-15: Two ways of making a particular
cell stand out.

XYZ Corporarion
Annval Reponrt

Figure 14-16: These objects use shadow or 3D effects.
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Creating Organizational Charts

Figure 14-17 shows a simple organizational chart that was created with the
AutoShape drawing tools. The shapes in the Connectors and Flowchart categories
were used and then 3D effects were added. To make the box size consistent, one
box was created and then copied several times.

i bl sheer s JERERIETT R R0 da01
Figure 14-17: This organizational chart was created with
Excel's drawing tools.

You can also create an organizational chart by selecting Insert+ Pictures
Organization Chart. This starts the Microsoft Organization Chart application that
inserts an OLE object into the worksheet.

Changing the Look of Cell Comments

If a cell contains a cell comment, you can replace the normal comment box with any
of the AutoShapes in the Callouts category. Select the cell comment and then click
the Draw tool on the Drawing toolbar. This tool expands to show a menu. Select
Change AutoShape+« Callouts, followed by the desired callout shape. Figure 14-18
shows an example of cell comments that use different AutoShapes.
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Figure 14-18: These cell comments use different

AutoShapes.

Linking Text in an Object to a Cell

As an alternative to typing text directly into an object, consider creating a link to a
cell. After doing so, the text displayed in the object reflects the current contents of
the linked cell. Figure 14-19 shows an AutoShape that is linked to a cell. The shape
is selected; notice that the edit line displays a formula.

e Yiekd ¥iala FOrROio

f &l New Car Loans B 90% ° F|AIA 1 5%
Used Car Loans 8.25% 15 AES 3./5%
| I Real Estate Loans A 9% - IITET B MM%
13.00% 182500 25.U0%
4 F0% 500000 23noc 1010%
$5,000 000  §482 281 (00.U0%

{Total Yiele: 9.25%]

Auta nEne 1500 %

Figure 14-19: The text in the AutoShape is linked to cell D12.
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To link an AutoShape to a cell, select the object and then click in the edit line. Enter
a simple cell reference, such as =Al, and press Enter. You can format the text in the
shape independent of the format of the cell. For best results, access the shape’s
Format dialog box and change the following settings:

« Automatic margins (Margins tab)
» Automatic size (Alignment tab)

« Center Horizontal alignment and Center Vertical alignment (Alignment tab)

Creating Flow Diagrams

You also can create flow diagrams by using the drawing tools. The shapes in the
Connectors and Flowchart categories are most useful. This capability often is
useful to describe how a process or system works. Figure 14-20 shows an example
of a flow diagram. After creating the diagram, all the objects were selected and
grouped together so that the diagram could be moved as a single unit.

B Sheet1 i

Figure 14-20: This flow diagram was created with Excel’s
drawing tools.
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Annotating a Chart

One of the most common uses of the drawing tools is to annotate a chart, For
example, you can add descriptive text with an arrow, to call attention to a certain
data point. This technique works for both embedded charts and charts on chart
sheets. Figure 14-21 shows an example of an embedded chart that has been
annotated.

Incoming Phone Calls for September

Figure 14-21: Annotating a chart with the drawing tools.

Pasting Pictures of Cells

One of Excel’s best-kept secrets is its ability to copy and paste pictures of cells. You
can copy a cell or range and then paste a picture of the cell or range on any work-
sheet. The picture can be static or linked. With a linked picture, the link is to the
cells. In other words, if you change the contents of a cell that’s in a picture, the
picture changes.

To create a picture of a cell or range, select a range and choose Edit+ Copy. Then
press Shift and click the Edit menu (pressing Shift is essential). Choose Paste
Picture to create a static picture, or choose Paste Picture Link to paste a linked
picture of the selection.

If you don’t hold down Shift when you select the Edit menu, the Paste Picture and
Paste Picture Link commands do not appear.

Figure 14-22 shows an example of a linked picture, with some additional formatting

to the picture object (fill color and a shadow). Notice that the picture displays a cell
reference in the formula bar.
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Figure 14-22: This picture is linked to the cells in EG:F17.

Using linked pictures is particularly useful for printing noncontiguous ranges.
See “Printing Noncontiguous Ranges on a Single Page” in Chapter 12 for more
information.

Summary

This chapter covers several types of graphic information that you can add to a
worksheet’s draw layer: imported graphic images, objects that you draw by using
Excel’s drawing tools, and other objects, such as WordArt or an OLE object, from
Microsoft’s Organization Chart application. Several examples demonstrate some
ways that you can use these objects in vour workbooks.

& AURGERINIES  ANSENRINERS
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Putting It All
Together

I he preceding chapters present basic information about
how Excel works. But you probably already realize that
simply knowing the commands and shortcuts won't help you
create successful workbooks. This chapter helps you to tie
everything together, and provides some pointers and
examples to help you develop workbooks that do what vou
want them to do.

The Audience for Spreadsheets

Before you get too far into this chapter, pause and think about
spreadsheets in general. Spreadsheets can be classified in
many ways, but the following two broad categories provide a
useful place to start:

» Spreadsheets that you develop for your own use

« Spreadsheets that others will use

As you'll see, the way in which vou develop vour

spreadsheet — and the amount of time and effort that you put
into it— often depends on who is the ultimate user (vou alone
or others).

Developing Spreadsheets for Yourself

If vou're the only person who will use a particular
spreadsheet, you should be less concerned with issues such
as security, ease of use, and error handling than you would be
if you were creating the spreadsheet for others. After all, you
develop the spreadsheet and thus know how it is designed. If
an error occurs, you can simply track down the source and
correct the problem.
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Quick-and-dirty spreadsheets

Chances are good that many of the spreadsheets you develop for your own use are
“quick-and-dirty” — usually fairly small and developed to solve a problem or answer
a question quickly. For example, you're about to buy a new car and want to figure
out your monthly payment for various loan amounts. Or, you need to generate a
chart that shows your company’s monthly sales, so vou quickly enter 12 values,
whip off a chart, and paste it into your word processing document.

In these examples, you don’t really care what the spreadsheet looks like, as long as
it gives you the correct answer (or in the case of the second example, produces a
nice-looking chart). You can probably input the entire model in a few minutes, and
you certainly won't take the time to document your work. In many cases, you won't
even bother to save the file.

For-your-eyes-only spreadsheets

As the name implies, this category includes spreadsheets created by you that no
one else will ever see or use. One example is a file in which you keep information
that is relevant to your income taxes. You open the file whenever a check comes in
the mail, you incur an expense that can be justified as business-related, you buy tax-
deductible Girl Scout cookies, and so on. Another example is a spreadsheet that you
use to keep track of your employees’ time records (sick leave, vacation, and such).

Spreadsheets that are for your eyes only differ from the quick-and-dirty ones in that
you use themn more than once; therefore, you save these spreadsheets to files.
Again, though, these are spreadsheets that are not worth spending a great deal of
time on —you may apply some simple formatting, but that’s about it (after all, you
don’t really need to impress yourself — or do you?). Like the quick-and-dirty kind,
this type of spreadsheet lacks any type of error detection, because you already
understand how the formulas are set up and, thus, know enough to avoid inputting
data that produces erroneous results. [f an error does crop up, you probably
immediately know what caused it.

Spreadsheets in this category sometimes increase in sophistication over time. For
example, [ have an Excel workbook that [ use to track my income by source. This
workbook was simple when [ first set it up, but [ tend to add accoutrements to it
nearly every time [ use it: more summary formulas, hetter formatting, and even a
chart that displays income by month. My latest modification was to add a trend line
to the chart to project income based on past trends.

Developing Spreadsheets for Others

If others will use a spreadsheet that you are developing, you need to pay a lot more
attention to minor details. Because of this, such a spreadsheet usually takes longer
to create than one that only you will see. The amount of extra effort depends, in
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One common type of spreadsheet is a budgef spreadsheet, which typically has
months along the top and budget categories along the left. Each intersecting cell
contains a projected expense —for example, telephone expenses for June. Budgets
use SUM formulas {and maybe SUBTOTAL formulas) to calculate annual totals and
totals for each category. Excel’s multisheet feature enables you to store on separate
sheets the budgets for different departments or divisions.

Budget categories often are arranged hierarchically. For example, you could have a
category called Personnel that consists of subcategories such as Salary, Benefits,
Bonus, and so on (see Figure 15-1). In such a case, you could create additional
formulas to calculate category totals.

0 Excel's outlining feature is ideal for creating formulas to calculate category totals,
which is the topic of Chapter 18.

|74 Outlined Budgetxls

IE U : —

Mzrkeling N ]
Salaries | 35,000] 35,000 105,000
Berefits ; 7,350 7,350 22 050
Barus a a 0 a
Total Persannel 42,350 42,350 127,050
_iOffice 22800 22500 5750
| Carmputar 900 aac 2,700
Total Supplies 3,150 3,150 9450
Transportation 3,000 3000 9,000
Hotsl 1,050 1050 3,150
eals 500 500 1,500
Total Travel 4,550 4,550 13,650 10,150
Computers 4,500 45000 13,500 4,500
Copiers 1,100 1,100 3,300 1,100
Cther 350 950 2,850 980
Total Equipment 6,550 6,950 19,650 6,350
Lease 2,000 2,000 2,500
Utilities 450 450 450
Taues 540 940 540
Cther 1200 1.200 1.200] 1,200
Telephone 875 875 875 375
Postage 250 250 250 250
Taotal Facility 5,315 5,315 5,315 5,815
Total Marketing [k BB BT HTH LR NI
Dpsrations |
| |Salaties 210,000] 210,000 0oo| 630,000] 216,000

| |Bersfits i :
hOutlined Budget. &

2

Figure 15-1: This budget worksheet uses formulas to calculate subtotals
within each category.
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Figure 15-2: Excel makes working with lists of data easy.

Turnkey Applications

A turnkey application refers to a spreadsheet solution that is programmed to work
as a standalone application. Such an application always requires macros, and may
involve creating custom menus and custom toolbars.

These applications are large-scale projects that are designed to be used by many
peaple or for a long time. They often interact with other systems (such as a
corporate database) and must be very stable. Although this book touches on some
elements of developing such applications, they are beyond this book’s scope.

Steps in Creating a Spreadsheet

This section discusses the basic steps that you may follow to create a spreadsheet.
This discussion assumes that you're creating a workbook that others may use, so
you may skip some of these steps if the spreadsheet is for vou only. These steps are
for relatively simple spreadsheets —those that don’t use macros, custom toolbars,
or other advanced features. And, of course, these are only basic guidelines.
Everyone eventually develops his or her own style, and vou may find a method that
works better for you. The basic steps are as follows:

1. Think about what vou want to accomplish.

2. Consider the audience.
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these people. Answering the following questions often prevents having to make
changes later:

» How experienced are the users? Can they perform basic operations, such as
copying, inserting rows, and so on? Don’t assume that everyone knows as
much as you do.

» What software will they be using? For example, if vou develop your
spreadsheet by using Excel 2000, you need to be aware that it can’t be loaded
into Excel 95 or earlier versions unless you first save the file in the older
format. Users with older versions won'’t be able to take advantage of the
newer features.

» What hardware will they be using? If your spreadsheet takes 3 minutes to
calculate on your Pentium-based system, it may well take 20 minutes on a
slower 486 system. Alsa, be aware of different video modes. If you develop
your spreadsheet by using a 1024 X 768 video mode, users with an 800 X 600
or 640 X 480 display will have a much smaller viewing area.

* Do you want to allow changes? Often, you want to make sure that your
formulas don’t get modified. If so, you'll need to perform some basic
protection (see “Applying Appropriate Protection,” later in this chapter).

Designing the Workbook Layout

An important consideration is how you want to lay out the workbook. Before the
days of multisheet workbooks, this was a lot more difficult than it is today. When
your file has only a single worksheet, you have to plan it carefully to ensure that
making a change doesn’t affect something else.

Spreadsheets often consist of distinct blocks of information. In the old days,
spreadsheet designers often used a layout like the one shown in Figure 15-3. This
example is for a spreadsheet that has three main blocks: an input area, a calculation
area, and a report area. This offset block layout minimizes the possibility of damage.
For example, deleting a column or changing its width affects only one area. lf the
areas were laid out vertically, this would not be the case.

Because Excel uses multiple worksheets in a file, howewer, this type of layout is
rarely necessary. Using a separate worksheet for each block is much easier and
more efficient. An added advantage is that you can access the various blocks
simply by clicking the tab (which can be named appropriately).
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« Statistical analysis

* Pivot tables

» Scenario management

« Solver

» Mapping

= Interaction with other applications

» Custom menus or toolbars (which require macros)

- Ll Ll
Applying Appropriate Formatting
Many people prefer to format their work as they go along. If that's not vour style,
this step must be performed before you unleash your efforts to the end-users. As |
mentioned in Chapter 11, almost all worksheets benefit from some stylistic
formatting. At the very least, you need to adjust the number formats so that the
values appear correctly. If the worksheet will be used by others, make sure that any
color combinations you use will be visible for those running on a monochrome
system (such as a notebook computer).

Of all the basic steps in creating a spreadsheet, formatting is the one with the most
variety. Although beauty may be in the eye of the beholder, there are some
guidelines that you might want to consider:

» Preformat all numeric cells. Use number formats that are appropriate for the
numbers and make sure that the columns are wide enough to handle the
maximum values. For example, if a cell is desighed to hold an interest rate,
format it with a percent sign. And if you create an amortization schedule,
make sure that the columns are wide enough to handle large amounts.

* Use only basic fonts. If others will be using your workbook, stick to the basic
TrueType fonts that come with Windows. Otherwise, the fonts may not
translate well, and the user may see a string of asterisks rather than a value.

» Don'’t go overboard with fonts. As a rule of thumb, never use more than two
different typefaces in a single workbook. Usually, one works just fine (Arial is a
good choice). If you use different font sizes, do so sparingly.

» Be careful with color. Colored text or cell backgrounds can make your
workbook much easier to use. For example, if you use a lookup table, you can
use color to clarify where the table’s boundaries are. Or, you may want to
color-code the cells that will accept user input. Overuse of colors makes your
spreadsheet look gaudy and unprofessional, however. Also, make sure that
color combinations will work if the workbook is opened on a monochrome
notebook computer.
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Applying Appropriate Protection

A spreadsheet can be quite fragile. Deleting a single formula often has a ripple effect
and causes other formulas to produce an error value or, even worse, incorrect
results. I've seen cases in which an inexperienced user deleted a critical formula,
panicked, and cemented the mistake by saving the file and reopening it —only to
discover, of course, that the original (good) version had been overwritten.

You can circumvent such problems by using the protection features built into Excel.
The following are the two general types of protection:
« Sheet protection

* Workbook protection

Protecting Sheets

The Tools* Protection+ Protect Sheet command displays the dialog box shown in
Figure 15-4.

Protect Sheet

i
|
E
I
i
[
|

I HICHIE TR [ IR
Figure 15-4: The Protect
Sheet dialog box.

This dialog box has three check boxes:

» Contents: Cells that have their Locked property turned on can’t be changed.

* Objects: Drawing objects (including embedded charts) that have their Locked
property turned an can’t be selected.

* Scenarios: Defined scenarios that have their Prevent Changes property turned
on can’t be changed (see Chapter 26 for a discussion of scenario
management).

You may provide a password in the Protect Sheet dialog box. lf you enter a

password, the password must be reentered before the sheet can be unprotected. If
you don’t supply a password, anyone can unprotect the sheet.
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today may be completely meaningless when you need to change it in six months.
The following sections provide some general tips on documenting your
spreadsheets.

Use the Properties Dialog Box

The File = Properties command displays the Properties dialog box (the Summary
tab is shown in Figure 15-6). You may want to take a few minutes to fill in the
missing information and enter some comments in the Comments box.

Use Cell Comments

As you know, you can document individual cells by using the Insert+ Comment
command. The comment appears when yvou move the mouse pointer over the cell.
If you don’t like the idea of seeing the cell comments appear, adjust this setting in
the View tab of the Options dialog box. Unfortunately, this setting applies to all
workbooks, so if you turn off the note indicator for one workbook, you turn it off for
all of them.

Use a Separate Worksheet

Perhaps the best way to document a workbook is to insert a new worksheet and
store your comments there. Some people also like to keep a running tally of any
modifications that they make. You can hide the worksheet so that others can’t see it.

Outlined Budget. xls Propeities

Figure 15-6: The Summary tab of the
Properties dialog box.
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For example, a formula may return an error value when a certain cell that it uses
contains a zero. Normally, you can isolate the problem and correct the formula, so
that the error doesn’t appear anymore (this is an example of an easily corrected
error). A potentially disastrous error is when you open a worksheet and Excel
reports that it can’t read the file. Figure 15-7 shows the message that you get.
Unless you made a recent backup, vou could be in deep trouble. Unfortunately, this
type of error (a corrupted file) occurs more often than you might think.

Micrasaft Excel 4 Figure 15-7: When you see an error message like this, you
better have a recent backup available.

Good testing helps you to avoid problems with your formulas. Making
modifications to your work, however, may result in a formula that no longer works.
For example, you may add a new column to the worksheet, and the formulas don’t
pick up the expanded cell retference. This is an example of when using names could
eliminate the need to adjust the formulas.

You will encounter cases in which a formula just doesn’t work as it should. When
this happens, try to isolate the problem as simply as possible. ['ve found that a
good way to deal with such formulas is to create anew workbook with a very
simplified example of what I'm trying to accomplish. Sometimes, looking at the
problem in a different context can shed new light on it.

The only way to prevent disasters—such as a corrupt file —is to develop good
backup habits. If a file is important, vou should never have only one copy of it. You
should get in the habit of making a daily backup on a different storage medium.

Where to Go from Here

This chapter concludes Part IL. If you're following the book in sequential-chapter
order, you now have enough knowledge to put Excel to good use.

Excel has many more features that may interest vou, however, which are covered in
the remaining chapters. Even if you're satisfied with what you already know about
Excel, [ strongly suggest that vou at least browse through the remaining chapters.
You may see something that can save yvou hours.
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Advanced
Charting

‘ hapter 13 introduces charting. This chapter takes the

topic to the next level. You learn how to customize your
charts to the maximum, so that they look exactly as you want.
I also share some slick charting tricks that I've picked up over
the vears.

Chart Customization: An Overview

Often, the basic chart that Excel creates is sufficient for your
needs. If you're using a chart to get a quick visual impression
of your data, a chart that’s based on one of the standard chart
types usually does just fine. But, if you want to create the
most effective chart possible, you probably want to take
advantage of the additional customization techniques
available in Excel.

Customizing a chart involves changing its appearance, as well
as possibly adding new elements to it. These changes can be
purely cosmetic (such as changing colors or modifying line
widths) or quite substantial (such as changing the axis scales
or rotating a 3D chart). New elements that you might add
include features such as a data table, a trendline, or error bars.

Before you can customize a chart, you must activate it on a
chart sheet, by clicking its sheet tab. To activate an embed-
ded chart, click the chart’s border. To deactivate an embed-
ded chart, just click anywhere in the worksheet.

In some cases, you may prefer to work with an embedded
chart in a separate window. For example, if the embedded
chart is larger than the workbook window;, working with it
in its own window is much easier. To display an embedded
chart in a window, right-click the chart’s border and select
Chart Window from the shortcut menu.
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You select a chart element by clicking it. The name of the selected item appears in
the Name box. When a chart is activated, you can’t access the Name box; it’s simply
a convenient place for Excel to display the chart element’s name.

The Chart toolbar, which is displayed when you select a chart, contains a tool
called Chart Objects (see Figure 16-1). This is a drop-down list of all the named
elements in a chart. Rather than selecting a chart element by clicking it, you can
use this list to select the chart element that you want to work with.

Value fyds
Value sxis Major Gridines |
Serigs 1

Figure 16-1: The Chart Objects tool in the
Chart toolbar provides another way to select
a chart element.

Yet another way to select a chart element is to use the keyboard. When a chart is
activated, press the up arrow or down arrow to cycle through all parts in the chart.
When a data series is selected, press the right arrow or left arrow to select individ-
ual points in the series.

Table 16-1 lists the various elements of a chart (not all of these parts appear in
every chart). You might want to create a chart and practice selecting some of these
parts — or use the Chart Objects tool in the Chart toolbar to examine the element
names.

Using the Format Dialog Box

When a chart element is selected, you can access the element’s Format dialog box
to format or set options for the element. Each chart element has a unique Format
dialog box. You can access this dialog box by using any of the following methods:

* Select the Format+ Selected Part Name command (the Format menu displays
the actual name of the selected part)

» Double-click a chart part

» Select the chart element and press Ctrl+1

» Right-click the chart element and choose the Format command from the
shortcut menu
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Part Description

Data Table The chart's data table.
Dropline A dropline that extends from the data point downward to
the axis.

Floor The floor of a 3D chart.

Legend Key One of the keys inside of a legend.

Plat Area The ché‘r‘t's Plot Area — the actual chart, without the”légend.

Series Axis The axis that represents the chart’s series (3D charts only).

Trendline A trendline for a data series.

Value Axis Title The title for the value axis.

Walls The walls of a 3D chart only (except 3D pie charts).

Chart Background Elements

As mentioned in the preceding section, a chart consists of many elements. This
section discusses two of those elements: the Chart Area and the Plot Area. These
chart items provide a background for other elements in the chart.
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When you select a chart element, you'll find that many of the toolbar buttons that
you normally use for worksheet formatting also work with the selected chart ele-
ment. For example, if you select the chart’s Plot Area, you can change its color by
using the Fill Coler tool on the Formatting toolbar. If you select an element that
contains text, you can use the Font Color tool to change the color of the text

Working with Chart Titles

A chart can have as many as five different titles:

= Chart title

» Category (X) axis title

* Value (Y) axis title

» Second category (X) axis title
» Second value (Y) axis title

The number of titles that you can use depends on the chart type. For example, a pie
chart supports only a chart title, because it has no axes.

To add titles to a chart, activate the chart and use the Chart+ Options command.
Excel displays the Chart Options dialog box. Click the Titles tab and enter text for
the title or titles (see Figure 16-3).

The titles that Excel adds are placed in the appropriate position, but you can drag

Figure 16-3: The Titles tab of the Chart Options dialog
box lets you add titles to a chart.
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If vou didn't include legend text when you originally selected the cells to create the
chart, Excel displays Series [, Series 2, and so on in the legend. To add series
names, choose Charts Source Data and then select the Series tab in the Source
Data dialog box (refer to Figure 16-4). Select a series from the Series list box,
activate the Name box, and then either specify a cell reference that contains the
label or directly enter the series name.

Data dialog box to change the name of a data series.

Changing Gridlines

Gridlines can help you to determine what the chart series represents numerically.
Gridlines simply extend the tick marks on the axes. Some charts look better with
gridlines; others appear more cluttered. You can decide whether gridlines can
enhance your chart. Sometimes, horizontal gridlines alone are enough, although XY
charts often benefit from both horizontal and vertical gridlines.

To add or remowve gridlines, choose Chart+ Options and then select the Gridlines
tab. This Chart Options dialog box is shown in Figure 16-5.
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« Font: Adjust the font used for the axis labels
+ Number: Adjust the number format for the axis labels

» Alignment: Specify the orientation for the axis labels

Because the axes’ properties can dramatically affect the chart’s look, the Patterns
and Scale dialog box tabs are discussed separately, in the following sections.

Axes Patterns

Figure 16-6 shows the Patterns tab of the Format Axis dialog box.

Automatic

Figure 16-6: The Patterns tab of the Format Axis
dialog box.

This tab has four sections:

« Axis: Controls the line characteristics of the axis (the style, color, and weight
of the line).

« Major tick mark type: Controls how the major tick marks appear. You can
select None (no tick marks), Inside (inside the axis), Outside (outside the
axis), or Cross (on both sides of the axis).

* Minor tick mark type: Controls how the minor tick marks appear. You can
select None (no tick marks), Inside (inside the axis), Outside (outside the
axis), or Cross (on both sides of the axis).
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If vou're preparing several charts that use similarly scaled data, keeping the scales
the same is a good idea, so that the charts can be compared more easily. The charts
in Figure 16-8 show the distribution of responses for a survey. Because the same
scale was not used on the value axes, however, comparing the responses across
survey items is difficult. All charts in the series should have the same scale.

Question 1
Slrang Agree
Agraa
Undecided
Disagraae

Stranglv Disagree §

Question 2
Strong Agree
Agree
Undlecided §
Disagree

SBtrongly Disagree |

FilEhoheet2 (B e TR &L&ﬂ&%
Figure 16-8: These charts use different scales on the value axis,
making a compatrison between the two difficult.

Excel automatically determines the scale for your charts. You can, however, override
Excel’s choice in the Scale tab of the Format Axis dialog box (see Figure 16-9).

The Scale tab varies slightly, depending on which axis is selected.
" This dialog box offers the following options:

* Minimum: Enter a minimum value for the axis. If the check box is checked,
Excel determines this value automatically.

« Maximum: Enter a maximum value for the axis. If the check box is checked,
Excel determines this value automatically.
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Working with Data Series

Every chart consists of one or more data series. Each series is based on data that is
stored in a worksheet. This data translates into chart columns, lines, pie slices, and
so on. This section discusses most of the customizations that you can perform with
a chart’s data series.

To work with a data series, you must first select it. Activate the chart and then click
the data series that you want to select. In a column chart, click a column; in a line
chart, click a line; and so on. Make sure that you select the entire series and not
just a single point. You may find it easier to select the series by using the Chart
Object tool in the Chart toolbar.

When you select a data series, Excel displays the series name in the Name box (for
example, Series 1, or the actual name of the series), and the SERIES formula in the
formula bar. A selected data series has a small square on each element of the series.
In addition, the cells used for the selected series are outlined in color.

Many customizations that vou perform with a data series use the Format Data
Series dialog box, which has as many as seven tabs. The number of tabs varies,
depending on the type of chart. For example, a pie chart has four tabs, and a 3D
column chart has four tabs. Line and column charts have six tabs, and XY (scatter)
charts have seven tabs. The possible tabs in the Format Data Series dialog box are
as follows:

» Axis: Specify which value axis to use for the selected data series. This is
applicable only if the chart has two value axes.

* Data Labels: Display labels next to each data point.

« Options: Change options specific to the chart type.

» Patterns: Change the color, pattern, and border style for the data series. For
line charts, change the color and style of the data marker in this tab.

» Series Order: Specify the order in which the data series are plotted.
* Shape: Specify the shape of the columns (in 3D column charts only).

* X Error Bars: Add or modify error bars for the X axis. This is available only
for XY charts.

= ¥ Error Bars: Add or modify error bars for the Y axis.

The sections that follow discuss many of these dialog box options.
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« Select the range to add and copy it to the Clipboard. Then, activate the chart
and choose Edit+ Paste Special. Excel responds with the dialog box shown in
Figure 16-11. Complete this dialog box to correspond to the data that you
selected (or just use Edit+ Paste and let Excel determine how the data fits
into the chart).

» Select the range to add and drag it into the chart. When you release the
mouse button, Excel updates the chart with the data that you dragged in. This
technique works only if the chart is embedded on the worksheet.

L |
Figure 16-11: Using the Paste Special
dialog box is one way to add new data
to a chart.

Changing Data Used by a Series

Often, vou create a chart that uses a particular range of data, and then you extend
the range by adding new data points in the worksheet. For example, the previous
month’s sales data arrives in vour office, and you enter the numbers into your
sales-tracking worksheet. Or, you may delete some of the data points in a range that
is plotted; for example, you may not need to plot older information. In either case,
vou'll find that the chart doesn’t update itself automatically. When you add new
data to a range, it isn’t included in the data series. If you delete data from a range,
the chart displays the deleted data as zero values.

You can create a chart that updates automatically when you add new data to your
worksheet. See “Chart-Making Tricks,” later in this chapter.

The following sections describe a few different ways to change the range used by a
data series.

Dragging the Range Outline

The easiest way to change the data range for a data series is to drag the range
outline. This technique works only for embedded charts. When you select a series,
Excel outlines the data range used by that series. You can drag the small dot in the
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Figure 16-13: When you select a data series, its SERIES formula appears in the
formula bar.

A SERIES formula consists of a SERIES function with four arguments. The syntax is
as follows:

=SERIES(Name_ref,Categories,Values,Plot_order)

Excel uses absolute cell references in the SERIES function. To change the data that a
series uses, edit the cell references (third argument) in the formula bar. The first
and second arguments are optional and may not appear in the SERIES formula. If
the series doesn’t have a name, the Name_ref argument is missing and Excel uses
dummy series names in the legend (Seriesl, SeriesZ, and so on). If no category
names exist, the Categories argument is missing, and Excel uses dummy lakels (1, 2,
3, and so on).

if the data series uses category labels, make sure that you adjust the reference for
the category labels also. This is the second argument in the SERIES formula.

Using Names in SERIES Formulas

Perhaps the best way to handle data ranges that change over time is to use named
ranges. Create names for the data ranges that you use in the chart and then edit the
SERIES formula. Replace each range reference with the corresponding range name.
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Figure 16-15: The Data Labels tab of the Chart Options
dialog box.

The data labels are linked to the worksheet, so if your data changes, the labels also
change. If you want to override the data label with other text, select the label and
enter the new text (or even a cell reference) in the formula bar.

Often, vou'll find that the data labels aren’t positioned properly —for example, a
label may be obscured by another data point. If you select an individual label, you
can drag the label to a better location.

After you add data labels to a series, format the labels by using the Format Data
Aié Labels dialog box.

As you work with data labels, you may discover that Excel’s Data Labels feature
leaves a bit to be desired. For example, it would be nice to be able to specify a
range of text to be used for the data labels. This would be particularly useful in XY
charts in which you want to identify each data point with a particular text item.
Unfortunately, this isn't possible. You can add data labels and then manually edit
each label — or, you can use the Chart Data Labeler utility that’s included with my
Power Utility Pak (use the coupon in the back of the book to get your copy).

Handling Missing Data

Sometimes, data that you're charting may be missing one or more data points.
Excel offers several ways to handle the missing data. You don’t control this in the
Format Data Series dialog box (as you might expect). Rather, you must select the
chart, choose Tools+ Options, and then click the Chart tab, which is shown in
Figure 16-16. The reason for putting this setting in the Options dialog box is known
only to the Excel design team.
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The Plot visible cells only setting applies only to the active chart. A chart must be
activated when you open the Options dialog box. Otherwise, the option is grayed.
This is another example of a setting that shows up in an unexpected dialog box.

Adding Error Bars

For certain chart types, vou can add error bars to your chart. Error bars often are
used to indicate “plus or minus” information that reflects uncertainty in the data.
Error bars are appropriate only for area, bar, column, line, and XY charts. Click the
Y Error Bars tab in the Format Data Series dialog box to display the options shown
in Figure 16-17.

Format Data Series

ELi

s e e 1 FLElE

Figure 16-17: The Y Error Bars tab of the Format Data
Series dialog box.

A data series in an XY chart can have error bars far both the X values and Yvalues.
Excel enables you to specify several types of error bars:

« Fixed value: The error bars are fixed by an amount that vou specify.

* Percentage: The error bars are a percentage of each value.

« Standard deviation(s): The error bars are in the number of standard-deviation
units that you specify (Excel calculates the standard deviation of the data
series).

« Standard error: The error bars are one standard error unit (Excel calculates
the standard error of the data series).
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Figure 16-19: The Add Trendline dialog box offers
several types of automatic trendlines.

The type of trendline that you choose depends on your data. Linear trends are most
common, but some data can be described more effectively with another type. One
of the options on the Type tab is Moving average, which is useful for smoothing out
“noisy” data. The Moving average option enables you to specify the number of data
points to include in each average. For example, if you select 5, Excel averages every
five data points.

When you click the Options tab in the Add Trendline dialog box, Excel displays the
options shown in Figure 16-20.

The Options tab enables you to specify a name to appear in the legend and the
number of periods that vou want to forecast. Additional options let you set the
intercept value, specify that the equation used for the trendline should appear on
the chart, and choose whether the R-squared value appears on the chart.

Figure 16-21 shows two charts. The chart on the left depicts a data series without a

trendline. The chart on the right is the same chart, but a linear trendline has been
added that shows the trend in the data.
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Creating Combination Charts

A combination chart is a single chart that consists of series that use different chart
types. For example, vou may have a chart that shows both columns and lines. A
combination chart also can use a single type (all columns, for example), but include
a second value axis. A combination chart requires at least two data series.

Creating a combination chart simply involves changing one or more of the data
series to a different chart type. Select the data series and then choose Chart»
Chart Type. In the Chart Type dialog box, select the chart type that you want to
apply to the selected series. Figure 16-22 shows an example of a combination chart.
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Figure 16-22: This combination chart uses columns and a line.

In some cases, you can’t combine chart types. For example, you cant combine a
2D chart type with a 3D chart type. If you choose an incompatible chart type for
the series, Excel lets you know.

You can’t create combination 3D charts, but if you use a 3D column or 3D bar chart,
you can change the shape of the columns or bars. Select a series and access the
Format Data Series dialog box. Click the Shape tab and then choose the shape for
the selected series,

Using Secondary Axes

If you need to plot data series that have drastically different scales, you probably
want to use a secondary scale. For example, assume that you want to create a chart
that shows monthly sales, along with the average amount sold per customer. These
two data series use different scales (the average sales values are much smaller than
the total sales). Consequently, the average sales data range is virtually invisible in
the chart.
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Figure 16-24: This chart includes a data table.

As you might expect, you can create your own custom chart types, called user-
defined custom chart types.

The first step in designing a custom chart type is to create a chart that’s
customized the way that you want. For example, you can set any of the colors, fill
effects, or line styles; change the scales; modify fonts and type sizes; add gridlines;
add a formatted title; and even add free-floating text or graphic images.

When vou’re satisfied with the chart, choose Chart+ Chart Type to display the
Chart Type dialog box. Click the Custom Types tab and then select the User-defined
option. This displays a list of all user-defined custom chart types.

Click the Add button, which displays the Add Custom Chart Type dialog box, as
shown in Figure 16-25. Enter a name for the new chart type and a description. Click
OK, and your custom chart type is added to the list.

Add Custom Chart Type

fiE

Figure 16-25: The Custom Chart Type
dialog box.
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Working with 3D Charts

One of the most interesting classes of Excel charts is its 3D charts. Certain
situations benefit from the use of 3D charts, because you can depict changes over
twa different dimensions. Even a simple column chart commands more attention if
you present it as a 3D chart. Not all charts that are labeled “3D” are true 3D charts,
however. A true 3D chart has three axes. Some of Excel’s 3D charts are simply 2D
charts with a perspective look to them.

Modifying 3D Charts

All 3D charts have a few additional parts that you can customize. For example, most
3D charts have a floor and walls, and the true 3D charts also have an additional
axis. You can select these chart elements and format them to your liking. This
chapter doesn’t go into the details, because the formatting options are quite
straightforward. Generally, 3D formatting options work just like the other chart
elements.

Rotating 3D Charts

When you start flirting with the third dimension, vou have a great deal of flexibility
regarding the viewpoint for your charts. Figure 16-26 shows a 3D column chart that
has been rotated to show four different views.
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You can rotate a 3D chart in one of the following two ways:

» Activate the 3D chart and choose the Chart+ 3D View command. The dialog

box shown in Figure 16-27 appears. You can make your rotations and
perspective changes by clicking the appropriate controls. The sample that
you see in the dialog box is not your actual chart. The displayed sample just
gives vou an idea of the types of changes that you’re making. Make the
adjustments and then choose OK to make them permanent (or click Apply to
apply them to your chart without closing the dialog box).

ez gy

Regare

wnr-3

itr-4 Regiar 2

Figure 16-26: Four different views of the same chart.

Rotate the chart in real time by dragging corners with the mouse. Click one of
the corners of the chart. Black handles appear, and the word Corners appears
in the Name box. You can drag one of these black handles and rotate the
chart’s 3D box to your satisfaction. This method definitely takes some
practice. If your chart gets totally messed up, choose Chart+ 3D View and
then select the Default button to return to the standard 3D view.
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Figure 16-28: This XY chart has five data series.

If the value of a data point that you move is the result of a formula, Excel displays
the Goal Seek dialog box (goal seeking is discussed in Chapter 27). Use this dialog
box to specify the cell that Excel should adjust to make the formula produce the
result that you pointed out on the chart. This techmique is useful if you know what
a chart should look like and you want to determine the values that will produce the
chart. Obviously, this feature also can be dangerous, because you inadvertently can
change values that you shouldnt—so be careful.

Unlinking a Chart from Its Data Range

A nice thing about charts is that they are linked to data that is stored in a
worksheet. You also can unlink a data series so that it no longer relies on the
worksheet data.

To unlink a data series, select the data series and then activate the formula bar.
Press F9, and the series formula converts its range references to arrays that hold
the values (see the formula bar in Figure 16-29). If vou unlink all the series in the
chart, you create a dead graph that uses no data in a worksheet. If you want,
however, you can edit the individual values in the arrays.

Creating Picture Charts

Excel makes it easy to incorporate a pattern, texture, or graphic file for elements in
your chart. Figure 16-30 shows an example of a column chart that displays a
graphic.
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Using a Graphic File to Create a Picture Chart

To convert a data series to pictures, start with a column or bar chart (either
standard or 3D). Then, access the chart’s Format Data Series dialog box and select
the Patterns tab. Click the Fill Effects button to get the Fill Effects dialog box. Click
the Picture tab and then click the Select Picture button to locate the graphics file
that you want to use.

Use the Fill Effects dialog box to specify some options for the image.

Using the Clipboard to Create a Picture Chart

This section describes another way to create a picture chart —a method for
which the image that you want to use doesn’t have to exist in a file. This technique
works if the image can be copied to the Clipboard. It's also the only way to get
pictures into the data points for a line or XY chart.

The first step is to locate the image that you want to use and copy it to the
Clipboard. Generally, simpler images work better. You may want to paste it into
Excel first, where you can adjust the size, remove the borders, and add a
background color, if desired. Or you can create the image by using Excel’s drawing
tools. In either case, copy the image to the Clipboard.

When the image is on the Clipboard, activate the chart, select the data series, and
then choose Edite Paste. Your chart is converted. You also can paste the image to
a single point in the data series, rather than to the entire data series— simply
select the point before you paste.

This technique also works with data markers in line charts, XY (scatter) charts, or
bubble charts. Figure 16-31 shows an example of a line chart that uses a smiley face
instead of the normal data markers. | created this graphic by using Excel’s drawing
tools (it’s one of the AutoShapes in the Basic Shapes category).

Pasting Linked Pictures to Charts

Another useful charting technigue involves pasting linked pictures to a chart. Excel
doesn’t let you do this directly, but this pasting is possible if you know a few tricks.
The technique is useful, for example, if you want vour chart to include the data
that’s used by the chart — but the data table feature (discussed earlier in this
chapter) isn’t flexible enough for you.

Figure 16-32 shows an example of a data range pasted to a chart as a linked picture.
If the data changes, the changes are reflected in the chart as well as in the linked
picture. Notice that the effect is similar to using a data table, but it allows more
formatting options.
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3. Activate the chart and paste the Clipboard contents. Youll probably have to
resize the Plot Area to accommodate the pasted image.

4. The image that is pasted is a picture, but not a linked picture. To convert the
image to a linked picture, select it and then enter the range reference in the
formula bar (or simply point it out). For this example, I entered
=Sheet1!AL:ES.

The picture is now a linked picture. Changing any of the cells that are used in the
chart’s SERIES formula is reflected immediately in the linked picture.

Simple Gantt Charts

Creating a simple Gantt chart isn’t difficult when using Excel, but it does require
some setup work. Gantt charts are used to represent the time required to perform
each task in a project. Figure 16-33 shows data that was used to create the Gantt
chart in Figure 16-34.

A workbook that demonstrates this technique is available on the companion
CD-ROM.

i
Planning M q 12,2293 12/2998
Devalop Questionnaire 12/3058 0110899
Print and Mail Quastionnaire 0141353 01521499
FHeceive Responsas 01/163 013099
Data Entry 01/16/99 02/02/92
Diata Analysis 02/03/99 02/06/93
Wiite Repart 02/09/99 02/20/99
Distributz Dratt Regort 02/2393 1 0272399
Saolicit Comments 02/2499 02727799
Fnalize Repadt TToamzes| s | oatemd]
Distributs to Board | 030905 1 | 0310949|

ard Mesting 0341799 1 0341799

Figure 16-33: Data used in the Gantt chart.

Here are the steps to create this chart:

1. Enter the data as shown in Figure 16-33. The formula in cell D2, which was
copied to the rows below it, is =B2+C2-1.

2, Use the Chart Wizard to create a stacked bar chart from the range A2:C13.
Use the second subtype, which is labeled Stacked Bar.
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